
 

 

 

 

 

 

 

Ocean Data View 
 

User’s Guide 
 

Version 3.0 
日本語訳版 

 

 
 
 
 
 
 

2005 年 5 月 17 日 
 



 



 

 

日本語訳版まえがき 

Ocean Data View (ODV) は、様々な海洋データを簡単に解析・可視化できるソフトウェアで、

アルフレッド・ヴェゲナー極域海洋研究所 (AWI) から無償で公開されています。 

本ユーザーズガイドは、日本海洋データセンター（JODC）が作者の了解を得て(財)日本水路

協会 海洋情報研究センター(MIRC)の協力で和訳し、さらにMIRCが第3版にあわせて加筆

補正したものです。本ユーザーズガイドが皆様にお役立ていただければ幸いです。 

なお本ユーザーズガイドの更新状況は以下のとおりです。 

原 文 ：2005 年 05 月 17 日 (バージョン 3.0) 
翻訳版 ：2005 年 11 月 7 日 (暫定版) 

本文中のカギ括弧[]で囲まれた文字は、キーボードの該当する文字を押すことを意味しています。例え

ば[p]はキーボードにpと刻印されたキーを、[F12]はF12 と刻印されたファンクションキーを、それぞれ押

すことを意味しています。また、[Ctrl+x]はコントロールキー[Ctrl]を押しながら[x]キーを押すことを意味

します。 

ウインドウやダイアログ・ボックスのタイトルや項目名などは原文のまま表記しています。 

メインメニューやポップアップ・メニューなどに表示される選択可能なメニューはイタリック体で表記して

います。 
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ライセンスの同意 (License Agreement) 
 

本ソフトウェアのダウンロードまたは使用によって、あなたはアルフレッド・ヴェゲナー極域海洋研究所 (AWI) との間に

次の法的な合意に制限されることに同意したことになります。この合意項目に同意できない場合は、本ソフトウェアをダウ

ンロードしたり使用したりしないでください。 
 
 
1. 学術および教育での利用 (SCIENTIFIC USE AND TEACHING) 
 
Ocean Data Viewは非商用、非軍事研究、および教育目的の場合に無償で使用することができます。科学的な作業で本

ソフトウェアを使用する場合、あなたの出版物でOcean Data Viewを以下のように参照しなければなりません： 
 
      Schlitzer, R., Ocean Data View, http://odv.awi-bremerhaven.de/, 2005. 
 
 
2. 商用および軍事での利用 (COMMERCIAL AND MILITARY USE) 
 
商用または軍事目的のアプリケーションおよび製品のために、Ocean Data Viewまたはその如何なる部分をも使用する場

合には、特別な書面のソフトウェア・ライセンスが必要です。より詳細な情報を知りたい場合は下記に連絡してください。 
 
 
3. 再配布 (REDISTRIBUTION) 
 
CD-ROM、DVDまたは他の電子メディア、またはインターネットによるOcean Data Viewの再配布には、AWIによる事前の

書面での許可が必要です。より詳細な情報を知りたい場合は下記に連絡してください。 
 
 
4. 保証の放棄 (WARRANTY DISCLAIMER) 
 
ODVソフトウェアは、明示の如何にかかわらず、いかなる種類の保証なしにあるがまま提供されるものです。商用利用や

特定目的に関する利用の適合性に関する暗黙の保証もありません。ソフトウェアの品質や性能に関する全てのリスクは

利用者が負うものであり、ソフトウェアに欠陥があった場合、全ての必要なサービス、復旧あるいは修正にかかる費用は

利用者の負担となります。 
 

AWI, ODVの協力者ならびにその著作権保有者のいずれも、利用者に対し、あらゆる直接的、間接的、一般的、

特殊的、典型的、偶発的あるいは必然的な損害がどのように生じたとしても、また、ソフトウェアの利用によ

る、あるいは利用できないことによる責任（データあるいは誤って提出されたデータの損失、利用者あるいは

第三者が被った損失、他のソフトウェアと同時に利用したために生じたソフトウェアの被害や営業の中断を含

み、それだけに留まらない）を一切負いません。 
 
 
© 2005 Reiner Schlitzer, Alfred Wegener Institute, Columbusstrasse, 27568 Bremerhaven, Germany.  
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1 はじめに (Introduction) 

1.1 概要 (General Overview) 

Ocean Data View (ODV)は、海洋学や他のジオリファレンスを与えられたプロファイル、連続データ、グリッド

データを対話的に探査して可視化するコンピュータープログラムです。ODV のマルチプラットフォーム版は、

Windows (9x/NT/2000/XP), Linux, UNIX, Mac OS X の各オペレーションシステム上で動作します。ODV の

データコレクションと設定ファイルはプラットフォーム(訳注: コンピュータの種類)に依存しないので、サポート

されているシステム上で作られたコレクションやファイルは、サポートされているシステム間で交換することが

できます。ODV で大量の測点データを対話的に見ることができます。また、高品質な測点図(station-maps), 

複数の測点における成分間分布図(property-property plots), 選択した測点群の散布図(scatter plots), 任意

の航跡に沿った成分断面図(property sections), 等値面(general iso-surfaces)上の成分分布図も作成できま

す。ODV はカラーの点、数値、矢印でオリジナルのスカラーおよびベクトルデータを表示します。さらに、二

種類の高速なグリッド・アルゴリズムが自動的に矩形格子領域を生成して、等値面上や断面に沿った領域を

カラーで陰影化したり等値線を描画したりします。多くの導変量(derived quantities)を直接計算できます。こ

れらの変数は、ディスクに保存される基本変数と同じように表示および解析することができます。 

 

1.2 使いやすさ (Ease of Use) 

ODV は柔軟性に富んで使いやすく設計されています。ユーザーは、内部のデータ記憶フォーマットの詳細

を知る必要がなく、プログラミングの経験も不要です。ODV は利用可能な測点分布図を常に画面上に表示

するので、ユーザーはマウスで測点(stations), 断面(sections), 等値面(iso-surfaces)を選んで簡単にデータ

を操作できます。画面のレイアウトやその他の様々な設定も簡単に修正でき、気に入った設定は後で利用で

きるように設定ファイルに保存できます。ODV は、比較的安価で広く使われているモバイル・コンピュータ上

で、膨大なデータコレクションの作成と管理ができます。新しいデータを受け取っても簡単にデータコレクショ

ンを拡張できます。ODV はデータの品質管理が非常に簡単で、教育や研修にも役立ちます。 

 

1.3 高密度データフォーマット (Dense Data Format) 

ODV のデータフォーマットは、可変長で不規則な間隔のプロファイルや連続データ, 測点データ向けに最

適化されているので、膨大なデータコレクションでも高密度に保存でき、どの測点にも瞬時にアクセスできま

す。データフォーマットは柔軟で、最大 50 個の変数を個々のデータコレクションに保存できます。変数の型と

数はコレクション毎に変えられます。ODV は個々のデータ値に対して品質フラグを保持していて、これらの品

質フラグは、解析時に不良または疑わしい値を除くためのデータ品質フィルターとして利用できます。データ

値および品質フラグの編集や修正は簡単にでき、全ての修正はログに残りますので、必要ならば不用意な
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変更は元に戻せます。 

 

1.4 拡張性 (Extensibility) 

ODV は既存のコレクションの中に新規データを簡単に取り込むことができ、また、コレクションからデータを取

り出すこともできます。以下に示すような広く採用されているフォーマットによる海洋データは ODV で直接読

み込めます： 

• WOCE WHP data (Scripps 海洋研究所の WHPO からインターネットで配布) 

• World Ocean Database (米国 NODC から CD-ROM およびインターネットで配布) 

• World Ocean Atlas 1994 (WOA94；米国 NODC から CD-ROM で配布) 

• NODC SD2 data 

• Java Ocean Atlas spreadsheet format, 

• ODV spreadsheet format. 

 

1.5 導変数 (Derived Variables)  

データファイルに保存される基本的な実測変数に加え、ODV は多くの導変数(derived variables)を計算して

表示することができます。これらの導変数(ポテンシャル温度, ポテンシャル密度, 力学高度(いずれも基準層

は任意), 中立密度, Brunt-Väisälä Frequency (ブラント─バイサラ周波数), 音速, 酸素飽和度など)の計算

アルゴリズムは ODV ソフトウェアにコード化されているか、あるいはユーザーがマクロファイルや数式で定義

できます。マクロ言語は広く応用できるように簡単かつ一般化されています、新しい導変量(derived 

quantities)に数式やマクロファイルが使えることによって、ODV の適用範囲は一層広がり、科学分野では未

だ確立されていない新しい数量に関する実験が容易に行えます。ODV にはマクロエディタが組み込まれて

いるので、ODV マクロの作成および修正は簡単にできます。 

どの基本変数や導変数でも複数表示でき、どの変数も等値面の定義に使用できます(例えば等深面、等密

度面、等温面または等塩分面；成分の極大または極小層、例えば中層水の塩分極小層にはこれらの変数

(の導数量)の鉛直微分がゼロの等値面として定義されます)。 

 

1.6 プロットの種類 (Plot Types) 

ODV は二つの基本的な方法でデータを表示します。方法 1 では、オリジナルのデータをユーザーが定義し

たサイズのカラーの点、数値、矢印でデータの位置に表示し、方法 2 では、オリジナルのデータを可変の解

像度または等間隔の矩形グリッド上に投影したグリッド領域に表示します。方法１は最も基本的で、データの
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「ありのまま」の分布を瞬時に描くので、不良データやサンプリングが粗な領域を明らかにできます。これに対

して方法２は見た目が美しく、方法１で見られるようなカラーの、特にサイズの大きな点が重なりあう状態を回

避することができます。しかしながら、方法 2 によるグリッド領域は加工されたデータを表わしていて、データ

に含まれる小規模スケールや顕著な特徴がグリッド化によって失われることに注意しなければなりません。グ

リッド化、陰影化、等値線描画の専用ソフトウェアでも使えるように、ODV はアスキーファイルやクリップボード

に断面または表面のデータを出力することができます。大量のデータセットをすばやく概観できるように、

ODV は地図や任意のデータプロット・ウインドウのアニメーション GIF ファイルを作成することもできます。 

 

1.7 ODV のモード (ODV Modes) 

ODV は五つの異なるモード: MAP(地図), STATION(測点), SCATTER(散布図), SETION(断面図), 

SURFACE(表面)を操作できます。これらのモードには、[F8]から[F12]までのキーを押すか、メインメニューの

Configuration>Use Template あるいはキャンバス・ポップアップ・メニューの Use Template から定義済みのレイ

アウト・テンプレートを選べば、いつでも簡単に切り替えることができます。現在のモードと使用中の設定ファ

イルは、ODV ステータス・バーの右端に常に表示されます。初期設定は STATION モード(新規データコレク

ションの初期モード)です。 

MAP モードは全画面の測点図を描くものでデータプロットは作成できません。このモードは高品質な航跡図

の作成に使用してください(地図ウインドウのサイズと位置を決めて、五つの地図投影法から選択し、適切な

海岸線および海底地形の設定を定義して、個々に測点番号と航海ラベルの付いた測点を描いて、プリントア

ウトまたは PNG, JPG および EPS PostScript ファイルを作成します)。 

 

 

 

図 1.1: 地図(MAP)モードで描かれた全画面測点図 
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STATION モードは (以降の全てのモードと同様に)、測点図と一つ以上(最大 20)のデータプロット・ウインド

ウを作成します。このモードは、選択した測点の(任意の基本または導変数の)X/Y プロットの作成に使用して

ください。地図中の測点上でマウスの左ボタンをクリックするか、航海ラベルと測点ラベルを指定すると測点を

選択できます。[p]を押すと現在の測点のデータをプロットに追加でき(ダブルクリックすると測点の選択と表示

が同時にできます)、[Ctrl-x]を押すと画面をクリアしてやり直すことができます(この操作は全モード共通)。 

 
図 1.2: 選択した測点の成分間プロット 

SCATTER モードでは(以降の全てのモードも同様に)、データプロットは Z 変数(任意の基本および導変数)

をサポートしています。ある X/Y 点の Z 変数の値で X/Y 点の色が決まります。Z 変数のプロットには 

(SECTION モードおよび SURFACE モードも同様に)、(1) X/Y の位置にカラーの点または実際のデータ値を

配置する方法(初期設定)と、(2)観測データに基づいて推定した連続的なグリッド領域として表示する方法の

二つの方法があります。グリッド領域にはカラーの陰影や等値線が描画されます。SECTION モードや

SURFACE モードとは異なり、SCATTER モードでのデータプロットには (Z 変数の有無に関係なく)地図に表

示されている全測点の全データ点(ただし有効な測点のみ)が含まれます。 
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図 1.3: 地図中の全測点データを示した散布図 

SECTION モードもデータプロットで Z 変数をサポートし、SCATTER モードの全てのプロットタイプが使えま

すが、プロットに使える測点は、通常、ある航跡に沿った断面帯に制限されます。断面帯は任意に定義でき、

正しく測点を選べるように幅を調整できます。このモードは、断面に沿った成分分布や断面内の全測点に関

する成分間プロットの表示と、断面を横切る地衝流の計算および解析に使用してください。 
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図 1.4: 断面に沿った成分分布 

 

SURFACE モードでは、三次元空間(経度/緯度/深度)において、ある変数(例えば深さ, 密度, 水温など)が

一定の値になる面を定義して、その面上における他の変数の成分分布を表示することができます。このモー

ドでは、ある面上における任意の成分間プロットも作成できます。 

 

 

図 1.5: 等値面上における成分分布 

 

 

図 1.6: 偏流データによる矢符プロット 

 

1.8 グラフィックス出力 (Graphics Output) 
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ODV グラフィクス画面のプリントアウトは、ODV プリントオプションを使って簡単に得られます。また、全画面も

しくは個々のデータプロットや地図を PNG, JPG, GIF, PostScript ファイルに書き出すこともでき、これらのファ

イルは電子化書類や Web ページに含めることができます。PNG, GIF および JPG の解像度はユーザーが指

定でき、画面の解像度で制限されることはありません。 

 

1.9 任意の点の推定とボックス平均 (Point Estimation and Box Averaging) 

ODV は任意の緯度-経度-深度における基本変数もしくは導変数の値の推定に使えます。三次元推定(3D 

point estimation)には高速加重平均処理(fast weighted averaging procedure)が実装されていて、ユーザーが

指定した経度、緯度、深度の平均の長さスケールで現在有効な測点とサンプルのセットが使用されます。推

定が要求される点は単純なアスキーファイルで与えます。点は不規則な間隔、または均一か不均一の、矩形

または曲線上のグリッドになります。メインメニューの Utilities > 3D Estimation で三次元上の点の推定を呼び

出せます。 

断面および等値面プロットでは、ある断面に沿った、あるいは等値面上の任意の X/Y における値の推定に、

二次元推定(2D point estimation)オプションを使用できます。三次元推定と同様に、X/Y の点は単純なアス

キーファイルで与えられます。点は不規則な間隔、または均一か不均一の、矩形または曲線上のグリッドに

なります。 

三つ目の推定方法である一次元推定は、X または Y 軸上に第一コレクション変数(第一変数)を持つデータ

プロットに関して利用できます。このオプションは、プロットに含まれる一つ一つの測点に対して、ユーザーが

指定した第一変数の値における他の変数を推定します。これらのユーザーが指定する座標は、一行につき

一つの座標含むアスキーファイルで与えてください。推定の結果は generic ODVスプレッドシート・フォーマッ

トのファイルで出力され、これらのファイルは ODV で簡単に取り込めて図化できます。一次元推定オプション

は、例えば、ユーザーのコレクションに保存されている任意の成分の標準層プロファイルを得るのに使えます。

このオプションの呼出は、各々のデータプロット・ポップアップ・メニューから Extras > 1D Estimation を選んで

ください。 

上述した様々な点の推定方法に加えて、ODV はユーザーが指定した緯度／経度／深度のボックス内の平

均および標準偏差の計算にも使えます。あるボックス内で現在有効な全てのサンプルが平均に使用されま

す。ボックス平均は点の推定とは異なります：全ての点の推定法は常に(もしデータが近くになければ低品質

な)値を生成するのに対して、ボックス平均(box averaging)処理ではデータ値が実際にボックス内で見つかっ

た時にだけ結果を返します。 

 

1.10 NetCDF の対応 (NetCDF Support) 
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ODV は、地球科学系データやモデル出力をプラットフォームに依存せずに保管および交換するために研究

者が広く利用している netCDF ファイルを読み込むことができます。ODV は使いやすい netCDF エミュレーシ

ョン・ウイザードで netCDF ファイルから選んだ座標系と変数でデータの一つ以上の表示方法を定義でき、ネ

イティブの DV コレクションのように netCDF ファイルの内容を表示することができます。NetCDF データの探索

に ODV の解析および図化ツールの全ての機能が利用できるので、初めにデータを変換したり書き直したり

する必要はありません。NetCDF ファイルの構造と内容によって ODV のエミュレーションは異なります。個々

のエミュレーションの設定は、後で利用できるようにディスクに保存することができます。NetCDF ファイルはプ

ラットフォームに依存しないので、ODV がサポートする全てのプラットフォーム上で使用できます。 
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2 ODV のインストールと起動 (Installing and Running 

ODV) 

2.1 Ocean Data View のインストール (Installing Ocean Data View) 

CD-ROM や DVD 上での ODV 実行環境 (WOCE V3 データリリース DVD2 の eWOCE ディレクトリにはそ

のような実行環境が含まれています)またはコンピュータにインストールされた ODV から Ocean Data View を

起動させることができます。頻繁に ODV を使うのであれば、使用するコンピュータにソフトウェアをインストー

ルすることをお勧めします。ODV インストール・ファイルは Windows (9x/NT/2000/XP), Linux, UNIX, Mac OS 

X で使えます。http://odv.awi-bremerhaven.de/ から最新版をダウンロードできます(訳注:原文と異なりますが、

現在はこの URL です。またソフトウェアのダウンロードにはユーザー登録が必要です。登録は無償です)。イ

ンストール方法は、INSTALL(という名前の)ファイルに記述されています。 

 

2.2 オプショナルパッケージのインストール (Installing Optional Packages) 

高解像度の海岸線および海底地形ファイル、すぐに使用できる(ready-to-use)データコレクションはオプショ

ナルパッケージとなっています(http://odv.awi-bremerhaven.de/ からダウンロードできます; 訳注:原文と異な

りますが、現在はこの URL です。またソフトウェアのダウンロードにはユーザー登録が必要です。登録は無償

です)。インストール方法および詳細は“INSTALL”ファイルを参照してください。 

 

2.3 Ocean Data View の起動 (Running Ocean Data View) 

(1) ODV の起動 (Starting ODV) 

システムに ODV をインストールした後は様々な方法で ODV を起動できます。 

Windows では、インストール処理によって ODV アイコンがデスクトップに置かれ、自動的に.var コレクション・

ファイルが ODV の実行プログラムに関連付けられます。この.var ファイルまたは ODV デスクトップ・アイコン

をダブルクリックすると ODV が起動します。あるいは、Windows のスタート・メニューの「すべてのプログラム」

から Ocean Data View (mp)を選んでも起動できます。ODV デスクトップ・アイコンを Windows のタスクバーに

ドラッグすることもでき、その場合は、タスクバーの ODV アイコンをシングルクリックして ODV を始めることがで

きます(訳注: 訳者の環境ではこれができません)。 

ODV がサポートしているファイルをデスクトップまたはタスクバーの ODV アイコンにドラッグすると、ODV の起

動とファイルのオープンが同時にできます。ODV の起動中は、サポートされているファイルを ODV ウインドウ

にドラッグすると、そのファイルを開くことができます。ODVがサポートするファイルの種類には、ODVコレクシ
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ョン(*.var), netCDF ファイル (*.nc, *cdf), ODV スプレッドシート・ファイル (*.txt) などがあります。 

Linux, UNIX, Mac OS X のシステムでは、ODV の実行形式ファイル odvmp またはスタートアップ・スクリプト

ファイルの run_odv の別名(エイリアス)やアイコンを作ることができます。各々のオペレーティングシステム特

有の方法で、デスクトップ、タスクバー、ドックにアイコンまたは別名(エイリアス)を作ってください。ODV の実

行形式ファイル odvmp は、ODV がインストールされたディレクトリの下の bin_…(ここで“…”はシステムに依存

します；例えば Mac OS X であれば macx, Linux システムであれば linux-i386 となります) の中にあります。

デスクトップ・アイコンやタスクバー/ドック・アイコンを作成した後は、ODV アイコンをダブルクリックまたはシン

グルクリックして ODV を起動できます。ほとんどのシステム上では、ODV コレクションである.var ファイルや

netCDFファイル、またはサポートされているどのデータファイルも、ODVアイコン上にドラッグ・アンド・ドロップ

(drag-and-drop)できます。 

ODV は DOS ボックスまたはターミナル・ウインドウの中で実行形式ファイルのフルパス名とオプションの引数

(訳注：odvmp に渡すパラメーター値。これに応じて odvmp は処理を行う。) を入力して起動することもできま

す。いくつかのシステムでは、スクリプトファイル run_odv を使ってコマンドラインから ODV を開始することもで

きます。コマンドラインから ODV を起動する場合は次の引数をサポートしています。スペースを含むファイル

やパス名は、””で括らなければならないことに注意してください。 

コマンドラインの引数 動  作 

.var, .nc, .cdf のファイル名 ODV を起動して、ローカルまたはリモート¶にある指定したコレクションまた

は netCDF ファイル.nc, .cdf の netCDF ファイルを開きます。 

サポートする読み込みファイル

(supported import file)名 
(例 .txt, .csv, .jos, .o4x など) 

ODV を起動して、新しいデータコレクションを作成して開き、指定したファ

イルからデータを読み込みます。すべてのサポートファイルはローカルで

もリモート¶でもかまいません。 

-cfg ファイル名 (.cfg) var コレクションを開くときに、指定した.cfg ファイルの設定を使用します。

(絶対パス名またはコレクションのあるディレクトリからの相対パス名) 

-nce ファイル名 (.nce) .nc や.cdf ファイルを開くときに、指定した.nce ファイルのエミュレーション

情報を使用します。 
(絶対パス名もしくは.nc/.cdf のあるディレクトリからの相対パス名) 

-x ファイル名 (*.cmd) ODV を起動して、指定した ODV コマンドファイル(ODV command file) 
を実行します。 

-q  すべてのコマンドライン引数を実行してから ODV を終了します。 

¶ リモートファイルは、ローカルのコンピュータに自動的にダウンロードされて処理されます。リモートファイルは http://...ま
たは ftp://...といった URL で指定します。ファイアウォールがある場合、ODV でリモートファイルにアクセスするためには、

Windows の SocksCap のようなソケット・サーバー・ソフトウェアを使用しなければなりません。 

(2) クイック・インストール・ダイアログ (Quick Installation Dialog) 

初めて ODV を実行すると、次の Quick Installation 情報に関して入力が求められます： 

1. bin_…ディレクトリを含む完全パス名 (環境変数 ODVMPHOME) 
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2. ODV 実行中に一時ファイルを書き込むディレクトリの完全パス名 (環境変数 ODVMTEMP)。この

ディレクトリには書き込み許可が必要です。システムの一時ディレクトリを使用するか、ローカルディ

スクにこの目的のための特別なディレクトリ (例えば /odvmptemp) を作ることもできます。ネットワ

ークドライブ上のディレクトリを使用することは、ネットワークの転送速度の遅延の面でお勧めしませ

ん。 

3. 使用するコンピュータ名 

4. ユーザー名またはログイン名 

[OK]を押すと Quick Installation が完了します。そのあとで Configuration > General Settings ダイアログを使っ

て ODV フォントと外部プログラムの設定を変更してください。ヘルプが必要なら[F1]を押すか、Help > Help 

Topics オプションを使ってください。多くの ODV ダイアログにある Help ボタンを押すと状況依存ヘルプ

(context sensitive help; 訳注: 操作に応じて特定のトピックを表示するタイプのヘルプ)が表示されます。 

(3) ODV の使用 (Using ODV) 

ODV を起動させた後は、File > Open オプションを使って、特定のデータコレクション、netCDF ファイル、サポ

ートされている読み込みファイルを開くことができます。標準のファイルオープン・ダイアログが表示されるの

で、開くファイルの適切な形式とファイル名が選べます。サポートされている読み込みファイルを開く場合に

は、ODV は指定されたファイルのデータから新規コレクションを自動的に作成してから、この新しいコレクショ

ンを開きます。コレクションを開くと、このコレクションに関する直前の ODV セッションの設定が読み込まれるこ

とに注意してください。さらに、この直前の設定によって測点とサンプルの選択フィルターが適用されるかもし

れないことにも注意してください。すなわちデータコレクションの一部の測点だけが測点図に表示されること

になります。全測点を含む初期設定の地図を表示させるには Configuration > Use Template > default を使い、

Configuration > Selection Criteria を使って選択基準を選び直せば別の測点／サンプルのサブセットが得ら

れます。 

前に保存した別の設定は Configuration > Load Configuration を使って呼び出せます。また、Configuration > 

Use Template を使えば定義済みのレイアウト・テンプレートの一つを選べますし、Configuration メニュー・オプ

ション、またはキャンバス領域や地図、データプロット上でマウスの右ボタンをクリックしたときに現れるポップ

アップ・メニューを使えば対話的に様々な設定を変更できます。Mac OS X ではマウスをクリックしている間に

[Alt]キーを押すと、右クリックと同じになります。 

File > Open でローカルファイルを開けることに加えて、File > Open URL オプションを使えばリモート・データ

セットにアクセスすることもできます。ODV は netCDF やサポートされている読み込みファイルの場所を示す

URL (Uniform Resource Locator)アドレスを入力させて、各々のファイルをダウンロードして開きます。URL に

は http:や ftp:といったプロトコル識別名をつけて指定します。ファイアウォールがある場合に http:または ftp:

で指定知る場合は、Windows の SocksCap のようなソケット・サーバー・ソフトウェアが必要になります。 
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3 ODV 画面レイアウト (ODV Screen Layout) 

ODV アプリケーション・ウインドウは、トップのタイトル・バー, メインメニュー・バー, 三行テキストウインドウ, グ

ラフィックス・キャンバス・ウインドウ、モードタブ・バー、ステータス・バーで構成されています(下図参照)。キャ

ンバスはメインの作図エリアで、測点図と 20 図までのデータプロット・ウインドウを含めることができます。ODV

は常に現在のマウスの位置を記憶していて、キャンバスまたは特定のオブジェクト上で右クリックすると(Mac 

OS X ではクリックしている間に[Alt]キーを押すと)、状況依存ポップアップ・メニュー(context sensitive popup 

menu; 訳注: 操作に応じて特定の選択肢が表示されるメニュー)が表示されます。ポップアップ・メニューから

選択したアクションは、右クリックしたオブジェクトに対して適用されます。地図上の測点の位置とデータプロッ

ト中のデータ点は、それらの上で左クリックすると選べます。選択した測点とサンプルに関する情報は三行テ

キストウインドウに表示されて、さらに、各々の測点位置は地図上に赤丸で示され、データプロット中のデータ

の位置は赤色の十字記号で示されます。地図とデータプロットの多くの表示設定は修正が可能で、後で利

用できるように設定ファイルに保存できます。 

 

 

図 3.1: ODV アプリケーション・ウインドウ 

主な ODV ウインドウの構成部分とポップアップ・メニューの詳細を以下に示します。 

 

3.1 メインメニュー (Main Menu) 

メインメニューは以下の基本機能を提供します： 
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File: コレクションのオープン、作成； netCDF ファイルのオープン； ODV がサポートするデータファイ

ルのオープン(ローカルまたはリモート)； バッチモードでの ODV コマンドの実行； 現在の ODV グ

ラフィクス・キャンバスの印刷； 現在の ODV グラフィクス・キャンバスの GIF, PNG, JPG, PostScript

ファイル出力； ODV の終了。 

Collection: コレクションのコピー、名前の変更、削除； データコレクションの並替えおよび圧縮； コレク

ションの変数の変更、現在の測点または有効な測点の削除。 

Configuration: 測点選択基準の変更； 導変数の定義； 等値面変数の定義； 地図およびデータプロッ

トレイアウトの変更； 変数ラベルの変更； ODV テキストウインドウの三行目に表示されるデータの

数値フォーマットと位置の変更； 設定の読み込みと保存または初期設定の設定。 

Import: 現在のコレクションへのデータの読み込み(WOCE フォーマット、WOA94 CD, WOD CD, 

NODC SD2 フォーマット、ODV スプレッドシート・フォーマット、二種類の ODV リストフォーマット)。 

Export: 現在選択されている測点のデータ出力；ウインドウ X/Y/Z データのアスキーファイル出力； 参

照データセットとしてのウインドウ X/Y/Z データの出力。 

Utilities: データインベントリ・テーブルの作成； 三次元推定の実行； ボックス平均の計算； 地衡流の

計算と可視化； コレクションの info ファイルと log ファイルの表示； マクロエディタの呼出し。 

Help: ODV ヘルプシステムの呼出し； ODV Web ページへの接続； バグレポートの送信； バージョン

の表示。 

 

3.2 三行テキストウインドウ (3-Line Text Window) 

 

図 3.2: ３行テキストウインドウ 

三行テキストウインドウには現在の測点(一行目)と現在のサンプル(二行目と三行目)に関する情報が表示さ

れます。一行目の測点メタ情報の意味は次の通りです: 

1 有効な測点数(現在の測点の選択基準を満していて地図に表示されている) 

2 コレクション中の測点の総数 

3 現在の測点の内部順番号 

4 現在の測点のクルーズラベル 

5 現在の測点の測点ラベル 
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6 現在の測点のタイプ(B か C) 

7 現在の測点の観測日付 

8 現在の測点の観測時刻 

9 現在の測点の経度(十進法) 

A 現在の測点の緯度(十進法) 

B 現在の測点の水深 

C 現在の測点の最深観測深度 

D 現在の測点のサンプル数 

テキストウインドウ上でマウスの右ボタンをクリックするとコンテクスト・メニューが出て、データと測点のメタデー

タの編集、様々な変数の設定ができ、このとき二行目と三行目にある変数ラベルと数値フォーマットも編集で

きます。 

テキストウインドウの特定の領域(作動領域)上にマウスを置くと、補足情報を含むポップアップ・ウインドウが

現れ、マウスを作動領域から離すか、マウスの右クリックで消えます。ODV ポップアップ・ウインドウの作動領

域と内容は以下の図表の通りです。 
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図 3.3: ODV ポップアップ・メニューの作動領域と内容 

表 3-1: ODVポップアップ・メニュー 

ポップアッ

プ・ウインドウ 

作動領域 内容 

コレクション

変数 

一行目の航海ラベルに

続く測点ラベルの欄 

コレクション変数と、(図上に表示されている)現在有効

な測点(Val), 現在の航海(Cru), 現在の測点(Sta)に関する

データ有効率[%]の一覧 

選択基準 一行目のはじめの[]で

囲まれた欄 

現在の測点・サンプルの選択基準のリスト 

航海情報 一行目の`:’に続く航海

ラベルの欄 

現在のクルーズに関する概要 

測点情報 一行目の航海ラベルに

続く測点ラベルの欄 

現在の測点のデータ有効率 

データ概要 二行目と三行目の最初 現在のサンプルにおける全変数のデータ値(データの品
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の項目(#または “Surf”) 質によって色分けされている) 

データ情報 二行目と三行目の変数 完全な変数名、データ値、データ品質フラグ 

 

3.3 グラフィックス・キャンバス (Graphics Canvas) 

ODV グラフィックス・キャンバスは ODV 測点図および複数のデータプロットを含んでいます。地図のみ表示さ

れている場合、STATION モードでは個々の測点上で、他の全モードでは地図のどの場所でもダブルクリック

するとデータプロットが表示されます。[p]を押してもプロットが表示されます。グラフィック・キャンバスをクリア

するためには、キャンバス・ポップアップ・メニューから Clear Canvas を選ぶか、[Ctrl+x]を押してください。選

択した測点のリストのクリア、または等値面変数の再計算を実行するには Clear Canvas を二回選んでくださ

い。印刷出力の時、ODV グラフィック・キャンバスはプリンターの用紙サイズに合わせてマッピングされます。 

ODV のアプリケーション・ウインドウのサイズは、アプリケーション・ウインドウの右上スミのリサイズボタンを押

すかウインドウの枠をドラッグすることにより、任意に変更できます。ODV アプリケーション・ウインドウがキャン

バス領域より小さいと、水平スクロールバーや垂直スクロールバーが表示され、スクロールバーをスライドさせ

るかグラフィックス・キャンバスをドラッグする(マウスの左ボタンを押しながらマウスを移動させます)ことでキャ

ンバス領域の表示範囲を調整することができます。 

地図, データプロット、キャンバス領域でマウスの右ボタンをクリックすると(Mac OS X システムでは[Alt]キー

を押しながらマウスをクリック)、次のポップアップ・メニューが表示されます： 



 

Ocean Data Viewユーザーズガイド 

 

17 

図 3.4: キャンバス・メニュー 

キャンバス・ポップアップ・メニューでは次のオプションが利用

できます： 

• グラフィックス・キャンバスのクリアと測点図の回復。二回

選ぶと選択した測点のリストをクリア(MAP および

STATION モード時)、または等値面変数の再計算を実

行(SURFACE モード時) 

• 全グラフィックス・キャンバスの GIF, PNG, JPG, 
PostScript ファイルの作成 

• グラフィックス・キャンバスの印刷 

• 全ウインドウをフルスケールに変更 

• 最後に行った変更の取り消し(元に戻す) 

• 導変数の定義 

• 等値面変数の定義 (SURFACE モードのみ) 

• ODV テキストウインドウの三行目のデータの変数ラベ

ル, 数値フォーマット、位置の変更 

• キャンパス・オブジェクトの追加および管理 

• 地図とデータ・ウインドウのレイアウトの変更 

• 設定ファイルの保存と読み込み 

• ODV の終了 

 

地図ポップアップ・メニューでは、次のオプションが

利用できます： 

• 地図領域の拡大・縮小 

• コレクションの全領域の地図作成 

• 標準の世界地図作成 

• 地図の PostScript, GIF, PNG, JPG ファイル作成 

• 測点選択基準の変更 

• 地図表示オプションの変更(投影法、海底地形と海

岸線の設定、測点の注記スタイル) 

• 断面の定義(SECTION モードのみ) 

• 名前もしくは内部番号による新しい現在の測点選択

• 次の追加メニューの表示：測点の時系列分布の作

成、地図統計の閲覧、動画の作成、地名辞典の閲

覧、地図へのグラフィックス・オブジェクトの追加、地
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図 3.5: 地図メニュー 図データのクリップボードへのコピー 

 

 

図 3.6: データプロット・メニュー 

データプロット・ポップアップ・メニューでは、次のオプションが利

用できます： 

• 現在のウインドウの拡大と X/Y 値の範囲設定 

• 現在のウインドウのカラーバーの拡大と Z 値の範囲設定 

• 全データの値を含めるための現在または全ウインドウの

X/Y/Z 値の範囲の自動調整 

• 現在のプロットの PostScript, GIF, PNG, JPG ファイル作成と

カラーマッピングの変更 

• 新しい X/Y/Z 変数の選択 

• 次の追加メニューの表示：データ統計の閲覧、動画の作

成、データプロットへのグラフィックス・オブジェクトの追加、

プロットデータのクリップボードへのコピー 

 

3.4 モードタブ・バー (Mode Tab Bar) 

 

図 3.7: モードタブ・バー 

現在のモードはモードタブ・バーにハイライト表示されます。各々のタブをクリックすれば別のモードに切り換

えられます。 

 

3.5 ステータス・バー (Status Bar) 

 

図 3.8: ステータス・バー 
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ODV ステータス・バーにはヘルプ、状況および進捗情報が表示されます。ステータス・バーの右端には使用

中の設定ファイルが表示されます。 

 

3.6 現在の測点およびサンプル (Current Station and Current Sample) 

ODV は常に現在の測点を指し示しています。この測点は地図上に赤い十字記号で示され、その測点のメタ

データはテキストウインドウの一行目に表示されます。新しい現在の測点を選ぶためには、地図中のその測

点上でマウスの左ボタンをクリックしてください。もし同じ位置に複数の測点があって、それらを個々に選びた

い場合は、[Shift]キーを押したままクリックすると、一致する測点の一覧が表示されますので、現在の測点に

したいものを選んで、OK を押してください。 

現在の測点におけるサンプルの一つが現在のサンプルとなります。現在のサンプルは、もし存在していれば、

データプロット中に赤い十字記号で示され、現在のサンプルのデータはテキストウインドウの二行目と三行目

に表示されます。新しい現在のサンプル(と新しい現在の測点)を選ぶには、いずれかのデータプロット上で

マウスを左クリックしてください。 

 

3.7 作図 (Plotting) 

現在の測点のデータ(STATION モード)、全測点のデータ(SCATTER モード)、任意の航跡に沿ったカラー

断面図(SECTION モード)、等値面分布図(SURFACE モード)を作図するには、地図上の各々の測点または

地図内の任意の場所をダブルクリックするか、[p]を押します。STATION モードでは、地図上で別の測点記

号をダブルクリックするだけで、その測点を追加できます。図から特定の測点を削除するには、そのデータ点

をクリックして[Del]キーを押してください(STATION モードのみ)。SECTION モードでは、作図前に断面を定

義してください。 
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4 ODV コレクション (ODV Collections) 

ODV は、海洋や他のジオリファレンスを持ったプロファイルや連続データを効率よく保存し検索できる内蔵

データベース・フォーマットを持っています。コレクションのフォーマットは不規則な間隔のオリジナルデータ

を最適化するので、高密度な保管および高速なデータアクセスができます。ODV は、ODV コレクションと

netCDF データセットのいずれのグリッドデータでも扱うことができます。 

 

4.1 ODV のデータ概念 (ODV Data Concept) 

ODV は、海洋または大気のプロファイルデータ、堆積物コアのデータ、海中、浮氷、陸上における漂流点ま

たは定点での時系列データなど、広範囲にわたるデータを扱うことができます。ODV データモデルの中心と

なるのは、位置と時間でサンプリング場所を表わすことができ、複数のサンプルに関するデータが得られる

「測点」(stations)」いう概念です。各々のサンプルについて、ODV は最大 50 変数を扱うことができます。ODV

データコレクションの一番目の変数は、測点データの並び替え変数として扱われます(第一変数)。海洋、大

気、地質のプロファイルデータであれば、海中の深度か圧力、大気中の高度、堆積物コアの深さが第一変数

となります。時系列データであれば(十進法での)観測時刻変数を第一変数として使います。 

ODV データコレクション・フォーマットは位置と時間が不規則に分布している測点も扱えます。加えて測点の

サンプルは第一変数の座標に沿って不規則に分布しているでしょうが、均一な時空間グリッド上に測点やサ

ンプルを並べる必要はありません。 

測点を記述するために、ODV は八個のメタデータまたはヘッダー項目を使います。これらの項目には航海

名、測点名、地理座標、観測日付と時刻が含まれます。測点のメタデータ項目の詳細は下表を参照してくだ

さい。 

表 4-1: ODV測点メタデータ項目 

意味 (Meaning) 属ラベル (Generic Label) タイプ (Type) 

航海ラベル Cruise (航海) 文字列(最大 20 文字) 

測点ラベル Station (測点) 文字列(最大 20 文字) 

測点のタイプ Type (タイプ) 文字(1 文字) 

観測日付または配備日付  mon/day/yr (月/日/年) 文字列(mm/dd/yyyy) 

観測時刻または配備時刻  hh:mm (時:分) 文字列(hh:mm) 

十進法での測点経度(東経、度単位) Longitude(東経、度単位)1) 浮動小数点数 

十進法での測点緯度(北緯、度単位) Latitude(緯度、度単位)1) 浮動小数点数 

測点の水深または測器の深度 Bot. Depth [m] (水深) 浮動小数点数 

1) Lon (°E)と Lat (°N)は互換性を維持するために経度／緯度ラベルとして認識されます。 
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ODV コレクションは事実上無制限に測点を保存することができます。各測点は最大 50 変数を持つ最大

20,000 サンプル(または回)のデータを含むことができます。コレクション中の全測点は同じ変数(コレクション

変数)セットを使用します。上述したように、第一コレクション変数(第一変数)はデータを「自然な」順番で並べ

るために慎重に選ばなければなりません。海洋プロファイル、大気プロファイル、堆積物のプロファイルに関

してはそれぞれ深度、高度、または圧力を第一変数として選んでください。時系列データに関しては、第一コ

レクション変数として十進法の時間変数を使用してください。ODV の内部ではデータを昇順で並び替えるた

めに第一変数の座標を使います。コレクション中の第二以降の変数は任意です。コレクション変数は新規コ

レクションを作成したときに指定しますが(以下参照)、変数の追加や削除、並び替えはいつでもできます。 

サンプルの実際のデータ値に加えて、ODV は値毎にデータ品質フラグも保持しています。ODV は四種類の

品質区分から成る単純なデータ品質スキームを使用しています： good (0), unknown (1), questionable (4),  

bad (8). 新しく読み込んだデータに品質情報がなければ、初期値として unknown 品質フラグが割り当てられ

ます。WOD, WHP, IGOSS の読み込みデータファイルに含まれる品質フラグは、データ読み込み時に ODV

品質フラグに変換されます。品質フラグの変換に関する詳細は付録を参照してください。 

ODV の選択基準ダイアログの Quality タブでデータ品質条件を指定して、ODV コレクション中のデータ品質

情報を解析および可視化のためのデータ選別に使用します。いくつかの基本変数に関しては、図化および

解析に使える導変数のようにデータ品質フラグ値を与えることができます。 

 

4.2 コレクションの作成 (Creating Collections) 

新しい ODV コレクションを作成するには、メインメニューの File > New を選択し、新しいコレクションを作成す

るディレクトリを選んでコレクション名を指定します。その後にコレクションに保存する変数を定義してください。

第一コレクション変数はデータの「自然な」並べ替えに影響しますので注意してください。プロファイルデータ

の第一コレクション変数は水深、高度、圧力になります。時系列データの第一変数は十進法の時間変数とな

ります。二番目以降の全ての変数は任意です。いずれのコレクションも変数は最大 50 個です。導変数を使

用する場合は、45 個より多い(基本)変数の定義は避けてください。 

コレクション変数はいくつかの方法で指定できます。変数ラベルを手で入力するか、ODV がサポートする読

み込みファイル(.txt, .var, .o4x, 任意の拡張子を持つ general スプレッドシート・ファイル)の変数名を使うか、

様々な海洋プロジェクトまたはデータ出版物(例えば WOCE WHP, NODC World Ocean Database など)から

共通の変数名を使うことができます。 
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図 4.1: 変数選択ダイアログ・ボックス 

変数を手動またはテンプレート・ファイルで定義すると、初期の変数セットに対して変数の追加、既存変数の

削除、ラベルの編集、変数の並べ替えといった操作ができます。新たに変数を追加するためには、New 

Variable 欄に変数ラベルを入力して Add を押してください。変数の消去やラベルの編集は、その変数を

Defined Variables リストで選択してから Delete または Edit を押してください。変数ラベルの編集したときは、

変更を反映させるために Update ボタンを押すのを忘れないでください。曖昧さを回避するために、変数ラベ

ルの一部としてカギ括弧[]で囲った単位を含めるようにしてください。 

 

図 4.2: 変数定義ダイアログ・ボックス 

下付き、上付き、特殊記号を書くためのフォーマット制御文字列が使えます。 
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変数ラベルの定義を完了するには OK を押します。ODV はコレクションを作成して STATION モードに切り

替わり、初期設定では全球地図を描画します。初期のコレクションでは空なので、Import メニューのオプショ

ンを使ってコレクションにデータを読み込んでください。 

 

4.3 コレクション・ファイルの概要 (Collection Files Summary) 

本節では ODV コレクションを構成する様々なファイルの概要を述べます。この情報は関心のあるユーザー向

けで、問題や想定外の状況になった時に役立つでしょう。通常のユーザーはコレクション・ファイルの構造に

関心を持たなくてもかまいません。 

ODV はコレクション変数、測点、実データの値に関する情報を個別のファイル(それぞれ.var, .hob, .dob)に保

存します。設定ファイル.cfg にはデータそのものは含まれませんが、ユーザーがコレクション中のデータを「眺

める」方法を定義した設定を保存しています。設定には地図領域、測点選択基準、ウインドウのレイアウトや

他の多くのパラメーターが含まれています。コレクションの.var, .hob, .dob ファイルは全て同じディレクトリに置

かれなければなりません。.cfg ファイルはディスク上のどこにでも置くことができます。どのコレクション・ファイ

ルも手動で編集しないでください。 

表 4-2: ODVコレクション・ファイルの概要 

拡張子 フォーマット 注  釈 

   

基本ファイル  必  須 

<col>.var アスキー コレクション変数の定義、コレクション名と測点数の保存。Windows ではこのファ

イルタイプは ODV 実行形式ファイルに自動的に関連付けられるので、例え

ば.var ファイルをダブルクリックすると ODV が起動し各コレクションを開く。 

<col>.hob バイナリ 測点のメタデータ(名前, 位置, 日時など)の保存。 

<col>.dob バイナリ 実際の測点データと品質フラグの保存。 

   

情報ファイル  オプション 

<col>.info アスキー データセットの説明(自由書式のテキスト)。ODV は netCDF データセットを開い

たとき次元と変数の情報を含んだ.info ファイルを自動的に作成。 

   

補助ファイル  存在しなければ ODV が自動的に作成 

<col>.inv アスキー 航海毎に並べられたコレクションのインベントリ 

<col>.cid バイナリ 航海 ID 番号 

<col>.log アスキー コレクションのログファイル。データ変更記録を保管。 

<col>.idv アスキー 導変数に入力するためのキー変数(深さ、水温、酸素など)のキー変数の ID リス

ト 

<col>.cfl アスキー 直前に使用した設定ファイル名と出力ディレクトリ名が含まれています。 
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<col>はコレクション名を表わしています。全てのファイルは同じディレクトリ(コレクションディレクトリ)に置かれていなけれ

ばなりません。 

表 4-3: ODV設定ファイルの概要 

拡張子 フォーマット 注  釈 

<any>.cfg バイナリ レイアウト、数値範囲、選択された導変数や等値面変数、その他の多くの設定

を保存した設定ファイル。設定ファイルを持つコレクション名は.cfg ファイルの中

に記録される。別のコレクションがその.cfg ファイルを使う場合にはいくつかの制

約がある。 

<any>.sec アスキー 断面の輪郭と特性を保存。 

(上記の<any>で表わされる)ファイル名は任意です。Cfg と sec ファイルは任意のディレクトリに置くことができます。 

 

4.4 Windows, UNIX, Mac OS X 間の移動 (Migrating Between 

Windows, UNIX and Mac OS X) 

マルチプラットフォーム版 ODV で作成されたデータコレクションと設定ファイルは、プラットフォームに依存し

ないため、修正なしにサポートされている全てのシステムで使用することができます。Windows と Solaris 用の

ODV バージョン 4.0 またはそれ以降のバージョンで作成されたデータコレクションと設定ファイルもマルチプ

ラットフォーム版 ODV でサポートされています。 
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5 データの読み込み (Importing Data) 

5.1 ODV スプレッドシート・ファイル (ODV Spreadsheet Files) 

ODV は様々なスプレッドシート形式のアスキーファイルからデータを読み込むことができます。読み込みファ

イルのフォーマットが汎用 ODV スプレッドシート・フォーマットに準拠していれば、データの読み込みは全自

動で行われるのでユーザーの操作は不要です。汎用 ODV スプレッドシート・ファイルは ODV のウインドウか

アイコンにドラッグ&ドロップすることができます。一般 ODV スプレッドシート・フォーマットの仕様を満してい

れば、他のスプレッドシート・データファイルも同様に読み込めます。一般 ODV スプレッドシート・ファイルの

読み込みは、通常、ユーザーの操作を必要とします。ODV はそのファイルのフォーマットに関する情報の入

力を要求し、メタデータとデータ欄を特定するためにユーザーに問い合わせをします。 

ODV は測点メタデータ情報の有無、データ欄のラベル情報の有無に関わらず、スプレッドシート・データファ

イルをサポートしています。ODV スプレッドシート・ファイルにはコメントを含めることができます。カラム区切り

文字はタブ、セミコロン(;)、カンマ(,)、空欄、スラッシュ(/)のいずれかです。欠測は任意の数値のリストか空欄

とします。それが複数あれば一個以上の空欄で区切られていなければなりません。読み込みファイルの中で

空欄またはこれらの値のどれか一つが含まれている欄は欠測として扱われます。 

汎用および一般の ODV スプレッドシート・ファイルには多数の航海の多数の測点のデータを含めることがで

きます。ある測点の全サンプルは連続していなければなりませんが並び替えは不要です。ODV がファイルを

読んだとき、ある行から次の行にCruise, Station, Typeが一つ以上変わると測点が分けられます。Stationがデ

ータファイルに無ければ、mon/day/yr (月/日/年)、経度(東経、度単位)、緯度(北緯、度単位)がチェックされ

て、これらが一つ以上変わると測点が分けられます。これらのファイルから読み込んだデータは、現在開いて

いるデータコレクションに追加され、コレクションが開かれていなければ新たにコレクションが作成されます。 

汎用 ODV スプレッドシート・ファイルからデータを読み込むには、Import > ODV Spreadsheet を選んでコレク

ションを開き、標準のファイル選択ダイアログを使って読み込みたいデータファイルを指定します。読み込み

オプションを指定して OK を押すとデータの読込が始まります。汎用 ODV スプレッドシート・ファイルは ODV

アイコンまたは開かれている ODV ウインドウにドラッグ&ドロップすることもできます。 

一般 ODV スプレッドシート・ファイルからデータを読み込むためには、Import > ODV Spreadsheet を選んでコ

レクションを開き、標準のファイル選択ダイアログを使って読み込みたいデータファイルを指定します。ファイ

ルフォーマットが汎用 ODV スプレッドシート・フォーマットに準拠していなければ、Spreadsheet File Properties

ダイアログ・ボックスが現れますので、カラム区切り文字、欠測を示すデータ値(それが複数あれば一個以上

の空欄で区切られていなければなりません；空欄またはこれらの値のどれか一つが含まれていれば欠測とし

て扱われます)を指定してください。カラムのラベルを含む行(もしなければ空欄のまま)と最初のデータ行を指

定できます。ODV は全項目に対して妥当な初期値を与えますので、ほとんどの場合はほんの少し変えるだ

けで済みます。Column Sep. Character は、Column Labels ボックスにあるラベルのリストから選べます。スプレ
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ッドシート・ファイルの全ての情報を設定したら OK を、読み込みを中止するときには Cancel を押してくださ

い。 

メタデータ欄のラベルが汎用 ODV スプレッドシート・フォーマット(以降を参照)の仕様に準拠していなければ、

Header Variable Association ダイアログ・ボックスが現れるので、コレクションのメタデータ変数を入力された欄

と関連付けてください。すでに関連付けられている変数にはアスタリスク(*)が付いています。新たな関連付け

を定義するには、Source File と Target Collection のリストからそれぞれ項目を選んで Associate を押してくださ

い。読み込むときに変換を行いたい場合は Convert を押して有効な変換アルゴリズムのどれか一つを選んで

ください。既存の関連付けを削除する場合は、各々の変数を選んで Undo を押してください。読み込みファイ

ルに一つ以上のコレクション・ヘッダー変数の情報が含まれていときには次のようにして初期化します：(1)タ

ーゲット変数を選び、(2)set Default を押して、(3)初期値を入力します。指定した初期設定がファイルの全デ

ータに適用されることに注意してください。OK を押すと実行し、Cancel で中止します。最後に読み込みオプ

ションを指定して OK ボタンを押すとデータの読み込みが始まります。 

 

5.2 WOCE 海洋観測データ (WOCE Hydrographic Data) 

ODV を使って WHP 交換フォーマットのオリジナル海洋観測データを既存または新規データコレクションに読

み込むことができます。WHP 交換フォーマットのデータファイルは WHP DAC (http://whpo.ucsd.edu/)または

DVD-ROM で公開された WOCE 最終データセットから入手できます。既存コレクションにデータを読み込む

場合は先ずコレクションを開いてください。新規コレクションに読み込む場合はコレクションを作成して、コレク

ションに保存する変数の定義には WOCE WHP Bottle variables か WOCE WHP CTD variables のいずれか

を選択してください。 

WHP 交換フォーマットの採水データを現在開いているコレクションに読み込む場合は、ODV のメインメニュ

ーから Import > WOCE WHP Bottle (exchange format) > Single File を選んでください。WHP データセットの

選択には標準のファイル選択ダイアログを使用します。WHP 交換ファイルの標準拡張子は.csv なので注意し

てください。データファイルの拡張子が異なる場合は、ファイル選択ダイアログでファイル形式を All files にし

てください。読み込みオプションを設定して OK を押すと読み込みが始まります。ODV はデータファイルの全

測点を読み込みます。ODV は実データに加えて、WOCE データの品質フラグも識別して読み込みます。こ

れらの品質フラグは、後で解析するときに不良または疑わしデータを取り除くフィルターとして使えます。地図

ポップアップ・メニューから select critelia を選択(Sample Selection タブを選択)するとデータ品質フィルターを

修正できます。 

CTD データを現在開いているコレクションに読み込む場合は、ODV のメインメニューから Import > WOCE 

WHP CTD (exchange format) > Single File を選び、読み込む CTD データが含まれている.zip ファイルを選択

します。それから鉛直方向の sub-sampling パラメーターを指定するか、sub-sampling がなければ初期設定の

ままとします。ODV は.zip ファイルの圧縮を解いて現在開いているコレクションに CTD の全測点を読み込み



 

Ocean Data Viewユーザーズガイド 

 

27 

ます。 

一度の読み込み操作で複数の WHP 交換ファイルからデータを読み込むことができます。この場合には同じ

読み込みオプションがその操作中に読み込まれるすべてのファイルに適用されます。複数のデータファイル

を読み込むためには、読み込むファイル名が書かれた標準の拡張子が.lst であるアスキーファイルを用意し

てください。フルパス名で一行に一ファイル名を指定します。それから Import > WOCE WHP Bottle 

(exchange format) > Multiple Files または Import > WOCE WHP CTD (exchange format) > Multiple Files を

選び、読み込みオプションを指定して OK を押すとデータの読み込みが始まります。 

ODV は一測点あたり 20,000 サンプルまでのデータを扱うことができます。CTD 測点がそれ以上のサンプル

を含んでいる場合は切り捨てられます。ODV はソースファイルの圧力を深さに自動変換します。変数として

圧力が必要な場合には導変数 Pressure (Depth)を使ってください。 

読み込み中に ODV は WOCE の読み込みファイルから WHP または IGOSS の品質フラグを見つけて、対応

する ODV 品質フラグを割り当てます。品質フラグの割り当ての詳細は付録を参照してください。 

 

5.3 WOD 海洋観測データ (WOD Hydrographic Data) 

ODV で既存もしくは新規のデータコレクションに、World Ocean Database (WOD) からオリジナルの海洋観

測データを読み込むことができます。WOD データファイルは、WOD CD-ROM もしくはインターネットからダ

ウンロードしたデータファイルを直接読み込むことができます。既存のコレクションに読み込むにはコレクショ

ンを開き、新規コレクションに読み込むにはコレクションを作成して、コレクションに保存する変数を定義する

ときに World Ocean Database variables を選びます。現在開いているコレクションに WOD データを読み込む

には Import > World Ocean Database > Single File を選択します。読み込む WOD データセットの gz データ

ファイル(訳注: gzip で圧縮されたファイル)の指定には、標準のファイル選択ダイアログを使用します。すでに

展開された WOD ファイルを選ぶときにはファイル形式を All Files (*.*)とします。WOD の測点に合うように測

点選択基準を指定するか、現在の地図領域に収まる全測点を読み込むためには単に OK を押して、読み込

みオプションを指定して OK を押すとデータの読み込みが始まります。ODV は選択された WOD データファ

イルを読んで、測点の選択基準を満たす全ての測点を読み込みます。読み込まれた測点の航海ラベルは、

WOD の識別子、例えば “WOD98” または “WOD01” などの後に続く二桁の NODC 国コードと六桁の

OCL 航海番号で構成されます。ODV は特有の(他と重複しない)OCL プロファイル番号を測点番号として使

用します。ODV は読み込みファイルで見つかったデータ品質フラグを認識して使用します。 

一度の読み込み操作で複数の WOD ファイルからデータを読み込むことができます。この場合は、この操作

で読み込む全てのファイルに、同じ測点選択基準と読み込みオプションが使われます。複数のデータファイ

ルを読み込むには、読み込むファイル名を含むアスキーファイル(初期設定の拡張子は.lst)を用意しなけれ

ばなりません。フルパス名で一行につき一ファイル名を指定します。そして Import > World Ocean Database > 

Multiple Files を選び、WOD の測点に合う測点選択基準を指定し(現在の地図領域に収まる全測点を読み
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込む場合はそのまま OK を押します)、読み込みオプションを指定して OK を押すとデータの読み込みが始ま

ります。ODV は、アスキーファイルに記載された全ファイルを読み取り、測点選択基準を満たす全測点を読

み込みます。 

WOD データを読み込むとき、現在の地図領域に収まる測点だけが、実際にコレクションに読み込まれる点に

注意してください。全測点を読み込むためには、読み込みを開始する前に地図ポップアップ・メニューから

Global Map を選択しておくのを忘れないでください。 

読み込み中に ODV は、読み込みファイルで見つかった WOD 品質フラグを対応する ODV 品質フラグに変

換します。変換される品質フラグの詳細は付録を参照してください。 

 

5.4 WOA94 海洋観測データ (WOA94 Hydrographic Data) 

ODV で World Ocean Atlas 1994 の配布 CD からオリジナルの海洋データを直接読み込むには、Import > 

World Ocean Atlas 94 > Single File を選んでください。Windows 標準のファイル選択ダイアログを使って読み

込みたい WOA94 データセットのデータファイル(*.ol)を指定します。WOA94 の測点に合う測点選択基準を

指定し(現在の地図領域に収まる全測点を読み込む場合はそのまま OK を押します)、読み込みオプションを

指定して OK を押すとデータの読み込みが始まります。ODV は選択された WOA94 データファイルを読み取

り、測点の選択基準を満たす全測点を読み込みます。 

同じ測点選択基準と読み込みオプションを使って、一度の読み込み操作で複数の WOA94 ファイルからデ

ータを読み込むことができます。そのためには、読み込むファイル名(フルパス名で一行につき一ファイル名)

を含むアスキーファイル(初期設定の拡張子は.lst)を用意する必要があります。そして Import > World Ocean 

Atlas 94 > Multiple Files を選んで、WOA94 の測点に合う測点選択基準を指定し(現在の地図領域に収まる

全測点を読み込む場合はそのまま OK を押します)、読み込みオプションを指定して OK を押すとデータの読

み込みが始まります。ODV はアスキーファイルに記載された全ファイルを読み取り、測点の選択基準を満た

す全ての測点を読み込みます。 

現在の地図領域に収まる測点だけがコレクションに読み込まれる点に注意してください。全ての測点を読み

込むためには、読み込を開始する前に地図ポップアップ・メニューから Global Map を選択しておくのを忘れ

ないでください。 

 

5.5 SD2 海洋観測データ (SD2 Hydrographic Data) 

既存もしくは新規データコレクションに、NODC SD2 ファイルからオリジナルの海洋観測データを読み込むこ

とができます。既存コレクションに読み込むためには、先ずそのコレクションを開いてください。新規コレクショ
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ンに読み込むためにはコレクションを作成して、コレクションに保存する変数を定義するときに NODC SD2 

variables を選択してください。現在開いているコレクションに SD2 データを読み込むためには Import > 

NODC SD2 Format > Single File を選びます。読み込むデータファイルの指定には標準のファイル選択ダイ

アログを使用します。読み込みオプションを指定して OK を押すとデータの読み込みが始まります。 

一度の操作で複数の SD2 ファイルを読み込む場合は、全ての SD2 ファイルを一つのディレクトリに置いて、

読み込む SD2 のファイル名のリストを含むファイルを作ってください(初期設定のリストファイルの拡張子は.lst

で、一行につき一ファイル名)。Import > NODC SD2 Format > Multiple Files を選んでそのリストファイルを選

択してください。 

 

5.6 その他の海洋観測データ (Other Hydrographic Data) 

ODV スプレッドシート、WOCE WHP, World Ocean Database, World Ocean Atlas 1994, SD2 に加えて、ODV

は他の様々なフォーマットのデータ読み込みをサポートしています。これらには WOCE データの主流である

netCDF フォーマットはもちろんのこと、Java Ocean Atlas スプレッドシート・フォーマットも含まれます。現在開

いているコレクションにこれらのフォーマットのデータを読み込むには、Import メニューから適切なオプション

を選んでください。多くの読み込み方法では単一ファイルと複数ファイルの読み込みを選べます。複数ファイ

ルの読み込みには、読み込む全ファイルのフルパス名を含んだアスキーファイルを指定してください。単一フ

ァイルの読み込みは、読み込むデータを含んでいるファイルを指定します。全ての読み込み方法でユーザ

ーによる適切な読み込みオプションの指定が必要です。読み込み中に ODV は、読み込むファイルで見つか

ったデータ品質フラグを対応する ODV 品質フラグに変換します。品質フラグの変換に関する詳細は付録を

参照してください。 

ODV は、単純な XYZ データによる三カラムファイルを含む幅広い様々の他のスプレッドシート・フォーマット

もサポートしています。互換性を維持するために ODV は o4x 及び o3x 交換フォーマットもサポートしていま

す。 

 

5.7 読み込みオプション・ダイアログ (Import Options Dialog) 
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データを読み込む時には読み

込みオプション(Import 

Options)ダイアログが現れ、デ

ータ読み込み時の動作を定

義するようユーザーに促しま

す。 

 

図 5.1 : 読み込みオプション・ダイアログ 

Import Mode (読み込みモード) 

Add/Replace Station Data (測点データの追加/置き換え) : コレクションに読み込みファイルのデータ

を追加したい場合に選択してください。Check for Existing Stations ボックスがチェックされていれば、

ODV は同じ名前、日付、位置を持つ測点をコレクションから検索し、もし見つかればコレクション中の既

存の測点を読み込みファイルの新しい測点に置き換える許可を求めてきます(測点検索手順の詳細は

下記の Cruise Label Association (航海ラベルの関連付け)の項目を参照してください)。 

Merge Data (selected variables) (データの結合) : 一つ以上の変数(結合する変数)にデータを追加し

て、他の変数の既存データは変更したくない場合に選んでください。あるサンプルでの「結合変数

(merge variable)」の「結合(merged)」値は、下表のように既存値と新規値で変わります： 

既存値(Existing value) 新規値(New value) 結合値(Merged value) 

有り 有り 既存値と新規値との平均値 

有り 無し 既存値 

無し 有り 新規値 

無し 無し 欠測値 

 

Check for Existing Stations ボックスは、このモードのときには外せません。データを追加する前に、

ODV は一致する測点をコレクションから検索し(測点検索手順の詳細は下記の Cruise Label 

Association (航海ラベルの関連付け)の項目を参照)、もし見つかればコレクションからオリジナルの測

点を読み出し、選択した変数にデータを追加し、オリジナルの測点を更新されたものに置き換えます。

一致する測点が見つからなければユーザーに通知します。 
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Update Data (selected variables) (データの更新) : 一つ以上の変数(更新する変数)のデータを更新し

て、他の変数の既存データは変更したくない場合に選択してください。あるサンプルでの 「更新変数

(update variable)」の「更新(upadated)」値は新規の変数値だけに依存し、既存値は破棄されます。

Check for Existing Stations ボックスは、このモードでは外せません。データを更新する前に ODV は一

致する測点をコレクションから検索し(測点検索手順の詳細は下記の Cruise Label Association (航海ラ

ベルの関連付け)の項目を参照)、もし見つかればコレクションからオリジナルの測点を読み出し、選択し

た変数のデータを更新して、オリジナルの測点を更新されたものに置き換えます。一致する測点が見つ

からなければユーザーに通知します。 

Cruise Label Association (航海ラベルの関連付け) 

データの置き換えや結合の際に ODV は、まず初めに読み込まれる測点と一致する既存の測点をター

ゲット・コレクションから検索します。この検索では、航海名、測点名、測点タイプ、経度、緯度、日付を

比較します。一致の条件は航海名を除く全項目が同じことです。航海名については、ターゲット(Target)

とソース(Source)のコンボ･ボックスを用いて別名を作成することができます。例えば、既存のコレクション

に 06MT15/3 という名の測点群があり、読み込みファイルに METEOR15/3 という名で同じ測点群があれ

ば、まずターゲット・コンボ･ボックスから 06MT15/3 を選択して、それからソース・フィールドに

METEOR15/3 と入力して別名を設定することができます。ソース・フィールドの初期値はターゲット名と

同じなので、読み込みファイルと既存コレクションの航海ラベルが同じ場合には Cruise Label 

Association を全て修正する必要はありません。 

Variable Association (変数の関連付け) 

通常、読み込みファイルに保存されている変数の数, 並び、意味は、コレクションのそれらとは異なるの

で、変数のソース(Source)とターゲット(Target)を関連付けなければなりません。ODV は、変数と一致す

るラベル(名前と単位)を自動的に関連付けます。関連付けられた変数にはアスタリスク(*)が付き、その

変数をクリックすれば関連付けられた変数がわかります。 

手動で変数を関連付けるには、ソース変数をクリックしてから、そのソース変数に関連付けたいターゲッ

ト変数をクリックし、Associate または Convert のいずれかのボタンを押します。読み込みファイルのデー

タ値を無修整で読み込む場合には Associate を使用し、読み込み時に単位の変換が必要な場合には

Convert を使用してください。Convert では、あらかじめ定義された共通で使える変換方法から選ぶこと

ができ、自ら定義した汎用の線形変換式を作ることもできます。 

ODV スプレッドシートを読み込むとき、読み込みファイル中のソース変数に対応しないターゲット変数に

初期値を設定することができます。これは、例えば三つのカラム X/Y/Z を含んでいるアスキーファイルか

らある数量 Z の経度緯度座標を読み込みたいが、指定した表面または深さのデータが含まれていない

ときに役立ちます。ターゲット変数に初期値をセットするには、まず初めに Target Collection リストの中か
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ら変数を選択し、次に Use Default ボタンを押して、このターゲット変数に望ましい初期値を入力してくだ

さい。このターゲット変数には “ + ” が付けられます。指定した値は、この操作によって読み込まれる

個々の測点の個々のサンプルで使われます。 

ターゲット変数に関連付けられないソース変数はコレクションに読み込まれません。コレクションにデー

タを結合させたい場合は、コレクションに追加したい変数だけを関連付けしてください。どの ODV コレク

ションあっても第一変数には関連付けが必要です。 
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6 データの出力 (Exporting Data) 

6.1 スプレッドシート・ファイル (Spreadsheet Files) 

現在選択されている測点のデータを単独のアスキーODV スプレッドシート・ファイルに出力するには、ODV

のメインメニューから Export > ODV Spreadsheet を選び、出力ファイルに含めたい変数を選択して(初期設定

では全変数)、標準のファイル選択ダイアログ・ボックスを使って出力するディレクトリとファイル名を指定してく

ださい。スプレッドシート・ファイルは Import > ODV Spreadsheet で再度読み込むことが可能です。ODV スプ

レッドシート名にはスペース、¥ (訳注: 日本語キーボードでは円記号、それ以外の言語ではバック・スラッシ

ュ), / (スラッシュ), : (コロン) の文字を含めないでください。 

 

6.2 ODV コレクション (ODV Collection) 

現在選択されている測点のデータを新しい ODV コレクションに出力するには、ODV のメインメニューから

Export > ODV Collection を選び、新規コクションに含めたい変数を選択して(初期設定では全変数)、標準の

ファイル選択ダイアログ・ボックスを使って出力するディレクトリとファイル名を指定してください。ODV コレクシ

ョン名にはスペース、¥ (訳注: 日本語キーボードでは円記号、それ以外の言語ではバック・スラッシュ), / (ス

ラッシュ), : (コロン) の文字を含めないでください。 

 

6.3 アスキーリスト (ASCII Listings) 

現在選択されている測点のデータを単独のアスキーリストファイルに出力するには、ODV のメインメニューか

ら Export > ODV ODV 4.x Listing を選び、出力ファイルに含めたい変数を選択し(初期設定では全変数)、

Windows 標準のファイル選択ダイアログ・ボックスを使って出力するディレクトリとファイル名を指定してくださ

い。ODV 4.x リストファイルは Import > ODV4.x Listing を使って再度読み込むことができます。よい詳細な

ODV 4.x リストフォーマットの情報を見るにはここをクリックしてください。ODV リストファイル名にはスペース、

¥ (訳注: 日本語キーボードでは円記号、それ以外の言語ではバック・スラッシュ), / (スラッシュ), : (コロン) の

文字を含めないでください。 

 

6.4 X/Y/Z プロットデータの出力 (Exporting X/Y/Z Plot Data) 

二次処理(平均化、グリッド化、等値線の作成など)のために、ODV プロット・ウインドウに表示されたデータ値

をアスキーファイルに出力するには、ODV のメインメニューから Export > X/Y/Z Data を選び、この出力データ
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を識別する説明文(txtID)を入力して OK をクリックしてください。ODV はローカルの ODV ディレクトリ(通常

<home>¥odv_local)に export¥txtID の名前でサブディレクトリを作成して、全出力ファイルをこのディレクトリに

書き出します。既に同じファイルが存在する場合には、事前にこのディレクトリから全ファイルを削除する許可

を求めてきます。出力ファイル名は “win?” (ここで?は各ウインドウの番号を表す)から始まります。実際の

x-y-z-sigma_z データは、win?.oai ファイルにあります(一行につき一点のデータ)。 

グリッド領域のウインドウに関して、ODV はグリッド化処理の結果も出力できます(win?.oao ファイル)。.oao ファ

イルのフォーマットは次の通りです： 

0 (無視) 

nx  ny (x と y のグリッド・ポイント数) 

... nx X-grid values ... (X グリッドの位置) 

... ny Y-grid values ... (Y グリッドの位置) 

... nx*ny gridded values ... (最初の Y グリッド値から始まる X 行毎の推定フィールド) 

... nx*ny gridded values ... (最初の Y グリッド値から始まる X 行毎の推定品質) 

 

6.5 参照データセットの出力 (Exporting Reference Datasets) 

現在のプロット・ウインドウのオリジナルのデータをアスキーファイルに保存しておけば、これらのデータを参

照データセット(reference datasets)として後に使用することができます。ODV のメインメニューから Export > 

X/Y/Z Data as Reference を選んで、参照データを識別する説明文(txtID)を入力して OK を押してください。

ODV はローカルの ODV ディレクトリ(通常<home>¥odv_local)に reference¥txtID の名前でサブディレクトリを

作成し、このディレクトリに全ファイルを書込みます。ディレクトリが既に存在する場合は事前に現在の内容を

削除する許可を求めてきます。参照データは差分変数の定義に使用されます。 
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7 導変数 (Derived Variables) 

コレクション・ファイルに保存される基本変数に加えて、ODV では非常に多くの導変数(derived variables)を

計算でき、(一度定義すれば)基本変数と同様に解析やデータプロットに使用することができます。導変数に

は次の３種類があります： 

• 組込導変数(built-in derived variables)：海洋物理や海洋化学で一般的に使われているパラメータ

ーが多く含まれています。 

• マクロファイル(macro files)：ユーザー定義による数式がファイルに保存されたもので、任意の

ODV コレクションで使用できます。 

• 数式(expressions)：ユーザーがその場(on-the-fly)で定義できますが、現在のコレクションにしか使

用できません。 

導変数を定義または削除するには、キャンバス・ポップアップ・メニューから Derived Variables を選択するか、

メインメニューから Configuration > Derived Variables を選んでください。マクロを追加するには、Choices リス

トからマクロファイルを選んでください；ユーザー定義の数式の追加には〔Expression〕を選びます。組込導変

数の追加は Choices リストのその他の項目を選んでください。 

 

7.1 組込導変数 (Built-in Derived Variables) 

任意の基準圧力からのポテンシャル水温やポテンシャル密度、中立密度、Brunt-Väisälä (ブラント─バイサ

ラ)周波数、力学的高度といった海洋物理学のパラメーターのアルゴリズムが ODV には多数組み込まれてい

ます。さらに、海洋二酸化炭素の関する様々なパラメーターや大気中ガスの飽和度や濃度、海洋化学に関

する他の変数も簡単に同変数として選ぶことができます。鉛直積分や微分と同様に任意の二変数の比率の

ような役に立つ数式もあります。組込導変数のリストは以下の通りです。これらの全ての変数は、ユーザーの

要求に応じてその場(on-the-fly)で計算でき、コレクション・ファイルに記録されている基本変数と同様に解析

や可視化ができます。 

組込導変数の定義および削除は、キャンバス・ポップアップ・メニューから Derived Variables オプションを選

んでください。ODV は、利用可能な定義済み導変数のリストボックスを表示します。導変数を追加するには

Choices リストからその項目を選んで Add を押します。導変数を定義するのに必要な追加情報(例えばポテン

シャル水温やポテンシャル密度では基準圧力が必要)は、自動的に現れるダイアログ・ボックスに入力して

OK を押してください。多くの導変数では適切な入力変数の指定が求められます。 

導変数を削除するには、Already Defined リストボックスにある変数を選択して Delete を押すか、削除する項

目をダブルクリックしてください。他の導変数から入力を求められている変数を削除するときには、これらの数

量も同様に削除されてしまうことに注意してください。ODV マクロおよび数式を編集するためには、Already 
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Defined リストボックスにある各々の変数を選択して Edit を押してください。 

表 7-1: 組み込み導変数一覧 

変数名 コメント 

AOU [μmol/kg] Apparent oxygen utilization 

Brunt-Väisälä Freq. [cycl/h] EOS80 

CFC-11 Saturation [%] Warner & Weiss, Deep Sea Res., 32,1485-1497,1985 

CFC-12 Saturation [%] Warner & Weiss, Deep Sea Res., 32,1485-1497,1985 

CFC-10 Saturation [%] Bullister & Wisegarver, Deep Sea Res., 45,1285-1302,1998 

CFC-113 Saturation [%] Bu & Warner, Deep Sea Res., 42,1151-1161,1995 

CH4 Saturation [%] Wiesenburg & Guinasso,  J. Chem. Eng. Data,24,356-,1979 

CO*2(TCO2, TALK) [μmol/kg] (details) 

CO3
2-(TCO2, TALK) [μmol/kg] (details) 

Day of Month (header mon/day/year) Day of the Month derived from header mon/day/year 

Day of Month (time variable) Day of the Month derived from a time variable 

Day of Year (header mon/day/year) 
[days] 

Day of the Year [days] derived from header mon/day/year 

Day of Year (time variable) [days] Day of the Year [days] derived from a time variable 

Difference from Reference Data (details) 

Dynamic Height [dyn m] EOS80 (any reference pressure) 

fCO2 (TCO2, TALK) [μAtm] (details) 

Freezing Temperature [°C] F. Millero, UNESCO Tech. Papers in the Marine Science, No. 28., 29-35, 1978

HCO3
- (TCO2, TALK) [μmol/kg] (details) 

Latitude Decimal latitude derived from station header 

Longitude Decimal longitude derived from station header 

Month of Year (header mon/day/year) Month of Year derived from header mon/day/year 

Month of Year (time variable) Month of Year derived from a time variable 

Neutral Density [kg/m3] Jackett & McDougall, J. Phys. Ocean., 237-263, 1997 (more) 

OmegaA (TCO2, TALK) (details) 

OmegaC (TCO2, TALK) (details) 

Oxygen Saturation [%] Weiss, Deep Sea Res., 17, 721-735, 1970 

pCFC-11 [pptv] Warner & Weiss, Deep Sea Res., 32,1485-1497,1985 

pCFC-12 [pptv] Warner & Weiss, Deep Sea Res., 32,1485-1497,1985 

pCFC-10 [pptv] Bullister & Wisegarver, Deep Sea Res., 45,1285-1302,1998 

pCFC-113 [pptv] Bu & Warner, Deep Sea Res., 42,1151-1161,1995 

pCH4 [ppbv] Wiesenburg & Guinasso,  J. Chem. Eng. Data,24,356-,1979 

pCO2 (TCO2, TALK) [μAtm] (details) 

pHtot (TCO2, TALK)  (details) 

Potential Density [kg/m3] EOS80 (any reference pressure) 

Potential Temperature [°C] Bryden, Deep Sea Res.,20,401-408, 1973 (any reference pressure) 

Potential Vorticity [10-12 m-1 s-1] Planetary potential vorticity (derived from Brunt Vaissala Frequency Q=f/g*N2)

Pressure [db] Saunders, J. Phys.  Ocean., 1981 

Quality Flag Any variable 
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Ratio Any two variables 

Revelle Factor (TCO2, TALK) (dfCO2 / dTCO2) / (fCO2 / TCO2). (details) 

Sound Speed [m/s] Fofonoff & Millard, Unesco Tech. Pap. in Mar. Sci._, No. 44, 53 pp, 1983 

Specific Heat Cp  [J/(kg °C)] F. Millero et al, J. Geoph. Res., 78, 4499-4507, 1973 

Time (header mon/day/year) [yr] Decimal time [yr] derived from header mon/day/year 

Time (time variable) [yr] Decimal time [yr] derived from a time variable 

Vertical Derivative Any variable 

Second Vertical Derivative Any variable 

Vertical Integral Any variable 

Year (header mon/day/year) Year derived from header mon/day/year 

Year (time variable) Year derived from a time variable 

海洋二酸化炭素のパラメーター (Parameters of the carbon dioxide system in sea water) 

次の海洋二酸化炭素のパラメーターは導変数として用意されています。 

1. pH (total scale) 
2. fCO2, pCO2 

3. CO*2, CO3
2-, HCO3

-の濃度 

4. Revelle factor または homogeneous buffer factor 

5. calcite, argonite に対する [CO3
2-]*[Ca2+] / Ksp 溶解比、OmegaC, OmegaA 

これら全ての変量は現場の深度(圧力)、水温、塩分、全炭酸(TCO2)、アルカリ度(TALK)、リン、シリカの関数

として計算されます。リンおよび／またはシリカのデータがなければゼロと仮定します。アルカリ度の定義には

Dickson (1981)を使用し、HS, S, NH3 を除いた全ての項目に適用されます。pH は反復ニュートン法で計算さ

れます。 

平衡定数は Dickson & Goyet (1994)の概要に従います: K1, K2 は Roy et al. (1993), K0 は Weiss (1974), KB

は Dickson (1990), KS は Dickson (1990), KF は Dickson & Riley (1979), KW は Millero (1995), K1p, K2p, K3p, 

Ksi は Millero (1995), calcite と aragonite の溶解度積(solubility product) Ksp は Mucci (1983). 圧力依存の平

衡定数は Millero (1995)によります。(Lewis & Wallace (1998)にまとめられている)様々な出版物の誤植は考

慮されています。 

ODV (version 2.1 および以降)への炭酸系の実装は、他の独立したソフトウェアの結果と比較して検証されて

いて、その結果は Lewis & Wallace (1998)の CO2SYS.EXE アプリケーションの出力値と非常に良く一致して

います。以前のバージョンのODVは “potential” pHと炭素系パラメーター、例えば、水粒子を断熱的に海面

に上げた時の値で計算されていましたので注意してください。 

DOE (U.S. Department of Energy). 1994. Handbook of methods for the analysis of the various parameters of the carbon dioxide system in 
sea water. Version 2. ORNL/CDIAC-74. A. G. Dickson and C. Goyet (eds.), Carbon Dioxide Information Analysis Center, Oak Ridge 
National Laboratory, Oak Ridge, Tenn.  

Lewis, E., and D. W. R. Wallace. 1998. Program Developed for CO2 System Calculations. ORNL/CDIAC-105. Carbon Dioxide 
Informa-tion Analysis Center, Oak Ridge National Laboratory, U.S. Department of Energy, Oak Ridge, Tennessee.  
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鉛直積分の使用 (Usage of Vertical Integral) 

最初に鉛直積分を計算する変数を選択し(以降 A; 基本変数または定義済み導変数が使用可能)、積分の

開始水深 z0 を指定します(初期値は 0m)。ある測点の各サンプルに対し、ODV は z0 から各々の層までの積

分 A×dz を計算します。積分の単位は変量 A の単位×長さ(ODV では km を使用)です。体積濃度単位(例え

ばモル／立方メートル)の変数の積分は “standing stock per square meters” (単位水柱中のモル総量)になり

ます。定義によっては z0 での積分値はゼロになります。（例：水柱の海面から 500m までの塩分濃度(salt 

content)を求めるには、積分の変数として塩分を選択し、開始値は 0 とします。それから(近傍点の間では内

挿によって)500m での鉛直積分値を調べるか、SURFACE モードにおける等値面変数と同様に水深=500 に

おける積分を定義してください。） 

 

7.2 導変数のマクロ (Derived Variable Macros) 

あるサンプルの新しい導変数の値が同じサンプルの他の変数値にだけ依存するのであれば、組み込み導変

数のリストには含まれていない新しい導変数を実装できます。この場合にはマクロファイルに入力変数と新し

い導変量の式を指定してください。マクロファイルの拡張子は.mac で、ODV マクロディレクトリ 

(<home>¥odv_local¥macros) に置き、フォーマットは以下の仕様に従ってください。マクロの定義を容易にす

るために ODV マクロエディタを使用することができます(Utilities > Invoke Macro Editor で呼び出せます)。

ODV と共に配布されている実例のマクロファイルは各自の定義ためのサンプルファイルとして使ってくださ

い。 

マクロ導変数を使うには、キャンバス・ポップアップ・メニューから Derived Variables を選んで、利用可能な変

量のリストから Macro File を選択してください。それから ODV マクロディレクトリ(<home>¥odv_local¥macros)

にあるマクロファイルを選び、新しい変量の計算に必要な変数を指定してください。必要な変数のどれか一

つでも利用できなければ Not Available を押してマクロファイルの設定を中止してください。 

 

7.2.1 マクロエディタ (Macro Editor) 

Ocean Data View マクロファイルは Utilities > Invoke Macro Editor オプションを使って作成し編集することが

できます。既存のマクロファイルを選択するか新規マクロ名を選んで、下記の手順に従ってマクロを定義して

ください。終了するには OK を押しマクロ名を指定します。 

マクロ変数 (Macro Variable) 

ラベル (Label) : マクロ変数のラベルと単位を入力してください。様々なフォーマット制御文字列が使えま

す。 

フォーマット (Format) :  ODV テキストウインドウの数値フォーマット: フィールド長と小数点以下の桁
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数を入力してください。 

コメント (Comments) 

マクロ変数を説明する一行以上のコメントを入力してください。 

入力変数 (Input Variables) 

マクロ変数に必要な入力変数のリスト。入力変数の追加には、Newフィールドにそのラベルと単位を入力して

<<ボタンを押してください(上述した制御文字列が使えます)。定義済みの入力変数を削除するには Defined

リストボックスからそれを選んで>>ボタンを押してください。ODV マクロは最大九個の入力変数を扱えます。 

数式 (Expression) 

数式欄にはマクロ変数の計算を実行する演算を指定します。基本算術演算子 + - * / **, 平方根 sqrt, 前二

つの被演算数の最小または最大をとる min と max, 自然対数 ln, 指数関数 exp, 正弦 sin と余弦 cos (引

数はラジアン)、絶対値 abs が使えます。逆ポーランド記法 (Reverse Polish Notation; 被演算数を演算子より

前に記述する；例 Hewlett-Packard 電卓スタイル)を使用してマクロ式を入力し使用します。例えば、文字列#1

は入力変数値#1 の値を参照します。 

記号%H, %t, %d, %x, %y は、それぞれ測点における地理的高度(単位はメートル；陸が正、海が負)、観測

時間(1900 年からの年；例えば%t=84.4877 は Jun/27/84 を示します)、年内経過日数、東経、北緯を指します。

高度%H は GEBCO1 か ETOPO2 のオプションパッケージをインストールした場合だけ利用できます。 

演算子=%0, =%1, …, =%9 を使用して内部変数%0, %1, …, %9 に中間結果を格納することができます。格

納された値は、%0¸ %1 のように記述して後の計算で使用することができます。=%n 演算子は、それらの被演

算数を消滅させてしまうことに注意してください：例えば、それぞれの値はスタックから取り除かれます。演算

子と被演算数は一つ以上の空白で区切ってください。必要ならば次の行に続けてマクロ式の定義してくださ

い。演算式の定義では 500 文字を越えないようにしてください。 

 

7.2.2 ODV マクロの書式 (ODV Macro Format) 

テキストエディタでマクロファイルを用意する場合は、以下の ODV マクロファイル・フォーマットの説明に従っ

てください。上述の ODV マクロエディタを使う場合は、本節は読み飛ばしてください。 

ODV マクロファイルの一行目は、文字列 “ODV4.0 Macro” で、識別の目的のためだけに使用されます。荷

行目はファイルの残りの行の整形を容易にするための目盛です。実際の新しい導変数の定義は三行目から

始まり、六桁目から新しい変数のラベルが置かれ、ODV テキストウインドウで表示される数値フォーマット ll.d

は 66 桁目から始まります。ここで ll はテキストフィールドの長さを、d は小数点以下の桁数を表します。以降は、

新規変数の計算に使われる他の変数(基本または定義済み導変数)が一行に一つずつ続きます。これらの
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行は一桁目の#に続く一桁の数字(1, 2 , ...9 の順)で始まります。使用される変量を説明する名前を六桁目か

ら入力してください。上述したギリシャ文字、上付き文字、下付き文字のための制御文字列が使えます。 

マクロファイル po.mac の例 

ODV4.0 Macro 
>|--->----------------------------------------------------------|>--| 
     PO [~$m~#mol/kg]                                             5.0 
#1   Phosphate [~$m~#mol/kg] 
#2   Oxygen [~$m~#mol/kg] 
 
135 #1 *  #2 + 

計算に使われる変数のブロックは、測点の各観測層に対して実際に実行される代数演算の定義と一つの空

行で区切られます(上述のマクロファイルの例を参照)。基本算術演算子 + - * / **, 平方根 sqrt, 前二つの

被演算数の最小または最大をとる min と max, 自然対数 ln, 指数関数 exp, 正弦 sin, 余弦 cos (引数はラジ

アン)、絶対値 abs が使用できます。Hewlett-Packard 電卓のように(被演算数を演算子より前に記述；逆ポーラ

ンド記法)マクロ式を入力して使用してください。例えば、文字列#1 は入力変数#1 の値を参照します。記

号%t, %d, %x, %y は、それぞれ観測時間(1900 年からの年; 例えば%t=84.4877 は Jun/27/84 を示します)、 

年内日数、東経、北緯を表わします。演算子=%0, =%1, …, =%9 を使用して内部変数%0, %1, …, %9 に中

間結果を格納することができます。格納された値は%0, %1 のように記述して後の計算で使用することができ

ます。=%n 演算子は、それらの被演算数を消滅させてしまうことに注意してください：例えば、それぞれの値

はスタックから取り除かれます。個々の項目(被演算数と演算子)は少なくとも一個の空白で区切って、必要な

らば次の行に続けてマクロ式を定義してください。演算式の定義は 500 文字を越えないようにしてください。

ODV で同時に動作するマクロの最大数は 10 個です。 

変量 PO = 135 * PO4 + O2 を計算する上述の例では、文字列 135 #1 * は 135 と現在のサンプルの変数#1

の積を計算します。一度実行すると、文字列 135 #1 * は掛け算の結果に置き換えられ、それから変数#2 の

値が加えられます。一つ以上入力変数が測定されていなければ、導変量の値には-1.e10 (欠測値)がセットさ

れます。 

ODV のマクロ機能は広範囲に適用できるように一般化されています。以下に二つの例を示します。 

(a) t0 を基準とした放射性トレーサーの崩壊(ここでは t0=1980; τ=17.6 年とします)： 

T(t0) = T(t) e(t - t0)/τ 

ODV4.0 Macro 
>|--->----------------------------------------------------------|>--| 
     Trit80 [TU]                                                  7.2 
#1   Tritium [TU]        
 
%t 80 - 17.6 / exp #1 * 
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(b) 水塊特性の複数のパラメーター距離(ここではポテンシャル水温、塩分、シリカを使用)： 

C = {(c - c0) / σ }2 + ... 

ODV4.0 Macro 
>|--->----------------------------------------------------------|>--| 
     MP-Dist{10,34.7,25}                                          7.0 
#1   Tpot [C] 
#2   Salinity [psu] 
#3   Silicate [umol/kg] 
 
#1 10   - 0.1  / 2 **  
#2 34.7 - 0.05 / 2 ** + 
#2 34.7 - 0.05 / 2 ** + 

 

7.3 数式 (Expressions) 

数式はマクロと似ていて、同じ機能を使用でき、ODV マクロエディタで定義して編集することもできます。数

式を設定するにはキャンバス・ポップアップ・メニューから Derived Variables を選び、利用可能な変量のリスト

から Expression を選んで Add を押してください。すると ODV はマクロエディタ・ダイアログと同様のダイアログ

を表示します。ここでラベル欄に新規変数のラベルと単位を入力してください。それから新規変数に必要な

入力変数を選びます。例えば、変数を Choices リストから選んで<<を押します。最後に新しい変量を求める数

式を指定します。基本算術演算子 + - * / **, 平方根 sqrt, 前二つの被演算数の最小または最大をとる min

と max, 自然対数 ln, 指数関数 exp, 正弦 sin, 余弦 cos (引数はラジアン)、絶対値 abs が使えます。

Hewlett-Packard 電卓のように(被演算数を演算子より前に記述；逆ポーランド記法)マクロ式を入力して使用

してください。例えば、文字列 #1 は入力変数 #1 の値を参照します。 

記号%H, %t, %d, %x, %y は、それぞれ測点における地理的高度(メートル単位；陸が正、海が負)、観測時

間(1900 年からの年；例えば%t=84.4877 は Jun/27/84 を示します)、年内経過日数、東経、北緯を表わします。

高度%H は GEBCO1 か ETOPO2 のオプションのパッケージをインストールした場合だけ利用できます。 

演算子=%0, =%1, …, =%9 を使用して、内部変数 %0, %1, …, %9 に中間結果を格納することができます。

格納された値は%0, %1のように記述して後の計算で使用することができます。=%n演算子は、それらの被演

算数を消滅させてしまうことに注意してください：例えば、それぞれの値はスタックから取り除かれます。個々

の項目(被演算数と演算子)は少なくとも一個の空白で区切って、必要ならば次の行に続けてマクロ式を定義

してください。演算式の定義では 500 文字を越えないようにしてください。新しい数式のセットアップを完

了させるには OK を押します。 

ODV マクロおよび数式を編集するにはキャンバス・ポップアップ・メニューの Derived Variables オプションを

使用してください。次に Already Defined リストボックスで、それぞれの変数を選択し Edit を押します。Edit 

Expression ダイアログで Save As を押すと ODV マクロファイルに数式を保存することができます。 
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図 7.1: 数式編集ダイアログ・ボックス 
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8 対話的制御と ODV のモード (Interactive Controls 

and ODV Modes) 

8.1 現在のサンプルと測点の選択 (Choosing Current Sample and 

Current Station) 

コレクションを開いて ODV が測点図を描いたとき、地図中の有効な測点の一つが現在の測点です。この測

点は赤い十字記号で示され、測点のメタ情報が ODV テキストウインドウの最上行に表示されます。新しく現

在の測点を選択するには以下の方法があります： 

(1) 地図中の任意の測点をマウスの左ボタンでクリックします。同じ位置に複数の測点があるときは、そ

の測点上でシフトキーを押しながらマウスの左ボタンをクリックすると、一致する測点のリストが表示さ

れますので、現在の測点にしたいものを一つを選んでください。シフトキーを押していなければ、初

期設定では最後の測点が選ばれます。 

(2) 地図ポップアップ・メニューから Current Station by Name を選んで、航海ラベル, 測点ラベル、測点

タイプを指定します。 

(3) 地図ポップアップ・メニューから Current Station by Number を選んで(または単に#を押して)、測点の

内部連続番号を指定します。 

(4) 右矢印キー(‐>)を押すと次の有効な測点を選択できます。 

(5) 左矢印キー(<‐)を押すと前の測点に戻ります。 

現在の測点におけるサンプルの一つが現在のサンプルとなります。この現在のサンプルのデータ値は ODV

テキストウインドウの三行目に表示されます。画面上にデータプロットが表示されていれば、現在のサンプル

も各プロット中に赤い十字記号で示されます。成分間プロットでは、現在の測点の全データ値が赤線で強調

表示されます。強調表示の方法は、各々のプロットの Display Option ダイアログで変更することができ、完全

に消すこともできます。 

同じ測点の次または前のサンプルは、上向き下向きの矢印キーまたは PgUp/PgDn キーを押して選べます。

また、データプロット中のデータ点を単にマウスの左ボタンでクリックすると現在のサンプルにすることができ

ます。ODV テキストウインドウの情報は、新しい測点かサンプルを選択すると自動的に更新されます。 

テキストウインドウの二行目または三行目の項目上にマウスを動かすと、品質フラグを含むデータ値の詳細な

情報を示すポップアップ・ウインドウが現れます。テキストウインドウに並べられる変数の数値フォーマットと順

序を変更するには、テキストウインドウ・ポップアップ・メニューから Variables Settings を選んでください。 
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8.2 変数設定の変更 (Changing Variable Settings) 

すべてのコレクション変数について、ODV テキストウインドウの三行目に表示される変数のラベル、最小／最

大範囲の初期値、数値フォーマット、位置を変更するには、テキストウインドウ・ポップアップ・メニューの

Variables Settings オプションを使います(テキストウインドウでマウスの右ボタンをクリックして Variables 

Settings を選んでください)。 

最初に Variable コントロールを使って修正したい変数を選択します(マウスの右ボタンをクリックしたときに

各々の変数上にマウスがあれば、その変数はすでに選択されています)。そして、この変数に別のプロパティ

を設定してください。Label 項目を編集すると変数ラベルと単位の文字列が変更されます。単位はカギ括弧 

[]で囲んでください。Minimum と Maximum の項目を設定すると、変数の上限と下限の初期値を変えられま

す。Format 項目を設定すると、テキストウインドウの三行目にある変数のリストデータに使われる数値フォーマ

ットを修正できます。最初の数字でフィールドの長さ(文字数)を指定し、２番目の数字で小数点以下の桁数を

指定します。最後に Position コンボボックスを使ってテキストウインドウの変数の位置を変更できます(変数の

新しい位置を選択できます；例えば(現場)水温の次にポテンシャル水温)。引き続き他の変数を変更して

(Variable コンボボックスで選択します)、終了時に OK を押してください。 

 

8.3 選択基準の変更 (Changing Selection Criteria) 

測点図を描くとき、ODV はコレクションの各測点をチェックして、現在の測点選択基準を満たすかどうかを調

べます。この検査を通過した測点だけが有効とみなされ、地図上に表示されて以降の閲覧やプロットに使用

されます。 

測点およびサンプルの選択基準を修正するには、地図ポップアップ・メニューの Selection Criteria またはメイ

ンメニューから Configuration を選択し Selection Criteria を使ってください。それぞれのタブ、例えば

Name/Range, Date/Time, Availability や Sample Selection をクリックして修正したいカテゴリーを選択し、必要

な項目を設定します。 
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図 8.1: 選択基準ダイアログ 

Name/Range タブでは、航海ラベル、測点ラベルの範囲、測点のタイプ、内部連続番号の範囲、測点の水深、

最深観測深度で測点を選ぶことができます。航海ラベルによる選択に関しては、リストから航海名を選ぶか、

航海ラベル欄に正規表現(ワイルドカード・パタン)を指定できます。後者の場合は、どの正規表現に一致した

航海ラベルが有効となります。航海ラベルに関する正規表現には以下の文字を含めることができます： 

表 8-1: 航海ラベルに関する正規表現の文法 

任意の文字 以下を除くそれ自身を表わす 
例: c は文字 c に一致する。 

? 任意の一文字に一致 
例: SAVE_LEG? は SAVE_LEG1, SAVE_LEG2, SAVE_LEG9, SAVE_LEGa などに一致 

* 0 個以上の任意の文字に一致 
例: I01_* は最初が I01_である全てのラベルに一致；*06AQ* はラベル中に 06AQ を含む全

てのラベルに一致 

[…] カギ括弧内に並べられた文字列。文字クラスの内では、その外のようにバックスラッシュ(訳注：

日本語キーボードでは円記号)は特別の意味を持ちません。ダッシュ(-)は文字列の範囲を示

すのに使われます；最初の文字としての、すなわちカギ括弧の直後のキャレット(^)は続く文字

以外に一致します。 
例: I05[EW]は I05Eと I05W に一致；LEG[0-2]はLEG0, LEG1, LEG2に一致；SAVE_LEG[^3]
は SAVE_LEG3 を除いた全ての SAVE_LEG?に一致。 

 

Date/Time タブでは、有効な時間間隔、有効な月のサブセットおよび日時の範囲を指定できます。Domain カ

テゴリーでは、各々の経度／緯度の値を指定して地図の矩形サブ領域を定義でき、Zoom ボタンを押すと矩
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形の拡大を定義できます。Polygon ボタンを押してマウスで多角形の頂点を入力すると、その多角形を有効

な領域として定義できます。このとき多角形は自動的に閉じられます。Availability カテゴリーでは、測点が有

効と見なされるために存在しなければならない一つ以上の変数をマークできます。Sample Selection カテゴリ

ーでは、指定した変数(Validate Variable)の範囲を指定するか、信頼できるデータ品質レベルを要求して、

データ品質フィルターを設定できます。与えられた範囲外の Validate Variable の値を持つサンプルは全て除

外されます。Invert タブで測点の選択を逆にすることができます。例えば、基準を満たさないすべての測点を

選択するには Invert Selection ボックスをチェックしてください。設定が完了したら OK を押してください。ODV

は新しい選択基準を用いて測点図を再描画します。 

 

8.4 地図投影法の変更 (Changing Map Projections) 

地図ポップアップ・メニューの Display Options を使って地図投影法を変更できます。General タブを選択して

Map Projection ボックスから投影法を一つ選んでください。現時点で選べる投影法は次の通りです：(1)初期

設定の投影法、(2)正射図法(北極)、(3)正射図法(赤道)、(4)正射図法(南極)、(5)正射図法(Oblique(斜角))、

(6)モルワイデ図法(Mollweide)。初期設定の投影法は経度／緯度が線形です。正射図法は半球ですが、初

期設定の図法とモルワイデ図法は全球に拡張されます。全ての投影法においてマウスによる拡大や地図の

Display OptionsダイアログのDomainタブを使ったサブ領域の定義が可能です。正射図法(斜角)では全球を

表示させる任意の経度／緯度で視点(極)を指定できます。他の投影法では極緯度は固定されていて極の経

度だけ変更できます。 

(2)から(6)までの投影法では、拡大によるサブ領域の定義が微妙なので、精密な結果が必要な場合には地

図の Display Options ダイアログの Domain タブを使用するか、一旦、初期設定の投影法に切り替えて拡大

(それによりサブ領域を定義)して、最後に希望する地図投影法に切り換えてください。 

他の地図表示オプションの記述は表示オプションの変更(Changing Display Options)を参照してください。 

 

8.5 全画面測点図 (Full Screen Station Maps) 

ファンクションキーの F8 を押すか、キャンバス・ポップアップ・メニューから Use Template > MAP を選ぶと、全

画面の測点図が描かれます。地図中の測点をダブルクリックすると測点にラベルを追加することができ、削除

(Del)ボタンを押すと現在の測点の注釈を取り除くことができます。注釈の位置は測点の位置とダブルクリック

したときのマウスの位置との関係に依存しますので試してみてください。Display Options ダイアログ・ボックス

で注釈のスタイルとフォントサイズを変更できます。File > Print を選択すると測点図のハードコピーを作成で

きます。またメインメニューから File > Save Canvas As を選ぶと地図の PostScript, PNG, JPG ファイルを作成で

きるので、希望するフォーマットを選んでください。 
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図 8.2: 南極海における R.V. Polarstern ANT VIII/2 の航跡図 
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8.6 成分間プロット (Property-Property Plots) 

ODV が STATION モードのとき(ウインドウの右下隅に示されます；[F9]を押すか、キャンバス・ポップアップ・

メニューの Use Template で定義済みの STATION テンプレートの一つを選ぶと、STATION モードに切り替え

られます)、[p]を押すか、地図の現在の測点上でマウスの左ボタンをダブルクリックすると、現在の測点の成

分間プロット(property/property plots)が描かれます。他の測点のデータをプロットに追加するには、追加した

い測点をダブルクリックするか、現在の測点としてそれらを選択して[p]を押してください。プロットから選択さ

れている測点の一つを削除するには、現在の測点にして(例えばどれか一つのプロットで、どれか一つのそ

のデータの点をクリックして)、[Del]キーを押してください。画面をクリアするには[Ctrl-x] を押してください。選

択されている測点のリストをクリアするには[Ctrl-x]を二回押してください。 

参照： 拡大と自動スケーリング; 新規 X, Y 変数の選択; 表示オプションの変更; 印刷; PostScript ファイ

ル。 

 

図 8.3: 南大西洋ベンチレーション実験(South Atlantic Ventilation Experiment, SAVE)の五測

点分の成分間プロット 

 

8.7 拡大と自動スケーリング (Zooming and Automatic Scaling) 
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いずれかのデータプロットの変数の範囲を変えるには、そのウインドウにマウスを移動させて、右ボタンをクリ

ックしてデータプロット・ポップアップ・メニューを呼び出し、Full Range または Zoom を選びます。Full Range

では現在のウインドウの X と Y の範囲を、全データが収まるようにウインドウを調整します。Full Range (All)を

使用すると画面上の全データプロットが自動的にスケーリングされます。 

Zoom を選択すると赤い拡大枠が現在のウインドウに現れます。この拡大枠を操作するには、拡大枠の上に

マウスを移動させて、マウスの左ボタンを押して希望する位置に枠をドラッグしてください。拡大枠の現在の

設定を適用して、それに応じて変数の範囲を調整するには、マウスの左ボタンをダブルクリックするか

ENTERキーを押してください。拡大操作を中止して現在の変数の範囲を維持したいときは、ESCキーを押す

かマウスの右ボタンをクリックしてください。 

これに加えて、標準的な拡大操作で最大化をコントロールできる quick-zoom オプションも利用できます。マウ

スが地図上またはどれかのデータプロット上にあるとき[Ctrl]キー(マッキントッシュシステムでは[Apple]キー)

を押したまま、マウスの左ボタンを押して拡大枠をドラッグしてください。マウスの左ボタンを離すと

quick-zoom で操作された拡大枠の設定がウインドウに適用されます。 

 

8.8 ウインドウ・レイアウトの変更 (Changing Window Layout) 

ODV では、モード毎(STATION, SCATTER, SECTION, SURFACE)にウインドウ・レイアウトの情報を保持し

ています。レイアウト情報には地図およびデータプロットの位置とサイズ、データプロットの数、X-,Y-,Z-軸の

変数、記号のサイズ、地図の地形ファイルの選定が含まれます。それぞれのモードでキャンバス・ポップアッ

プ・メニューを(キャンバスエリア上で右マウスをクリックして)呼び出し、Graphics Layout を選択すると、それぞ

れのウインドウ・レイアウトを変更できます。ODV は現在のレイアウトの輪郭を描くので、ウインドウの移動、サ

イズの変更、削除、作成ができます。ウインドウ上でこれらの操作を実行するには、そのウインドウにマウスを

動かし、右ボタンをクリックしてレイアウト・ポップアップ・メニュー(layout-popup menu)を呼び出し、適切なオプ

ションを選びます。 

Move/Resize を選択すると赤い拡大枠がそれぞれのウインドウに現れますので、マウスの左ボタンを押したま

まドラッグして、この拡大枠を移動させたり大きさを変更したりしてください。ウインドウの新しいサイズや位置

を適用するには、マウスの左ボタンをダブルクリックするか、[ENTER]キーを押してください。Move/Resize の

操作を中止してウインドウの状態を変更させたくない時には[ESC]キーを押します。オーバーレイ・ウインドウ

(以下を参照)は動かしたり大きさを変えたりできません。 

新しいウインドウを作成するには、既存のウインドウの一つにマウスを動かし、右ボタンをクリックして Create 

New Window または Create Overlay Window オプションを選んでください。どちらの場合も新しいウインドウの

初期プロパティは既存のウインドウから引き継がれます。Create New Window を使うと新しいウインドウが

ODV グラフィックス・キャンバスの中央に置かれるので、上述の Move/Resize オプションを使って位置と大きさ

を決めてください。Create Overlay Window を使用すると、オーバーレイ・ウインドウが必要とするいくつかのプ
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ロパティが自動的に設定され、新しいウインドウは既存のウインドウ上に積み上げられます。Window Layout

モードから抜け出た後は、それぞれのウインドウの Display Options ダイアログを呼び出して新しいウインドウ

のプロパティを変更することができます。 

あるウインドウの X-, Y-, Z-軸に新規変数を選ぶには、適切なオプションを選択し、表示されるリストボックスか

ら変数を選んでください。初期設定では、変数の値は右と上の方向に増加します。方向を逆にするには(例

えば水深図の水深)、Reverse Variable Range ボックスをチェックしてください。選択を適用する場合は OK を

押します。 

Window Layout モードの終了は Accept か Cancel を選択してください。地図やデータプロットの他のプロパテ

ィを変更するには、地図やデータプロットのポップアップ・メニューから Display Options 機能を使用します。 

 

8.9 表示オプションの変更 (Changing Display Options) 

地図およびデータプロット・ポップアップ・メニューの Display Options 機能を使って、地図やデータプロットの

表示プロパティを変更できます。これらのメニューを呼び出すには、それぞれのウインドウ上にマウスに動か

して右ボタンをクリックします。オーバーレイ・ウインドウ(二つ以上のウインドウが互いの上に積み上げられて

いる)の場合、この方法では一番上のウインドウにしかアクセスできませんので、Configuration > Window 

Properties > …を使って個々のウインドウのプロパティを変更してください。 

 

8.9.1 地図 (Map) 

Map Display Options ダイアログでは、General, Layers, Domain, Annotations の四つのカテゴリーに関する地

図プロパティを修正できます。これらのカテゴリーにアクセスするには、それぞれのタブをクリックします。詳細

については以下を参照してください。 
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図 8.4: 地図表示オプション・ダイアログ・ボックス 

General (一般) 

地図に使用するカラーパレットを選択して、背景色を選び、グリッド線の有無を指定します。地図投影法を指

定し、測点を示す点の色と記号のサイズを選びます。測点を示す点の色は航海ラベル毎に異なる色が(自動

的に)選ばれます。 

Layers (レイヤー) 

ODV は、地図ウインドウ中に海底地形、海岸線、陸上地形、他に追加情報として、湖沼、河川、境界、流氷

の張出し，海洋フロントなども描画できます。複数のレイヤーを持つ地図のサンプル GIF ファイルは ODV が

インストールされたディレクトリの下の samples ディレクトリにあります。低解像度の全球地理情報ファイル

(GlobLR シリーズ)は、ODV をインストールしたときの初期設定です。高解像度の全球および地域データセッ

トはオプショナルパッケージとして利用でき、いつでもダウンロードしてインストールできます。Series リストから

インストールされたシリーズの一つを選んでください。Bathymetry/topography カラーバーを描きたい場合は

Draw Color Bar ボックスをチェックしてください。 

上述の地理情報は、ODV により個々のレイヤー上で実行されて描画されます。これらのレイヤーは、

(1)pre-Bathymetry, (2)Ocean Bathymetry, (3) pre-Coastlines, (4)Coastlines, (5)pre-Topography, (6)Land 

Topography, (7)post-Topography の七つのレイヤーセットに分類されています。Layer Sets リストで選択して

Compose ボタンを押すとレイヤーセットを合成します。ODV は、このレイヤーセットに関して利用可能なレイヤ

ーリストを表示します。利用可能なリストから(標準的な一つもしくは複数を選択する方法を使って)一つ以上

のレイヤーを選び、描画特性を指定して<<ボタンを押すと Selected list にレイヤーが追加されます。Selected 

list からレイヤーを削除するには>>を押してください。 

描画特性の指定は以下の規則に従ってください： 
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(a) (一筆書の)線で地形の輪郭を描く場合は、適切な線の幅、種類、色を選択し、輪郭が不要な場合

は色に none を選びます。Windows の制約によって 1 ピクセル幅以上の線は、画面上および PNG

と JPG ファイルでは常に実線になりますが、ODV PostScript ファイルではどのような線の幅でも、選

んだ通りになります。 

(b) 地形を塗りつぶす場合は適切な色を、そうでない場合は none を選んでください。 

線と塗り潰しの色に automatic を選ぶと、ODV は初期設定の色を使用します。一部のレイヤーでは、

automatic の初期値が none に設定されていますので注意してください。また、河川や境界のような一部の地

形ファイルは塗り潰せないので、塗り潰しの色には none を設定しなければなりません。 

ODV が地図を描くときには、上述の順にレイヤーセットを処理します。あるレイヤーセットに関しては、

Selected list に表示された順で個々のレイヤーが描かれます(海底地形と陸上地形のレイヤーは、それらが追

加されたときに自動的に並び替えられます)。海氷の分布は pre-Coastlines で、湖沼、河川、境界線は

post-Topography で定義してください。 

Domain (領域) 

サブ領域の緯度経度を指定するか、コレクションの全領域または全球地図に切り替えます。 

Annotations (注釈) 

選択した測点に航海および／または測点にラベルを持たせるかどうかを指定して、ラベルのフォントサイズを

設定します。このオプションは全画面の MAP モードと STATION モードだけに適用可能です(ファンクション

キーの F8 または F9 を押してこれらのモードに切り替えてください)。MAP モードと STATION モードで測点を

選ぶには、測点上でマウスの左ボタンをダブルクリックしてください。ラベルの位置は、測点の位置に対する

マウスポインタの位置で決まります。ラベルを測点の位置の上に表示させたい時は、測点より少し上を指して

ダブルクリックしてください；ラベルを測点の右下に表示させたい時は、右下の位置を同様にダブルクリックし

てください。 

 

8.9.2 データプロット・ウインドウ (Data-plot windows) 

成分間プロット(property/property plots, STATION モード)では、記号のサイズとデータ点間の結合線の幅を

設定してください。記号なし、または結合線なしの場合はゼロを選びます。 
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図 8.5: データプロット・ウインドウ(STATION モード)の表示オプション・ダイアログ・ボックス 

散布図、断面図、等値面図(SCATTER, SECTION, SURFACE モード)では、表示スタイル(Original Data: カ

ラー点、数値、矢印；Quick Gridding; VG Gridding)、オリジナルデータの点(またはフォント)サイズ、(散布図

の)点のサイズ、グリッド領域の X-, Y-方向の平均の長さスケールを設定できます。二種類の異なるグリッド化

アルゴリズムが利用でき、どちらも等値線の描画をサポートしています。また、X と Y の長さスケールは、各軸

の範囲を千分率(1/1000)で測って、大きな値であれば滑らかな領域が得られます。異なる長さスケールを試

してみて、最も好ましいものを選んでください。 

流速データの矢符プロットを作成するには、Original Data ラジオボタンをクリックして、その真下のコンボボッ

クスから Arrows を選択します。自動的に現れる Arrow Properties ダイアログ・ボックスで矢符の X-, Y-成分を

選択し、矢符のスケール、線幅、色を指定してください。矢符の色を自動選択にすると、矢符に与えられる色

はその場所の Z 変数で決まります。 

データ点の位置を示すには、Draw Marks ボックスをチェックして、記号のサイズを設定し、色を指定します。

グリッド領域を持ったデータ・ウインドウでは、データ記号の色を(自動的に)選ぶことができ、データ点の Z 値

に依存した色が使用されます。大きな点にしてデータ点の記号の色を明確に識別するためにサイズには大

きな値を使ってください。 

軸ラベルを自動生成せずに手動で注釈を記入する場合は Automatic Axis Labels ボックスのチェックを外し
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てください。Apply to All Windows ボックスをチェックすると、現在のモードの全データプロットに修正が適用

されます。データプロットのスタイルを個々に設定したい場合は、このボックスのチェックを外してください。グ

リッド領域については Properties ボタンを使ってオプションの追加と等値線の指定を行ってください(以下を参

照)。 

 

図 8.6: データプロット・ウインドウ(STATION モード以外)の表示オプション・ダイアログ・ボックス 

Properties ダイアログでは以下のことができます； 

• 一般オプションの追加設定、 

• カラー陰影のオン/オフの切り換え、 
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• 範囲外値の自動削除のオン/オフの切り換え(計算機への負荷が大きい)、 

• 等値線の指定。 

等値線のセットを追加するには、New グループで Start, Increment, End の各値を指定してください。適切な線

のスタイルと色を選んで、Label Size の登録を設定し、<<ボタンを押してそれぞれの等値線を追加してくださ

い。必要ならば、異なる Start, Increment, End の各値と異なる線のプロパティでこの操作を繰り返してください。

ウインドウあたりの等値線の数は最大 50 本です。 

既存の等値線のプロパティを修正するには、Already Defined リストでそれを選び、New グループでプロパテ

ィを修正して<<を押してください。 

 

 

図 8.7: 表示オプションプロパティ・ダイアログ・ボックス 

 

8.10 印刷 (Printing) 
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現在の ODV グラフィクス・ウインドウの内容を印刷するには、File またはキャンバス・ポップアップ・メニューか

ら Print Canvas を選択してください。 

WIN32 

ODV が Windows 標準の印刷ダイアログを呼び出しますので、システムで利用可能なプリンターの一つ選び、

OK を押すと印刷が始まります。複雑なグラフィクス画面の印刷には、かなりの時間を必要とする傾向にありま

す。PostScript プリンターにアクセスできる場合は、代わりに PostScript オプションを使用してください。 

UNIX 

未だテストされていません。 

 

8.11 ポストスクリプト･ファイル (PostScript Files) 

全画面または個々のプロットの PostScript ファイルを作成するには、キャンバスまたはそれぞれのデータプロ

ット上で右クリックし、Save Canvas As または Save Plot As を選んで(あるいはキャンバス上かデータプロット上

にあるときは[Ctrl-S]を押して)、ファイルタイプに PostScript (*.eps)を選ぶと、ODV は PostScript Setting ダイア

ログを表示しますので、PostScript 出力の方向を指定してスケールパラメーターを設定し、出力ファイル名と

出力先を選んでください。結果として得られた PostScript ファイルは、PostScript プリンターに送ることで印刷

でき、また LaTeX, Word, PageMaker, pdf 文書に取り込むことができます。他のドキュメントに eps ファイルを取

り込む婆は Show Collection Info ボックスのチェックを外すのを忘れないでください。 

 

8.12 GIF, PNG 及び JPG ファイル (GIF, PNG and JPG Files) 

現在の ODV グラフィクス画面または個々のデータプロットを GIF, PNG, JPG ファイルに出力するには、キャン

バス・ポップアップ・メニューから Save Canvas As またはデータプロット・ポップアップ・メニューから Save Plot 

As を選択して、それぞれのファイル形式を選びます。これらのオプションはショートカットキーより呼び出すこ

ともできます：(1)マウスがキャンバス領域にあるときに[Ctrl-S]を押すと ODV グラフィクス・キャンバスが保存さ

れ、(2)マウスが地図またはデータプロット上にあるときに[Ctrl-S]を押すと各々のデータプロットが保存されま

す。ODV はファイル保存ダイアログ・ボックスを表示するので、適切な出力ファイルの形式(GIF(*.gif), 

PNG(*.png) , JPG(*.jpg))を選択してください。初期設定の出力ファイル名は現在の設定名に由来しますが、

必要ならばその他の名前や出力先を選ぶこともできます。 

 

8.13 散布図の作成 (Producing Scatter Plots) 
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SCATTER モードへ切り替えて(例えばキャンバス・ポップアップ・メニューから Use Template > …オプションを

使用)地図上でマウスの左ボタンをダブルクリックすると、現在有効な測点の全データによる成分間プロットが

描かれます(オプションとして三番目の変数を使って彩色できます)。 

参照: 拡大と自動スケーリング；新規X,Y変数の選択；表示オプションの変更；印刷；PostScriptファイル。 

 

図 8.8: 地図上の全測点のデータを示す散布図。測点の一つが記号セットにより強調されている。 

 

8.14 断面の定義 (Defining a Section) 

断面図をプロットするには、先ずファンクションキーの F11 を押すかキャンバス・ポップアップ・メニューの Use 

Template > …経由で定義済みの SECTION テンプレートの一つを選び、ODV の SECTION モードに切り換

える必要があります。新しい断面を定義するか、以前に定義した断面を使う場合には、地図上でマウスの右

ボタンをクリックし、地図ポップアップ・メニューを呼び出します。新しい断面の場合には Define Section > 

Define Section Spineを、以前に定義した断面を使う場合にはDefine Section > Load Section を選んでください。

後者の場合はファイルオープン・ダイアログから断面ファイルを(ダブルクリックして)選ぶだけです。新しい断

面を作成する場合、断面の中心線の定義を簡単にするために一時的に全画面の地図に切り替わります。マ

ウスカーソルはユーザーが断面の中心線を定義するために連続点を入力できることを示す十字記号に変わ

ります。 
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図 8.9: GEOSECS 西部大西洋断面 

十字記号を希望する位置に動かして、マウスの左ボタンを押して点を入力していきます。点を消去するには

マウスを点の近くに動かして右ボタンをクリックしてください。点の設定を適用するには ENTER を押すか最後

の点でマウスの左ボタンをダブルクリックします。上図に示されるように任意の航跡に沿った複雑な断面も構

築できます。 

断面の中心を指定した後、ODV は断面の帯域に初期設定の幅を割り当て、断面に沿った座標を初期値とし

て開始点(最初に入力した点)からの距離を選びます。断面の特性の初期設定を変更できるダイアログ・ボッ

クスが表示されます。地図ポップアップ・メニューの Define Section > Change Characteristics を選ぶといつで

も断面の特性を変更できます。断面に沿った座標を Distance(距離), Longitude(経度), Latitude(緯度)の中か

ら選び、断面の幅の設定、断面の海底地形の色の選択、断面の名称の指定を行います。断面の海底地形

については、測点の現場水深または全球水深データセット ETOPO2 の水深を使用することができます。さら

に断面の海底地形をまったく描かないことも選択できます。ETOPO2 の項目については、ETOPO2 のオプシ

ョナルパッケージをインストールしてから Bathmetry コンボボックスで利用可能になります。 

現在の断面をファイルに保存するには Define Section > Save Section As オプションを選んでください。Define 

Section > Load Section を選ぶと、保存した断面を後で使用することもできます。断面の定義を解くためには、

Define Section > Undefine Section を選びます。 

地図中でマークされた断面の幅の内部にある全測点は断面に属し、一連の操作でプロットされます。 

 

8.15 断面図のプロット (Plotting a Section) 



 

Ocean Data Viewユーザーズガイド 

 

59 

断面を定義した後に地図上にマウスがあると、左ボタンをダブルクリックするか[p]を押せば、その断面に属す

る全ての測点の断面に沿ったカラーの成分分布図と成分間プロットが描画されます。断面に沿ったカラーの

成分分布図の場合、X 軸は Section Coordinate を選択し、Y 軸と Z 軸には任意の変数を選びます。 

参照: 拡大と自動スケーリング；カラーズーミング；カラーマッピング機能の変更；新規 X,Y,Z 変数の選択；

表示オプションの変更；グリッド領域の表示；値；印刷；PostScript ファイル。 

 

 

図 8.10: WOCE A16 の断面 

 

8.16 カラーズーミング (Color-Zooming) 

カラー断面図と等値面上のカラー分布図は、カラーズーミングによってZ変数の範囲を変更できます。カラー

ズーミングを呼び出すには、変更したい断面図または等値面プロット上にマウスを動かし、右ボタンをクリック

してデータプロット・ポップアップ・メニューを呼び出します。ここで Z-Zoom を選ぶと、各ウインドウのカラーバ

ーに赤い拡大枠が描かれます。前述のように、この拡大枠を操作しドラッグしてください。現在の拡大枠の設

定とZ変数の範囲の調整を適用する場合は、マウスの左ボタンをダブルクリックするか、〔ENTER〕キーを押し

てください。拡大操作を中止して現在の変数の範囲を維持したいときは、[ESC]キーを押すかマウスの右ボタ
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ンをクリックしてください。 

 

8.17 カラーマッピング機能 (Color Mapping Function) 

カラー断面図や等値面上のカラー分布図のような Z 変数に関するどのプロットの場合でも、Z 変数の値のカ

ラーマッピングを操作できます。カラーマッピング機能を呼び出すには、それぞれのプロット・ウインドウにマウ

スを動かし、マウスの右ボタンをクリックしてデータプロット・ポップアップ・メニューを呼び出し、Color Mapping

を選んでカラーマッピングを対話的に変更します。カラーマッピングを非線形にするには、最高のカラー解像

度が得られる Z 値に Median トラックバーを動かし、Nonlinearity トラックバーを使って非線形性を増加させま

す。Auto Adjustボタンを押すとZ変数のヒストグラムから非線形の設定を行うことができ、Linear Mapping ボタ

ンを押すと線形のカラーマッピングへ戻すことができます。カラーマッピング機能に加え、別のカラーパレット

を読み込むこともできます。 

 

図 8.11: カラーマッピング・ダイアログ 

 

8.18 グリッド領域の表示 (Displaying Gridded Fields) 

サンプルの位置にカラーの点を表示する代わりに、二つのグリッド化アルゴリズム：Quick Gridding と VG 

Gridding のどちらかを使用して、Z 変数を持つ全てのウインドウにグリッド化した成分の領域を作成できます 

(例えば、断面に沿った、あるいは等値面上の成分分布図)。Quick Gridding は良好で均一なデータ・カバレ

ジでデータ点数が非常に多ければ良質な結果を素早く得られる方法ですが、粗または不均一なデータ・カ
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バレッジであれば VG Gridding の方が適しています(下記参照)。成分領域での等値線とカラー陰影の描画

は両方のグリッド化モードでサポートされています。 

Original Data Points モードからグリッド化モードの一つに切り替えるには、修正したいデータプロットにマウス

を移動させて右ボタンをクリックし、データプロット・ポップアップ・メニューを呼び出します。Display Options を

選択して Quick Gridding か VG Gridding のどちらかのボタンをチェックし、X 軸および Y 軸のそれぞれに適

切な平均の長さスケールを設定します。値は軸の全範囲の千分率(1/1000)で表され、値が大きいほど平滑

化された領域になります。Properties ボタンを押せば成分領域に対する等値線の定義や他の成分を設定でき

ます。変更を全てのプロットに適用したい場合には Apply to All Windows ボックスをチェックしてください。

ODV の出力に満足できない場合は、断面図もしくは等値面図をデータ出力して、専用のグリッド化または等

値線描画ソフトウェアを使用してください。 

 

8.18.1 VG 格子化アルゴリズム (VG Gridding Algorithm) 

等距離で矩形のグリッドに使われる Quick Gridding とは対照的に、VG Gridding は変数の解像度から、デー

タ密度にしたがって X 軸及び Y 軸のグリッド間隔が変化する矩形のグリッドを構築します。データ密度が高け

れば高解像度(狭いグリッド間隔)となりますが、サンプルが粗な領域では解像度が落ちてグリッドは粗くなりま

す。海洋観測の断面の場合、データ・カバレッジが良好な上層や境界流域では高空間解像度となり、データ

が粗な外洋域や深層では粗な解像度のグリッドになります。 
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図 8.12: 格子点(+)におけるデータ値の加重平均(赤丸)。詳細は本文を参照。 

グリッドの構築後、各格子点における成分値 ∑∑ ⋅=
i

i
i

iie dC αα は単純な加重平均スキームで計算さ

れます。効率の面から、格子点に近傍なデータ値 id だけを加えています(上図参照)。加重 iα はデータと格

子点との距離に比例して指数関数的に減少させています：
r

i e−=α  ここで ( ) ( )22 // yx LyLxr Δ+Δ= 、

yx LL ,  はそれぞれ X, Y 方向の平均の長さスケールを表わします。平均の長さスケールは領域とグリッド間

隔によって変わります。したがって、平均の長さスケールが短い領域は狭いグリッド間隔(高解像度グリッド、

例えば上層や境界流域など)に使用されるのに対し、広いグリッド間隔の領域では長い平均の長さスケール

が自動的に適用されます。空間的に可変な長さスケールのアプローチによって高密度なデータ・カバレッジ

領域で微小スケールの特性が解明され、同時に粗なデータ・カバレッジの他の領域でも滑らかで安定した領

域の値になります。Display Options ダイアログ・ボックスでユーザーが指定する長さスケール Lx0 と Ly0 は

各々の軸の範囲の千分率で測られていて、最も粗なデータ・カバレッジ(粗なグリッド)の範囲を表わしていま

す。ODV に実装された加重平均アルゴリズムは、データ点が数千個でも数秒以内に場を推定できるように速

度の面で高度に最適化されています。 

ひとたび全ての格子点で推定されれば、領域の値は画面表示またはプリンター出力のための陰影化および

等値線化ルーチンに渡されます。 

 

8.19 差分領域 (Difference Fields) 

あらかじめ保存した参照データと現在選択している測点との成分分布を比較することができ、成分の差分を

導変数として定義して別の領域を生成できます。ODV のキャンバス・メニューから Derived Variables を選ん

で(または[Alt+d]を押して(訳注：[Alt]キーを押しながら[d]を押す))、Difference from Reference を選択し、参

照データのディレクトリ・ツリーのサブディレクトリの一つにある参照データセット ExportID.txt ファイルを選ぶと、

ODV はそのディレクトリから利用可能な参照データファイルのリストを表示しますので、Z 変数として差分領域

を生成させたい変数と、適切な X, Y 変数(例えば経度と水深の断面を生成するには、参照データファイルの

X 変数が経度、Y 変数が深さであることを確認してください)を持つ.oal ファイルを選んでください。それから現

在のコレクションの Z, X, Y 変数を指定して(経度または緯度が必要ならば Difference from Reference オプシ

ョンを呼び出す前に導変数として定義してください)、差分変数の定義を完了してください。新しい変数の名

前は、Z 変数の名前と参照データセットの識別文字列(identification string)で構成されています。一度定義

すれば、どのデータプロットでも差分変数を使用できます。 

 

8.20 等値面の定義 (Defining Iso-Surfaces) 
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SURFACE モードに切り替わると(ファンクションキーの F12 を押すか定義済みの SURFACE テンプレートの

一つを選ぶ)、キャンバス・ポップアップ・メニューの Iso-Surface Variablesオプションが有効になって等値面変

数が定義できます。ODV は現在定義されている等値面の変数のリストを表示するので、既存の等値面変数

の編集と削除、新規変数の作成を行うことができます。既存の等値面変数を削除するには、変数上でマウス

の左ボタンでダブルクリックをするか、マウスの左ボタンをクリックして変数を選んでから Delete を押します。新

しい等値面変数を追加するには、まず New ボックスの中で変数を構成してから Add を押してください。等値

面変数を作成するには、ある表面に表示させたい変数(表示変数)、表面を定義する変数(等値面変数)、等

値面変数の数値を指定する必要があります。上面または底面の成分分布には、等値面変数として Depth を

選択し、数値の代わりに “top” または “bottom” と入力してください(最初の文字の “t” または “b” で十

分です)。表示変数または等値面変数に導変数を使う場合は、Iso-Surface Variable ダイアログを呼び出す前

にそれらが定義済み(導変量(Derived Quantities)参照)であることを確認してください。 

 

図 8.13: 等値面変数ダイアログ・ボックス 

Already Defined ボックスで等値面変数を選ぶと、S-Sync ボタンをクリックすると同じ等値面を使う他の全ての

変数が同期し(等値面の同期)、V-Sync ボタンをクリックすると同じ表示変数を使う他の全ての変数が同期し

ます(変数の同期)。 

明確に定義される等値面変数に加えて、時間, 年内経過日数, 経度、緯度のような追加のパラメーターが全

測点について記録されるので、成分間プロットの中でそれらを使用することができます。 

 

8.21 等値面分布のプロット (Plotting Surface Distributions) 
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等値面変数が定義されると、地図上で左のマウスボタンをダブルクリックするか[p]を押すと、等値面(経度お

よび緯度を X および Y 変数としてそれぞれ使用)または等値面上の成分間プロット(任意の等値面変数を X

または Y 変数として使用) 上で、指定したトレーサーのカラープロットを作成することができます。各深さでグ

リッド領域をプロットする場合、最も近い等深面が自動的に重ね合せ層として使用されます。オリジナルのデ

ータ点がプロットされる場合、灰色の陰影付き海底地形が背景に使用されます。 

参照:  拡大と自動スケーリング；カラーズーミング；カラーマッピング機能の変更；新規 X,Y,Z 変

数の選択；表示オプションの変更；グリッド領域の表示；値；印刷；PostScript ファイル。 

 

図 8.14: 等値面上における水温および塩分の分布 
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9 NetCDF 対応 (NetCDF Support) 

9.1 NetCDF の概要 (NetCDF Overview) 

Network Common Data Form (NetCDF) は、配列指向のデータ保管およびアクセスのためのインターフェイ

スで、気候研究やその他の地球科学の分野で広く利用されています。たくさんの重要なデータセットやモデ

ルの出力ファイルが netCDF フォーマットで配布されています。 

 

9.1.1 NetCDF とは (NetCDF data is) 

• 自己記述方式です。NetCDF ファイルは包含するデータに関する情報を保有しています。 

• アーキテクチャに依存しません。NetCDF ファイルは、整数、文字列、浮動小数点数の記憶方式が

異なるコンピュータでもアクセス可能なフォーマットで表されています。 

• ダイレクト・アクセスが可能です。最初に全てのデータを読み取らなくても、大きなデータセットの一

部分に効率よくアクセスできます。 

• 追加が容易です。データセットのコピーや、その構造を再定義しなくても、データを一次元で

netCDF データセットに追加できます。時々データセットがコピーされることになりますが、netCDF デ

ータセットの構造は変更可能です。 

• 共有性があります。同じ netCDF ファイルに対して同時に、１人のユーザーが書き込み、複数のユー

ザーが読み取ることができます。 

 

9.1.2 NetCDF の取り決め (NetCDF conventions) 

NetCDF データモデルは非常に一般的で、netCDF の構造や内容をかなり変更できます。NetCDF データセ

ットの相互交換や共有を容易に捗らせるために、様々な取り決めが定義されています。これらの取り決めのう

ち二つ(COARDS と GDT, 詳細は http://www.unidata.ucar.edu/package/netcdf/conventions.html を参照)は、

気候研究者やモデル研究者らが広く利用していて、多くの重要なデータセットが COARDS/GDT 準拠の

netCDF ファイルとして利用可能です。このようなデータセットの例は、http://www.cdc.noaa.gov/PublicData/, 

http://ferret.wrc.noaa.gov/, http://ingrid.ldeo.columbia.edu/, http://www.epic.noaa.gov/epic/ewb/からダウンロ

ードできます。NetCDF の詳細は、netCDF web ページ http://www.unidata.ucar.edu/packages/netcdf/を参照し

てください。 
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9.1.3 ODV の netCDF 対応 (ODV netCDF support) 

ODV は ODV コレクションと同様に netCDF ファイルのデータを読み込んで可視化できます。NetCDF ファイ

ルで作業するときも ODV の全機能が利用可能です。ただし netCDF ファイルへの書き込み許可が必要な場

合とデータセットを修正する場合は例外です(ODV は netCDF ファイルに書き込むことができません)。

NetCDF ファイルが COARDS/GDT の netCDF の取り決めに従っていれば、ODV は多くの変数を解釈するこ

とができます。例えば、絶対的または相対的な時間のフォーマット、欠測値の指示子のような変数の属性の

識別、長い変数名、単位、などです。ODV では、非常に大きなデータセットで作業しているときにしばしば必

要されるデータのサブ設定が可能です。 

 

9.2 NetCDF ファイルの使用 (Using netCDF Files) 

ODV は、地球科学の異なる研究者によって広く使われている netCDF ファイルのデータを読み込み可視化

できます。ユーザーによるわずかな指定や選択だけで、ネイティブの ODV コレクションをエミュレートする方

法で netCDF ファイルにアクセスし解釈します。ODV の持つ解析および可視化の全機能が netCDF ファイル

のデータ探査に利用できます。最初にデータを変換したり書き直したりする必要はありません。NetCDF ファ

イルの構造や内容によっては、別の ODV エミュレーションが可能です。個々のエミュレーションの設定は、後

の利用のためにディスクに保存することができます。NetCDF ファイルはプラットフォームに依存しないので、

同じファイルを Windows や Solaris 上の ODV で使用できます。 

(1) netCDF ファイルのオープン (Opening a netCDF file) 

ODV で netCDF ファイルを開くには File > Open netCDF File を選んでください。標準の Windows ファイル選

択ダイアログを使って、開きたいファイルを指定します。またコマンド行の引数に netCDF ファイル名を指定し

て、コマンド行から ODV を起動することもできます。Windows なら ODV デスクトップ・アイコンに netCDF ファ

イルをドラッグすることもできます。いずれの場合も netCDF ファイルの拡張子は.nc または.cdf でなければなり

ません。ODVは netCDFファイルを開いて、ファイルに含まれている次元や変数に関する情報を検索します。 

(2) netCDF エミュレーションの定義 (Defining the netCDF emulation) 

一連のステップで ODV がどのように netCDF ファイルを閲覧(またはエミュレート)するのかを定義しなければ

なりません。これには(もし必要なら)座標軸(次元)の選択、netCDF ファイルの情報と ODV ヘッダー変数との

関連付け、測点(例えばプロファイルや連続観測など)の論理構造と測点内での並び順を決める基本変数

(ODV コレクションの第一変数)の定義を含みます。 

最初に ODV は、新規にエミュレーションを定義するか、以前に定義して保存されているエミュレーションを使

うのかを尋ねます。以前に定義したエミュレーションを選ぶと追加入力の必要はなく、ODV はネイティブの
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ODV コレクションと同様に処理します：すなわち測点図を描画し、ODV の解析および可視化に関する全機

能を利用できます。ODV は開いた netCDF ファイルを読み取り専用データセットとして扱うので修正はできま

せん。したがってデータの書き込み操作が求められる全ての機能(データの読み込み、ヘッダーおよびデー

タの編集、コレクションの取り扱い操作など)は netCDF ファイルの作業では利用できません。 

(2.a) NetCDF 座標の選択 (Selecting netCDF coordinates) 

新規エミュレーションを定義する場合、最初に行う作業は netCDF の座標の選択です。ODV はファイルに含

まれている座標リストを表示します。 

 

図 9.1: NetCDF エミュレーション・ダイアログ (ステップ 1/4) 

拡張選択技術([Ctrl]または[Shift]キーを押したままマウスの左ボタンをクリックする)を使って、使用したい全

ての座標を選択してください。多次元座標が、共通の座標である X(経度)、Y(緯度)、Z(水深/高度)、T(時間)

で与えられる場合は、各方向につき一つだけ選択してください。 

ある座標を選択すると、これらの次元上で定義されている netCDF 変数のセットが Corresponding Variables リ

ストに表示されます。興味のある変数がこのリストに表示されているかどうか確認してください。Dimension リス

トで選択されなかった座標に依存する netCDF ファイルの他の変数は、Corresponding Variables として表示さ

れませんので、対応する次元を選ばない限り、それらの変数は利用できません。netCDF ファイルの完全なヘ

ッダー情報を閲覧するには(“ncdump -h”に相当)、netCDF Info を押してください。 

(2.b) ヘッダー情報の指定 (Specifying header information) 

次に、ODV 測点にヘッダー(またはメタ)情報を与える netCDF 変数を指定しなければなりません：例えば、経

度(Longitude [degrees_east])、緯度(Latitude [degrees_north])、日付(mon/day/yr)などです。これは netCDF フ

ァイルの変数(Source Variables リスト)と ODV ヘッダー変数(Target Variables リスト)を関連付けることよって行

われます。最初に ODV は自動的に変数の識別と関連付けを試みます。手動による変数の関連付けは、一

つ目のカラムに*(アスタリスク)が付いていないヘッダー変数にだけ必要となります。通常は経度(Longitude 

[degrees_east])、緯度(Latitude [degrees_north])、日付(mon/day/yr)の関連付けだけで間に合います。どの

netCDF 変数にも関連付けられないヘッダー変数には初期設定の値が使われます。ヘッダー変数の初期設

定値(例えば航海名など)を修正するには、Target Variables リストの中からそれを選んで Set Default を押して
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ください。 

NetCDF 変数と ODV ヘッダー変数との(一対一の)関連付けは、Source Variables リストの中から netCDF 変数

を、Target Variable リストの中からヘッダー変数を選んで Associate を押します。NetCDF と ODV ヘッダー変

数との間で変換が必要な場合には(通常、netCDF の時間変数に必要)、これら二つの変数を選んで Convert

を押します。コンボボックスから利用可能な変換オプションを一つ選んで OK を押してください。General 

Linear Transformation にはスケール係数とオフセットを与えます。 

 

図 9.2: netCDF エミュレーション・ダイアログ (ステップ 2/4) 

多くの netCDF ファイルでは、特定の開始日からの日数や時間といった相対的な時間を使用しますが、測点

の日付と時刻を得るためにこの情報を利用できます。そのためには Source Variables リストで相対時間を、

Target Variables で mon/day/yr を選んでから Convert を押してください。ODV は自動的に変換関数の確立を

試みますが、手動で適切な変換アルゴリズムを選択することもできます。ODV は参照する日付がグレゴリオ

暦に基づいていると仮定します。ODV の mon/day/yr 値はグレゴリオ暦の日付です。 

ヘッダー変数の Station と Type は ODV が自動的に設定します。 

(2.c) 基本座標の選択 (Selecting primary coordinate) 

コレクションの第一変数として ODV が使用する基本座標を選択する必要があります。この変数は、

station/profile/sequence 内での変数の並び替えにも使われます。ODV が測点として取り扱う論理構造を決定

するために基本座標の指定は重要です。例えば、基本座標として水深または他の鉛直座標を使用すると、

測点は鉛直プロファイルを表します；時間を使用すると、測点は時系列で表されます。日付(mon/day/yr)ヘッ

ダー変数が上述の(2.b)で定義されていれば、Use Decimal Date/Time 項目が有効になり、基本座標として測

点ヘッダーから導入される十進法の時間変数(単位は年)が使えます(時系列の場合、日付(mon/day/yr)ヘッ

ダー情報は時系列の開始の定数として参照されます)。 
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図 9.3: NetCDF エミュレーション・ダイアログ (ステップ 3/4) 

NetCDF ファイルのデータが水平面上の値(例えば、大気－海洋境界面を横切るフラックスなど)を表している

が、各々の表面を明示的に指定する netCDF 変数がない(例えば、鉛直座標や時間変数が)場合は、Use 

Dummy Variable 項目を選んでください。 

(2.d) 座標の部分設定 ( Subsetting coordinates) 

巨大な netCDF データセットで作業する場合、興味のある領域と範囲のデータにアクセスを制限すると便利で

す。これをするには座標変数のサブ設定を行うか地図を拡大します。 

 

図 9.4: netCDF エミュレーション・ダイアログ (ステップ 4/4) 

特定の座標をサブ設定するには、Corrdinates リストから対応する項目を選択し、Subset Coordinate ボタンを

押します。ODV はそれぞれの座標値のリストを示しますので、この座標に関する開始インデックス、増分、終

了インデックスを指定してください。新しいインデックスを適用するには OK を押してください。サブ設定したい

全ての次元／座標に対してこの手順を繰り返してください。 

経度と緯度が(2.b)で定義されている場合、地図を拡大すると、より視覚的にこれらの座標をサブ設定すること

ができます。そうするためには Zoom into Map ボタンを押し、赤い拡大枠を望む領域の大きさに変更するか

移動させてください。選択結果を適用するには Enter ボタンを押すか、左マウスボタンをダブルクリックしてく

ださい。ESC を押すか、右マウスボタンをクリックすると拡大操作を中止できます。 
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(3) netCDF ファイルの処理 (Exploring the netCDF file) 

(2.a)から(2.d)までのステップが完了してしまえば、ODV は測点図を描き、ネイティブの ODV データのコレク

ションを使用しているのと同様の方法で netCDF ファイルのデータを探査できます。ODV は netCDF ファイル

を読み込み専用データセットとして取り扱うのでファイルへの書き込みはできません。したがってデータを書き

込む操作が求められる全ての機能は netCDF ファイルでの作業中は利用できないことに注意してください。 

また、netCDF ファイルへのデータアクセスは、ネイティブの ODV コレクションに比べるとやや遅くなります。数

十万もの仮想測点を含む巨大な netCDF データセットを使用すると、SCATTER および／または SURFACE

の作図が遅く感じるかもしれません。そのような場合は(上述の)座標をサブ設定するか、Export > ODV 

Collection を使ってネイティブの netCDF データを ODV コレクションに出力して、この新規作成したコレクショ

ンを解析と可視化に使用してください。 

鉛直断面図を作成するには、SECTION モードに切り換えて(例えば Configuration > Use Template > 

SECTION 2 Win)、地図ポップアップ・メニューから Define Section > Define Section Spine を選択して断面を定

義してください。水平面上または他の経度／緯度の等値面上の成分分布図を描く場合は、SURFACE モー

ドに切り替えて(例えば Configuration > Use Template > SURFACE 1 Win)、Configuration > Iso-Surface 

Variables 経由で等値面変数を定義し、それをプロット・ウインドウ上の Z 変数として使用します。 

現在の設定を保存するとき、netCDF エミュレーションの設定も後の利用のためにディスクファイルに保存され

ます。 
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10 コレクションの操作 (Manipulating Collections) 

10.1 コレクション変数セットの変更 (Changing the Set of Collection Variables) 

新しいデータが、あるデータコレクションにまだ含まれていない新しい変数に対して利用可能になると、これら

の変数はいつでもコレクションに追加できます。既存の変数をコレクションから削除したり、コレクションの変数

の順序を並び替えたり、変数のラベルを変更したりもできます。コレクションの変数のセットを変更する前には

コレクションのバックアップ・コピーを作っておいてください。 

コレクションの第一変数は特別で、内部でデータを並べ替えるために使用されます。何をしたいのかを理解

した上でコレクションの第一変数を削除するか移動させてください。プロファイルデータでは、コレクションの

第一変数が深度、高度、圧力で、時系列データでは第一変数が十進法の時間変数でなければなりません。

コレクションの変数は最大 50 個です。 

コレクション変数の追加、削除、並び替えは、コレクションを開いてメインメニューから Collection > Add/Delete 

Variables を選んでください。新しい変数を追加するには、(カギ括弧[]で囲む単位も含めて)変数ラベルを

New Variable コントロール・ボックスに入力して Add を押してください。変数を削除するには Defined 

Variables リストから変数を選択して Delete を押してください。変数の並び替えは、変数を一つ選んで Up また

は Down で移動させます。実行するときは OK を押してください。変数のセットが変更されると、全てのコレク

ション・ファイルは自動的に書き換えられますので、巨大なデータコレクションであればある程度の時間を要し

ます。 

 

図 10.1: コレクション変数定義ダイアログ・ボックス 
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10.2 並べ替えと圧縮 (Sorting and Condensing) 

ODV の測点検索・選択アルゴリズムは、コレクション内の測点がある特定の方法で並べられている時に最も

効率よく機能します。したがって膨大な測点を読み込み、置き換え、結合、削除した後では、コレクションの並

べ替えと圧縮を推奨します。並べ替えと圧縮処理を呼び出すには、ODV のメインメニューから Collection > 

Sort and Condense を選んでください。 

 

10.3 選択済み測点サブセットの削除 (Deleting Selected Station-Subset) 

コレクションから現在選択されている測点を削除するには、ODV のメインメニューから Collection > Delete 

Station Subset を選んでください。現在の測点だけを削除するのであれば Collection > Delete Current Station

を選びます。コレクションのディスクファイル中の削除された測点のデータスペースは、コレクションの並べ替

えと圧縮を行うまで解放されません。 
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11 ユーティリティ (Utilities) 

11.1 データインベントリ・テーブル (Data Inventory Tables) 

ODV のメインメニューから Utilities > Inventory Table を選ぶと、現在開いているコレクションのインベントリテ

ーブルを作成できます。出力ファイルは単純なアスキーファイルで、コレクションのディレクトリに書き出されま

す(拡張子は.inv)。 

 

11.2 地衡流 (Geostrophic Flows) 

ODV の SECTION モードでは、Utilities > Geostrophic Flows オプション経由で地衡流速の計算と可視化が

できます。水深か、他の基本変数または導変数(例えば、ポテンシャル密度など)の値を選択して基準層を定

義し、結果を受け取る.o4x 出力ファイルの名前を指定してください。初期設定では、このファイルはコレクショ

ンのディレクトリの GeoVel サブディレクトリに書き出されます(このサブディレクトリがなければ自動的に作成さ

れます)。ODV は計算を始め、上述の.o4x ファイルにペアとなった測点と地衡流速を出力します。 

完了したら、新規に計算した断面のペアと流速データに関する新しい ODV セッションを呼び出すことができ

ます。Yes をクリックすると、新しい ODV セッションは GeoVel ディレクトリに新しいコレクションを作成し、書き

出されたばかりの.o4x ファイルを自動的に読み込みます。それから標準的な ODV の手順にしたがって、地

図を拡大して適切な地図領域を定義し、ファンクションキーの F11 を押して SECTION モードに切り替え、一

つ以上のプロット・ウインドウの Z変数として Geostr. Vel. [cm/s], Geostr. Vel. (north comp.) [cm/s], Geostr. Vel. 

(east comp.) [cm/s]を定義してください。ある測点ペアの測点ラベル A‐>B:alpha は、ペアに用いた測点のオリ

ジナル測点番号 A, B と、Geostr. Vel. [cm/s] が正の値を持つ流れの方角 alpha (alpha=0:東向き; alpha=90:

北向き；など)で構成されています。 

地衡流は二つの海洋観測点間における力学的高度の差から計算されます。一般的に、二つの測点の観測

深度は一致しないので、最初のステップで観測値を共通の深度に置き換えます(ODV は定義済みの標準層

へ内挿するために、区間線形の最小自乗法を使います)。それから標準層での力学的高度が両測点で計算

され、力学的高度の差から(標準層における)測点間の地衡流速が求められます。ODV はコレクションの全変

数の平均値(二点間平均)も計算します。二点間平均と地衡流速はともに、二測点間の中間点を代表してい

て、ODV はペアである二測点間の中間点における「仮想」ペア測点として、これらの値を o4x 出力ファイルに

書き出します(ペア測点の測点ラベルはオリジナル測点の測点ラベルを含んでいます)。 

赤道の近くや粗な海洋観測測点では地衡流は計算されません。結果はデータエラーに非常に敏感なため、

Utilities > Geostrophic Flows オプションを呼び出す前に、慎重に断面の水温および塩分データを品質管理

してください。処理方法の一つは、Edit Data オプションを使って疑わしいデータには Questionable や Bad の

ようなフラグを付加し、適切な測点選択基準を適用して Good と Unkown データのみ使うことです。適切な測
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点選択基準の適用によって、ある調査に関する測点だけが計算に含まれて、他の航海の測点が除外されて

いるか確認してください(断面帯を横切る他の海洋観測線には注意してください)。 

 

11.3 三次元推定 (3D Estimation) 

Utilities > 3D Estimation を選ぶと任意の地理的位置の基本変数または導変数を推定することができます。

ODV は、Z 変数の推定値を求めたい位置の経度, 緯度、深度の値を含んだアスキーファイルの入力を促し

ます。この三次元の点の定義ファイルは Utilities > 3D Estimation オプションを呼び出す前に用意する必要

があります。このファイルを作るときには一行につき一点を指定しますが、十進法の経度、緯度、深度の値を

この順で、個々の値には一個以上の空白を挿入してください。推定する変数を選んで、推定に使う x/y/z の

平均の長さスケールを指定します。深度長さスケールの単位はメートル(m)ですが、経度および緯度の長さス

ケールの単位は現在の地図範囲の千分率(‰)です。平均の長さスケールに大きな値を選ぶと滑らかな結果

が得られます。3D Estimation には現在の地図上に表示されている全測点の全オリジナルデータポイントが

使われます。あるデータ点が特定の目標点の推定に影響を及ぼす重みは、データと目標点との間の距離に

反比例します。 

 

11.4 ボックス平均 (Box Averaging) 

ODV を使用して、ある経度‐緯度‐深度のボックスに関する基本変数または導変数の平均値と標準偏差を計

算できます。平均値と標準偏差の計算には、現在地図に表示されている測点が対象で、要求されたボックス

内の測点およびデータだけが使われます。ボックス平均を呼び出す前に、適切な測点選択基準を適用する

と、年別、月別、季節別の平均を得ることができます。ボックス平均の呼び出しには、メインメニューから

Utilities > Box Averaging を選んでください。ODV は、ボックスの幾何学情報と出力される変数のインデックス

番号を含むアスキーのボックス定義ファイル(名前と拡張子は任意)の入力を促します。ボックス定義ファイル

は Box Averaging オプションを呼び出す前に用意してください。 

ボックス定義ファイルのフォーマットは以下のとおりです： 

• 単純なアスキー形式で、一行に一つのボックス／変数を定義し、

一つ以上の空白で区切られた７個の数値 

• 数値の意味：ボックスの中心の経度、緯度、深度、∆lon, ∆lat, ∆dep, 
変数番号。 

 
ボックス定義ファイルを指定すると ODV は作業を始めます。平均には範囲外のデータ値を検査し、平均±3

×標準偏差以内にあるデータだけが使用されます。出力はボックス定義ファイルと同じ名前で拡張子が.out

のファイルに書き出されます。 



 

Ocean Data Viewユーザーズガイド 

 

75 

.out 出力ファイルのフォーマットは次のとおりです： 

• 単純なアスキーファイルで、ボックス定義ファイル中の一行につき一行出力され、タブで区切られた

11 個の値 

• 値の意味：経度、緯度、深度、変数番号(ボックス定義ファイルと同様)、経度、緯度、深度、数値+－σ 

nu nr 

経度, 緯度, 深度, 数値は使用されたデータの平均経度、平均緯度、平均深度で、変数の平均値、σ は

個々の変数値の標準偏差、nu は使用されたデータポイントの数で、nr は除かれたデータポイントの数です。

各ボックス検索について全ての個々のデータ値は、ODV の一時ファイルディレクトリのアスキーファイル

ODVbox*.dat (.dat ファイル名の*はボックス番号を表わします)に出力されます。.dat ファイルの値の意味は

次の通りです：番号、経度、緯度、深度、年内経過日数、値、重み、使用/不使用フラグ。ODVbox*.dat ファイ

ルは、次のボックス平均の要求によって上書きされます。初期設定では ODV 一時ファイルディレクトリ中の

ODV*.*ファイルは、三日後に自動的に削除されます。 

 

11.5 範囲外値の検出 (Finding Outliers) 

Utilities > Find Outliers オプションを選ぶと、ユーザーが指定した範囲外のデータ値を持つサンプルを現在

選択中の測点から走査します。変数リストから走査する変数を選び、範囲の最小値と最大値を入力して、OK

を押すと走査を開始します。ODV は見つかった範囲外の値の数を知らせてきますので、範囲外の値のリスト

を見て、範囲外の値となったサンプルのデータ値や品質フラグを調べて修正を行ってください。 

Inspect and Edit Outliers をチェックすると、ODV は全ての識別された範囲外の値に対して、各々の値を削除

するか、Questionable または Bad フラグを付加するかどうか問い合わせてきます。Apply to All を押すと ODV

は選択された処理を全ての範囲外の値に適用しますが、そうでなければユーザーは個々の範囲外値に対す

る操作を求められます。現在処理中の範囲外の値にはデータプロットの中に示されます。 

 

11.6 重複測点の検出 (Finding Redundant Stations) 

Utilities > Find Redundant Stations を選ぶと、一致または殆んど一致する時間、位置を持つ測点(重複測点)

をコレクションから走査し、重複測点リストをディスクに書き出します(初期設定名は redundant.lst)。

Redundant.lst ファイルでは重複測点のセットが空白行で区切られ、各測点には次の情報が与えられます：(1)

内部順番号、(2)航海ラベル、(3)測点ラベル、(4)測点のタイプ、(5)日付、(6)経度、(7)緯度、(8)サンプル数、

(9)最深サンプル深度、(10)基本変数 2～nVar の有効率を示す指標(例えば 7 であれば、ある変数に関して

70 から 79％までのサンプルが含まれているデータであることを意味します)。重複測点を削除するには、地図

ポップアップ・メニューの Select Station by Name を使って現在の測点にしてから、Actions > Delete Current 
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Station で削除します。 
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12 グラフィックス・オブジェクト (Graphics Objects) 

ODV のグラフィクス・キャンバスにテキスト注釈、記号、線、その他の幾何学的なオブジェクトを追加できます

ので、専門的な仕上げが得られます。ODV のグラフィクス・オブジェクトには次のものがあります：(1)注釈(text 

annotations), (2)直線(straight lines), (3)四角形(rectangles and squares), (4)楕円と円(ellipses and circles), (5)

結合線(polylines), (6)塗りつぶし多角形(filled polygons) (直線のセグメントもしくはベジエ曲線), (7)記号

(symbols), (8)記号セット(symbol sets), (9)凡例(legends). これらのオブジェクトの詳細は以下の通りです。 

どの ODV グラフィクス・オブジェクトもグラフィクス・キャンバス、地図、指定したデータプロット・ウインドウに属

します。オブジェクトは、各々の親オブジェクトが描かれると同時に描かれます。グラフィクス・オブジェクトの

座標は、オーナー・ウインドウまたはグラフィクス・オブジェクトの座標のいずれかになります(背景の座標は左

下隅から距離(cm)です)。オブジェクトの初期のオーナーと座標系は、作成が呼び出されたウインドウになりま

す(以下を参照)。グラフィクス・オブジェクトのその他の殆どの属性のように、所有権と座標系はいつでも編

集・修正ができます。 

全グラフィクス・オブジェクトは現在の設定の一部であり、この設定は cfg ファイルに保存されます。 

作成 (Creation) 

自動的に作成される凡例を除いて、地図またはデータプロット・ポップアップ・メニューから Extras > Add 

Graphics Object > …(ここで...は作りたいオブジェクトの種類を表す)を選ぶか、キャンバス・ポップアップ・メニ

ューから Add Graphics Object > …を選ぶと、他のグラフィックス・オブジェクトを作成して追加できます。作成

後はオブジェクトの様々なプロパティを定義するダイアログ・ボックスが表示されます。これらのプロパティはい

つでも変更可能です(下記の編集(Edit)を参照)。グラフィクス・オブジェクトは、作成を始めたときのウインドウ 

(またはキャンバス領域)に属し、グラフィクス・オブジェクトの座標は各ウインドウの座標系に記録されます。そ

の結果、ウインドウの全オブジェクトは各ウインドウの移動やサイズ変更に自動で追従します。 

グラフィクス・オブジェクトは、グラフィクス・オブジェクトのコンテクスト・メニューの Copy Object オプション、また

はグラフィクス・オブジェクト管理ダイアログ(以下参照)の Copy ボタンを経由して、既存のオブジェクトのコピ

ーとしても作られます。断面プロットの地形ポリゴン、グリッド領域の等値線、Z 値で色付けされたデータプロッ

ト、測点図の選択されたポリゴンのような、既存のグラフィクス・オブジェクトやウインドウ・オブジェクトを出力し

て作成済みの ODV の.gov からグラフィクス・オブジェクトを取り込むことができます。 

編集･削除 (Edit and Delete) 

あるオブジェクトのプロパティを修正するには、オブジェクト(シンボルセットの場合はどれか一つの)上にマウ

ス動かして右ボタンをクリックし、ポップアップ・メニューから Edit Object を選んでください。ダイアログ・ボックス

(別のオブジェクトには別の)が現れますので、簡単かつ素早くプロパティを変更できます。どのグラフィクス・
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オブジェクトも、その親ウインドウに貼り付けることができ(clip to window ボックスをチェック)、ウインドウにデー

タが描かれる前にそれを描くようにもできます(pre-data plotボックスをチェック)。オブジェクトを削除するには、

マウスをその上に動かして右ボタンをクリックし、Delete Object を選択してください。 

ドラッグ (Dragging) 

グラフィクス・オブジェクトの属性に allow dragging が設定されていると、異なる位置にドラッグするだけでその

オブジェクトの位置を変更できます。オブジェクトをドラッグするには、そのオブジェクト上にマウスを動かし、

左ボタンを押したままマウスを動かしてください。初期設定では、データの値にリンクされたシンボルセットを

除いた他の全グラフィクス・オブジェクトについて、ドラッグが有効になっています。Allow dragging 属性は

Edit ダイアログ(上述参照)を使っていつでも変更できます。 

グラフィックス・オブジェクトの管理 (Managing Graphics Objects) 

キャンバス、地図、または他のデータプロットにおける各々の Extras > Manage Graphics Objects オプションを

使ってグラフィクス・オブジェクトを管理で、選択したオブジェクトの一項目またはグループでの編集、出力、コ

ピー、並び替え、削除が可能です。 

 

12.1 注釈 (Annotations) 

ODV のグラフィクス・ウインドウに注釈を追加するには、キャンバス, 地図、データプロット・ポップアップ・メニ

ューから(Extras > )Add Graphics Object > Annotation を選択してください。十字記号のカーソルが現れます

ので、注釈を表示したい位置に動かして、マウスの左ボタンをクリックします。個々のオブジェクトは作成を始

めたときのウインドウに所属します。注釈を追加(または編集)する場合は、注釈文の位置、方向(角度、反時

計回り)、フォントサイズ(ポイント)、色、配置パラメーターを設定してください。注釈には枠を付け加えることが

でき、注釈を描く前に注釈の枠内を塗りつぶせます。これらのすべての項目について別々の色を選べます。

注釈文の文字数は最大 255 文字です。様々なフォーマット制御文字列と自動テキスト置き換え関数が使用

できます。 

他のグラフィクス・オブジェクトと同様に、マウスカーソルを注釈の上に移動させて左ボタンを押しながら動か

すと、注釈を別の場所にドラッグできます。注釈を編集するには、マウスを注釈の上に移動させて右ボタンを

クリックし、ポップアップ・メニューから Edit Object を選んでください。注釈(全注釈)を削除するにはポップアッ

プ・メニューから Delete Object (Delete All Objects)を選んでください。 

データプロット・ウインドウの軸ラベルは(自動)注釈として実装されています。軸ラベルはプロット・ウインドウが

描かれると自動的に作成され、各データプロット・ウインドウが削除されると削除されます。軸ラベルをドラッグ、

編集し削除することはできますが、プロット・ウインドウが再描画されると自動作成時には再表示されてしまい
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ます。軸ラベルを永久に変更したい場合は、キャンバス・ポップアップ・メニューから Extras > Add Graphics 

Object > Annotation を選び、手動で注釈を作成してください。新しい注釈を定義した後で設定の保存を確認

し、印刷または PostScript ファイルに書き出す前に自動作成された軸の注釈を削除してください。 

 

12.2 線と多角形 (Lines and Polygons) 

地図、データプロット、キャンバスに直線(straight lines)、結合線(polylines)、多角形(polygons)を追加するに

は、データプロットまたはキャンバス・ポップアップ・メニューから(Extras >)Add Graphics Object > Line, …> 

Polyline, …> Polygon を選んでください。三つの場合のいずれもカーソルが十字記号に変わりますので、オ

ブジェクトの節点を指定してください。直線では始点と終点を定義しなければなりません：十字記号のカーソ

ルを直線の始点に動かしてマウスの左ボタンをクリックし、それから終点に動かして再度左ボタンをクリックし

ます。結合線や多角形では最大1000点まで定義できます。多角形はODVによって自動的に閉じられます。

節点を削除するときには、十字記号のカーソルをその近くに移動させてからマウスの右ボタンをクリックします。

多角形または結合線の点の定義を終了するには ENTER を押します。 

直線、結合線、多角形の節点を指定すした後で、ODV は(結合)線の色、幅、種類、多角形を塗り潰す色(直

線と結合線では無視されます；多角形の塗り潰しを中止する場合は none を選んでください)を設定するダイア

ログ・ボックスが現れます。１ピクセルより太い線は、多くの画面やプリンターでは実線になります。しかしなが

ら、ODV PostScript ファイルでは常に要求された線のタイプが得られます。結合線と多角形は Bezier 

smoothing ボックスをチェックすると滑らかになります。 

 

12.3 四角形と楕円 (Rectangles and Ellipses) 

地図, データプロット、キャンバスに四角形(正方形)と楕円(円)を追加するには、地図、データプロット、キャ

ンバス・ポップアップ・メニューから(Extras >)Add Graphics Object, …> Rectangle, … > Ellipse を選んでくださ

い。新しい四角形または楕円の境界を示す赤い四角形の拡大枠が現れます。この拡大枠は移動またはサイ

ズの変更が可能です。ENTER を押して設定を適用するとダイアログ・ボックスが現れますので、四角形また

は楕円のプロパティを定義してください(詳細は線と多角形(Lines and Polygons)を参照してください)。 

 

12.4 記号 (Symbols) 

記号(点、正方形、ダイヤモンド、三角形、逆三角形、星、×(バツ)、プラス)を地図、データプロット、キャンバ

スに追加するには、地図, データプロット、キャンバス・ポップアップ・メニューから(Extras >)Add Graphics 

Object > Symbol を選んでください。マウスカーソルが十字記号になりますので、記号を表示させたい場所に
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移動させてマウスの左ボタンをクリックしてください。Symbol Properties ダイアログ・ボックスが現れたら、それ

ぞれの記号のプロパティを設定してください。 

 

12.5 記号セットと凡例 (Symbol Sets and Legends) 

選択したデータ点に記号(記号セット)を割り当てて、プロット・ウインドウ中のデータの点のサブセットや地図

中の測点のサブセットを強調することができます。データ・ウインドウや地図に記号セットを作成するには、そ

のウインドウ上にマウスを動かして、Extras > Add Graphics Object > Symbol Set を選んでください。記号セット

選択ダイアログ・ボックスが現れたら、データ点のサブセットを選択します(航海ラベル、測点や個々のサンプ

ルを指定します)。選択リストに点を追加するには<<ボタンを押してください。全ての希望する点が選択されて

から OK を押すと、記号セット・プロパティ・ダイアログ・ボックスが現れますので、記号の特性を定義してくださ

い。記号セットが持つ説明文(凡例)は、それぞれのウインドウの凡例に自動的に追加されます(add to legends

ボックスをチェックしてください)。他のグラフィクス・オブジェクトとは異なり、記号セットは選択されたデータ点

に関連付けられているのでドラッグできません。記号セット上にマウスを動かして右ボタンをクリックし、Edit 

Graphics Object を選択すると、いつでも記号セットの全プロパティを変更することができます。 

データ・ウインドウまたは地図に、add to legends オプションが有効な記号セットが含まれている場合、このウイ

ンドウに現れている全ての記号セットの記号と説明文を含んだ凡例ボックスが表示されます。凡例セットは別

の場所にドラッグでき、それらのプロパティ(凡例ボックスの大きさは説明文のフォントサイズの変更に応じて

修正されます)はいつでも修正できます(マウスを凡例セットに移動させて右ボタンをクリックし、Edit Graphics 

Object を選んでください)。 

 

図 12.1: 特定の測点データを強調するために記号セットと凡例を使用した散布図の例 
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13 その他 (More … ) 

13.1 海底地形の地名辞典 (Gazetteer of Undersea Features) 

ODV では海山、海嶺、断裂帯、海溝(トラフ)、海盆といった海底地形を識別されます。地名辞典オプションを

呼び出すには、地図ポップアップ・メニューから Extras > Gazetteer を選んでください(またはマウスが地図上

にあるときに[Ctrl-g]を押してください(訳注:Ctrl キーを押しながら[x]を押す))。地名辞典ダイアログ・ボックス

が表示されますので、特定のデータベースを選択し、地名選択基準と同様に ODVが描く地名辞典記号のサ

イズと色も指定してください。 Switch On(地名辞典の設定を変更したときは Update)ボタンを押すと選択した

地名辞典データベースから情報が引き出され、地形の位置に記号が表示されます。マウスを地形記号の近

くに動かすと、地形表示ポップアップ・ウインドウが呼び出されます。地形記号を無効にするには、地名辞典

ダイアログ・ボックスを再び呼び出して Switch Off ボタンを押してください。 

いくつかの地名辞典が ODV 配布パッケージで提供されています。これらには次のもの含まれています：(1)

国際水路局(IHB)の GazetteerGEBCO.gzt, (2)米国防衛地図庁(訳注：現 米国画像地図庁；National 

Imagery and Mapping Agency)の GazetteerBGN.gzt, (3)WOCE 海洋観測プログラムの実施観測線を集めた

WHP_Sections.gzt. Gazetter ダイアログ・ボックスを使って、地形のタイプおよび／または地名の部分文字列

を指定して、地名サブセットを作ることができます。名前とタイプの選択は大文字と小文字を区別しません。

地名(またはその一部)を知っていて、その場所を識別したければ、地名辞典の地形選択を使ってください

(地形記号を見つけるために地図を全球に拡大する必要があるでしょう)。地名辞典設定は設定ファイルには

保存されません。コレクションを開く度に地名辞典オプションは無効なので、それを使うためには有効に切り

換える必要があります。 

地名辞典ファイルは編集して拡張することができ、ユーザー独自の新しい地名辞典データベースを作ること

もできます。ODV で個人の地名辞典を使うには、そのファイルの拡張子を.gzt として、ODV 地名辞典ディレク

トリ(通常は c:¥Program Files¥Ocean Data View (mp)¥include¥gazetteers)に置きます。そのフォーマットは以

下に示す仕様を満たしていなければなりません： 

• ファイルの最初の行は、“% GZT01:”で始まり、この後にファイルの名が続きます。 

• 次に%で始まる任意のコメントを含む七行が続きます。 

• その次の行は：“Feature;Type;No;East-Longitude;North-Latitude” でなければならず (訳注：タイト

ル行)、一つの空行が後に続きます。 

• ファイルの残りは実際の項目の定義が含まれています。一行につき一つの地名が記録されていま

す。 

• 地形の名前、その種類、経度／緯度の点数、経度／緯度の記載はセミコロン( ; )で区切ります。経

度は東向きに度単位(0-360)で指定されます。経度／緯度の点数は 1500 点までで、一行の長さは

200,000 文字までです。 
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13.2 ドラッグ&ドロップ (Drag-and-Drop) 

ほとんどのプラットフォームで、ODV ウインドウやアイコンに ODV がサポートするファイルをドラッグ&ドロップ

できます。ODV はドラッグされたファイルの拡張子に依存して、以下に続く動作を実行します： 

.var ：現在のコレクションまたは netCDF ファイルを閉じて、ドロップされたファイルを開きます。 

.nc または.cdt ：現在のコレクションまたは netCDF ファイルを閉じて、ドロップされた netCDF ファイルを開

きます。 

.txt (ODV スプレッドシート・ファイル), 

.o4x (ODV リストファイル), 

.csv (WOCE WHP 交換ファイル), 

.jos (Java Ocean Atlas スプレッドシート・ファイル)： 

現在開いているコレクションにドロップしたファイルからデータを読み込みます。ファイルをドロップし

たときにコレクションを開いていなければ、ドロップしたファイルと同じディレクトリに新しいコレクション

を作り、その新規コレクションにデータを読み込みます。 

全てのプラットフォームで、ODV がサポートするファイル名をコマンドラインの引数として使うこともできます。

任意のターミナル・ウインドウで “odv  [ファイル名[.拡張子] ]” と入力して ODV を起動させます。ファイル

名には絶対パス名、または ODV を起動するディレクトリからの相対パス名が使用してください。相対パス名を

使う場合は “.”と “..” は使えません。コマンドライン引数を使用して以下のことができます： 

1. ODV を起動して既存のコレクションを開く：ファイル名にはコレクション名を使用します。拡張子を省略

すると、初期設定の.var が使われます。 

2. 新しいコレクションを作成しデータを読み込む：ファイル名には読み込むデータファイル名を使用しま

す(ODV で読み込める形式でなければなりません。例えば.o4x, .txt, .csv, .jos)。この場合は必ず拡張

子を付けてください。ODV は読み込みファイルのディレクトリに新しいコレクションを作成し、ファイルか

らデータを読み込みます。コレクション変数はデータファイル中の情報で決められます。 

 

13.3 ODV コマンドファイル (バッチモード) (ODV Command Files (Batch Mode)) 

コレクションのオープン、指定した設定ファイルの読み込み、グラフィクスやデータ出力ファイルの作成といっ

た、頻繁に使用する操作コマンドを ODV コマンドファイルに保存できます。ODV コマンドファイルは File > 

Execute Command File オプション、または “-x cmd_file” コマンドライン・オプションを使っていつでも実行で

きます。ODV コマンドファイルの初期設定の拡張子は.cmd です。初期設定でのファイルの場所はユーザー

のホームディレクトリの odv_local/cmd_files ディレクトリです。このディレクトリが存在していなければ cmd_files
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ディレクトリを作成して、このディレクトリにコマンドファイル置いてください。 

以下のコマンドが ODV コマンドファイルで現在サポートされています： 

set_base_directory base directory 

ベースディレクトリの設定。以降の全ファイル名は絶対パス名か、ベースディレクトリからの相対パス名で

なければなりません。 

Example:  set_base_directory c:/ewoce/data 

open_collection collection 

コレクション collection を開く 

Example:  open_collection c:/ewoce/WoceBtl.var 

open_netcdf  netCDF file, nce file 

nce file ファイルからエミュレーションを使って netCDF ファイルを開く 

Example:  open_netcdf c:/netcdf/wind.nc, c:/nce_files/abc.nce 

load_cfg  cfg file 

設定ファイル cfg file を読み込む 

Example:  load_cfg c:/cfg_files/abc.cfg 

set_annotation_style ptSize, textColor, bckgrdColor, frameColor, frameWidth 

create_annotation で作成した注釈文のスタイルを設定します。ptSize はフォントサイズをポイントで、

textColor は文字の色を、bckgrdColor は文字ボックスの背景色を、frameColor は文字ボックスの枠の色

を、frameWidth は文字ボックスを囲む枠の幅を設定します。全ての色は現在のカラーパレットの中から

インデックス値で指定します。bckgrdColor と frameColor に-1 を指定すると、背景ボックスや枠を描きま

せん。全ての set_annotation_style の引数は整数です。既定値は 16, 0, -1, -1, 0 で、背景ボックスと枠の

ない 16 ポイントの黒色の文字を作成します。 

Example:  set_annotation_style 24, 8, 7, 0, 1 

create_annotation iw, x, y, orientation, textAlign, “text” 

注釈文 text を、ウインドウ iw の正の x 軸から反時計回りに角度 orientation の方向に、(ウインドウ iw の

座標系での)x, y の位置に作成します。textAlign は x, y における相対的なテキストの位置を定義します：

中央= 0, 中央上=1, 中央下=2, 右上=3, 右下=4, 左上=5, 左下=6, 右中央=7, 左中央= 8. iw と

textAlign は整数で、x, y, orientation は実数です。注釈文は“ ”で括ってください。 

Example:  create_annotation -1, 10., 8., 30., 0, “Some Text” 
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export_data  data file 

汎用 ODV スプレッドシート・フォーマットのファイル data file に現在の測点のデータを書き出します。 

Example:  export_data c:/output/odv_data.txt 

export_graphics iw, graphics file, dpi 

解像度 dpi (dots-per-inch)で graphics file にウインドウ iw のグラフィクスを保存します。graphics file の拡

張子.eps, .png, .jpg はそれぞれ PostScript, PNG, JPEG を指します。引数 dpi は PostScript では使用さ

れませんが、それでも dpi 値は与えてください。 

Example:  export_graphics –1, c:/output/odv_graph.eps, 300 

quit 

ODV の終了。 

Example:  quit 

上述の全てのファイル名には、プラットフォームに関係なくディレクトリを区分する文字に/ (スラッシュ)を使用

してください。set_base_directory でベースディレクトリが設定されると、以降の全ての相対ファイル名はベース

ディレクトリに対する相対的位置にあるとみなされます。ベースディレクトリが設定されていない状態でコレク

ションや netCDF ファイルを開く場合の相対ファイル名は、コレクションや netCDF のディレクトリに対する相対

位置とみなされます。複数の引数は, (カンマ)で区切られていなければなりません。ウインドウのインデックス

パラメーターiw は次の値です：-1(グラフィックス・キャンバス), 0(地図), 正数(データプロット iw)。ODV コマン

ドファイルの各行は 255 文字を超えないようにしてください。最初の文字が#の行はコメント行として扱われ実

行されません。 

 

13.4 パッチの使用 (Using Patches) 

現在画面に表示されている任意のデータプロットの X/Y 空間に多角形を指定して、水塊のパッチを定義する

ことができます。そのためには、定義したいデータプロット(例えばポテンシャル水温─塩分プロット)にマウス

を動かして右ボタンをクリックしてください。ポップアップ・メニューから Define Patch を選択して(カーソルが十

字記号に変わります)、パッチを当てる多角形の節点の位置をマウスの左ボタンをクリックして定義してくださ

い(節点を削除するにはその近くにマウスを動かして右ボタンをクリックしてください)。多角形の定義を終了す

るには Enter を押すか、マウスの左ボタンをダブルクリックします。多角形は ODV が自動的に閉じます。それ

から ODV はパッチの名前(拡張子なし)の入力を促して、コレクションのディレクトリ内のファイルにパッチの定

義を書き出します。 

コレクションに一つ以上の水塊のパッチを定義した後は、導変数 Patches を作り作動させてその定義を使うこ

とができます。キャンバス・ポップアップ・メニューから Derived Variables を選択し、Choices リストから Patches
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を選んでください。(上述にしたがって定義済みの)利用可能な水塊パッチを一つ以上選んでパッチ変数を

作ることができます。OK を押すと実行されます。あるサンプルのパッチ変数を評価するために、ODV はサン

プルがパッチの多角形の一つの内部にあるかどうかを調べ、(もし見つかれば)パッチの値としてそれぞれの

パッチの番号を割り当てます。サンプルが、選ばれた全てのパッチの外側にあれば、その値は欠測値として

セットされます。 

他の全ての(基本または導)変数と同様に、どのデータプロットのどの軸に対しても Patches 変数を使うことがで

きます。例えば、固有水塊の空間的な広がりを表示するための断面に沿った Z 変数または等値面変数として

使えます(下図参照)。 

 

図 13.1: 水塊の広がりを識別するためにパッチを使用 

 

13.5 二次元推定 (2D Estimation) 

VG グリッド化表示オプションを使ったデータプロットで、各々のデータプロット・ポップアップ・メニューから

Extras > 2D Estimation オプションを選ぶと、ユーザーが指定した任意の X-Y 点における Z 変数を推定する

ことができます。ODV は、推定したい点の X-Y 座標ファイルのファイル(以降では入力ファイルと呼ぶ)の入力

を促します。このファイルは 2D Estimation オプションを呼び出す前に用意してください。このファイルは一行

につき一組の X-Y ペアを持った単純なアスキーファイルで、X と Y の値は一つ以上の空白で区切られてい



 

Ocean Data Viewユーザーズガイド 

 

86 

なければなりません。点の数は無制限です。入力ファイルの各点に対して ODV は Z 値を推定し、入力ファイ

ルと同じディレクトリの出力ファイルに各々の X, Y 座標とともに推定値を出力します。出力ファイルの名前と

場所はユーザーが指定できますが、初期設定では入力ファイルに拡張子.est が付加された名前になります。

品質指標値が 0 なら推定は良好で、8 なら不良であることを示しています。Z 値が-1.e10 であれば X/Y 点が

現在の領域外にあることを示しています。 

 

13.6 データ編集 (Editing Data) 

現在の測点のデータ値と同様に測点ヘッダー情報を編集することができ、ディスク上のコレクション・データフ

ァイルに修正値を保存できます。 

ヘッダー情報 (Header information) 

現在の測点のヘッダー情報を修正するには、ODV テキストウインドウにマウスを動かして右ボタンをクリックし、

Edit Header を選んでください。現れたダイアログ・ボックス内での変更は OK を押すとコレクション・ファイルに

保存されます。修正を破棄してコレクション・ファイルを変更しない場合は Cancel を押してください。 

 

図 13.2: 測点ヘッダー・ダイアログ・ボックス 

測点データ (Station data) 

ある変数の測点データを修正するには、ODV テキストウインドウのそれぞれの変数上にマウスを移動させ、

右ボタンをクリックして Edit Data を選んでください(マウスがそれぞれの変数上にあるときに単に e キーを押し

てもできます)。現れたダイアログ・ボックスで、現在のサンプル(初期選択)もしくはユーザーが定義したサンプ

ルのサブセットのデータ値および品質フラグを変更できます。データリスト中のサンプルのサブセットも定義で

き、それにはマウスの左ボタンをクリックするときに標準の拡張選択キーである Ctrl と Shift キーを押します。

プロファイル全体を選択するときには任意のサンプルをクリックして Ctrl-Aを押します(訳注: Ctrlキーを押しな

がら a を押す)。 
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図 13.3: データ編集ダイアログ・ボックス 

単独のデータ項目を選択している場合、Change Value をクリックして新しい数値を入力することで、データ項

目の値を変更することができます。データリスト中で一つ以上のサンプルを選択している場合は Change 

Value ボタンは作動しません。Delete Value(s)を押すと、選択された全サンプルのデータ値が削除されます。

オリジナルのデータ値が永久に失われてしまうので、このボタンの使用には最大限の注意を払ってください。

実際のデータ値は変更せずに、選んだサンプルのデータ品質フラグを変更することを強く推奨します。それ

には Change Quality Flag(s)をクリックして利用可能なフラグのリストから新しい品質フラグを選択します。OK

を押すとディスクに変更が保存され、Cancel を押すと編集作業を中止して測点データを元の形式のまま残し

ます。 

品質フラグを使用してデータを選択することができます(詳細はサンプル選択基準の節を参照してください)。

編集操作はコレクションの log ファイルに記録されます。log ファイルは Utilities > View log File オプションを

使って見ることができます。 

 

13.7 カラーパレットの変更 (Changing the Color Palette) 

データプロット・ポップアップ・メニューの Display Options を使って、Pallete コンボボックスにある利用可能な

パレットファイルの一つを選び、ODV が散布図、 断面図、等値面図で使うカラーパレットを変更できます。

ODV は新しいパレットを使ってデータ・ウインドウを再描画します。High または true カラーシステムではデー

タ・ウインドウ毎に異なるパレットを使用できますが、256 色システムでは全てのデータ・ウインドウに(最後に選

択されたものと)同じパレットが使用されます。 

Windows 上では、ODV バイナリ・ディレクトリ(通常は c:¥Program Files¥Ocean Data View (mp)¥bin_32)にある

PalEdt.exe プログラムを用いて、新規カラーパレットの作成または既存パレットの変更ができます。PalEdt.exe

は Utilities > Invoke Palette Editor を選ぶと呼び出せます。 

ODV スタイルのカラーパレットでは 177 色が定義されています： 

 0-15: 基本色(ODV STATION モードで使用); 8 番目の色は断面図の地形で使用; 
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 16-31: グレースケール; 31 番目の色は ODV プロット・ウインドウの背景色として使用; 

 32-144: カラー陰影に使用されるメイン・パレット; 

 145-160: 地図の海底地形と大陸に使用される色; 

 161-176: 地図の陸上地形に使用される色; 

 

13.8 一般的な設定 (General Settings) 

ODV が使うグラフィクスやテキストフォントといった一般的な ODV の設定、あるいは “有効範囲の基準 

(good coverage criteria)” は、メインメニューの Configuration > General Settings オプションを使ってカスタマ

イズできます。 

フォント (Font): 

一つの、あるいは様々なフォントのプロパティを選択し、グローバル・フォント・スケーリング係数 f を設定しま

す。グラフィクスのテキストや座標軸の注釈を大きくしたければ f の値を増加させ、小さくしたければ減少させ

てください。通常と異なるフォントはODVのPostScript出力に対応していないかもしれません。Text Window > 

Font Size は ODV のテキストウインドウ、ダイアログ・ボックス、ポップアップ・ウインドウで使うフォントサイズを決

定します。 

キャンバス (Canvas): 

ODV グラフィクス・キャンバス、例えば地図やデータプロットが描かれる白い領域の幅と高さを調整します。最

大化された ODV ウインドウに、現在のキャンバスの下または右にグレー領域があれば、グラフィクス・キャンバ

スを広げ、キャンバスの X 軸や Y 軸にスクロールバーがあれば、グラフィクス・キャンバスを縮めてください。

サイズの変更を有効にするには ODV を終了して再起動しなければなりません。 

印刷 (Print): 

Show Collection Info ボックスをチェックすると、ODV のタイム・スタンプとコレクション／設定情報がプリントア

ウトされます。 

有効範囲の基準 (Good Coverage Criteria): 

例えば標準層への内挿や様々な導変数の計算といった一部の ODV の操作では、「十分な」入力データを

必要とします。例えば力学的高度は水温と塩分が必要なので、各プロファイルで大きな穴が開いていてはい

けません。Good Coverage Criteria ダイアログ・ボックスを使って検査基準の設定と修正ができます。これらの

基準は特定の操作で必須のあらゆる変数に適用されます。一つ以上の必須の変数が検査に失敗すると

各々の作業は実行されません。 

# Obs 各測点における必須観測数； 

Fraction > ある変数に関してデータが含まれていなければならないサンプルの割合； 

delta_Z.. データ点間における深さ方向の許容できる相違の指定。 
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プログラムの位置 (Program Locations): 

Web ブラウザ(ODV ヘルプで必要)とテキスト・ビューア(テキストファイルの閲覧に必要)の完全なパス名を入

力してください。 

 

13.9 データ統計 (Data Statistics) 

任意のプロット・ウインドウや地図に示されるデータの統計情報を得るには、それぞれのプロットのデータプロ

ット・ポップアップ・メニュー、あるいは地図ポップアップ・メニューの Extras > Statistics オプションを使用します。

ウインドウ統計ダイアログ・ボックス(以下を参照)が現われて、各々のウインドウの X, Y, (もしあれば) Z 変数の

平均と標準偏差、最小値と最大値を示します。最小と最大がすべての利用可能なデータに基づいているの

に対し、平均と標準偏差は現在目で見えるデータだけを使用して計算していることに注意してください。 

ODV は自動的に X と Y のデータの線形回帰計算を行い、得られた最小自乗法による回帰直線のパラメータ

ーを表示します。さらに、回帰係数、回帰直線からの Y データの自乗平均差、回帰計算に使用されたデータ

点数が示されます。現在表示されているデータ点だけが回帰計算に使用されることに注意してください。

Show Fit を押すとデータプロットに最小自乗法による回帰直線を表示させることができます。回帰直線はグラ

フィックス・オブジェクトとして描かれますので、直線のスタイルは修正でき、必要がなくなれば削除できます。 

 

図 13.4: 統計ダイアログ・ボックス 

各々の Histgramボタンを押すと X, Y, (もしあれば) Z データの度数分布図が得られます。度数分布図の例を

下に示します。度数分布図は現在目で見えるデータだけに基づいていることに注意してください(下図参

照)。 
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図 13.5: データ頻度分布図の例 

X/Y 空間におけるデータ分布図を作成するには X/Y Distribution ボタンを押してください(下図参照：図は

WOCE Upper Ocean Thermal programme の XBT 水温プロファイル数を示しています；データは

http://www.ewoce.org から得られます)。 

 

図 13.6: データ分布図の例 
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13.10 時系列データ分布図 (Temporal Data Distribution Plots) 

地図ポップアップ・メニューの Utilities > Temporal Distribution を選ぶと、現在選択されている測点の(月と年

の)時系列分布図を描くことができます(下図参照)。 

 

図 13.7: Reid and Mantyla データコレクションの時系列分布図 

 

13.11 アニメーション (Animations) 

ODV で地図あるいは任意のデータプロット・ウインドウのアニメーション GIF ファイルを作成することができま

す。アニメーションを作成するには各々のウインドウで右クリックして、Extras > Animation > Header Time, 

Extras > Animation > Validate Variable, Extras > Animation > Isosurface の中から一つを選んで、次の指示

に従ってください。 

(1) Extras>Animation>Header Time: 

開始日 t0, 間隔ステップ dt (日数), 作成するフレーム数 n、間隔タイプを指定してください。ODV は n 時間間

隔で構築し、Date/Time 選択基準で各々の開始日と終了日を使用します。 

選択された間隔タイプにより、間隔 i (i=0, ... , n-1)の開始日と終了日を以下のように定義されます： 
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間隔のタイプ(Interval Type) 間隔 ｉ の開始日(Start of interval i ) 間隔 ｉ の終了日(End of interval i ) 

Zero Width (幅なし) t0 + i･dt t0 + i･dt 

Fixed Width (固定幅) t0 + i･dt t0 + ( i+1)･dt 

Fixed Start (開始日固定) t0  t0 + ( i+1)･dt 

Fixed End (終了日固定) t0 + i･dt t0 + n･dt 

個々のそのような時間間隔で、各々の時間ウインドウからそれらの測点だけを含む地図を再構築します。デ

ータプロット・アニメーションが必要な場合は、現在の測点のセットだけのデータを使用してデータプロットを

再構築します。それからアニメーション・ファイルに現在の地図もしくはデータプロットのスナップショットが追

加されます。 

(2) Extras>Animation>Validate Variable: 

このオプションはデータプロット・ウインドウだけに有効です。有効変数(validate variable)を選択して、開始値

v0, 間隔ステップ dv, 作成するフレーム数 n、間隔タイプを指定してください。ODV は有効変数に関して n 間

隔で構築し、有効変数選択基準に関して各々の開始および終了の値を使用します。 

選択された間隔タイプにより、間隔 i (i=0, … , n-1)の開始と終了の値は以下のように定義されます： 

間隔のタイプ(Interval Type) 間隔 ｉ の開始(Start of interval i) 間隔 ｉ の終了(End of interval i) 

Zero Width (幅なし) v0 + i･dv v0 + i･dv 

Fixed Width (固定幅) v0 + i･dv v0 +  ( i+1)･dv 

Fixed Start (開始日固定) v0  v0 + ( i+1)･dv 

Fixed End (終了日固定) v0 + i･dv v0 + n･dv 

個々のそのような間隔で、各々の有効変数の間隔からそれらのデータだけを含むデータプロットを再構築し

ます。それから現在のデータプロットのスナップショットがアニメーション・ファイルに追加されます。 

(3) Extras>Animation>Isosurface: 

このオプションは等値面データプロット・ウインドウだけに有効です。開始値 s0, 間隔ステップ ds、作成するフ

レームの数 n を選んでください。ODV は n 個の等値面値を構築し、各値のデータプロットを再構築します。そ

れから現在のデータプロットのスナップショットがアニメーション・ファイルに追加されます。 

すべてのアニメーションについて、ODV は、現在のアニメーション間隔を示すアニメーション・バーを描きま

す。アニメーション・バーはそれぞれのウインドウ下の中央に置かれます。 
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14 ヒントとコツ (Tips and Tricks) 

14.1 ODV によるデータ品質管理 (Data Quality Control with ODV) 

ODV は複数のパラメーターを持つデータセットの品質管理を容易にします。ODV は格納されている任意の

変数に対して自動的な変数レンジチェックを可能にし、範囲外値の識別や編集を容易にする多様な対話的

かつ視覚的な方法を提供します。SCATTER および SECTION モードでは、地図に示された全ての測点

(SCATTER モード)の、または現在の断面幅の内側にある全ての測点(SECTION モード)の全データを含む

成分間プロットで、範囲外値や疑わしいデータを簡単に識別できます。いずれの場合も、プロット・ウインドウ

の一つで各々の点を単にクリックして希望する変数の Edit Data オプションを呼び出して、疑わしいサンプル

値の編集や関連した品質フラグの設定が可能です。データコレクションに施した全ての変更はコレクション

の.log ファイルに記録されます。ログ記録は、変更されたサンプルの情報、修正日時、修正を行ったユーザ

ー、操作が行われたコンピュータ名を含んでいます。Utilities > View log File オプションを使用して、コレクシ

ョンの.log ファイルをいつでも見ることができます。 

下の例では、全航海のデータプロットの表示から塩分と酸素の範囲外値を簡単に見つけ出すことができます。

そのような範囲外の値の点をクリックして現在のサンプルとして選択すると、編集および／またはフラグの付

加ができるようになります。 

 

図 14.1: 北大西洋における横断面における範囲外値の識別 

 

14.2 XYZ アスキーファイルのデータ可視化 (Visualizing Data from XYZ 

ASCII Files) 

ある X-Y 座標におけるいくつかの変量 Z の不規則な間隔またはグリッドのデータは、X, Y, Z 値の三項目を

持つファイルで一般的に提供されています。そのような XYZ データセットの例には、(1)ある Z 値の地図(X が

経度、Y が緯度)、(2)鉛直断面(X が断面に沿った座標系で、Y が水深)、(3)時間発展図(X が地理座標で、
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Y が時間、またはそれらの逆)があります。 

これらの全ての XYZ ファイルを ODV に読み込んで、ODV の全機能を使用して Z データの解析および表示

できます。以下に述べる手順は、複数の Z 変数、例えば三つより多い項目を持つデータファイルにも適用で

きます。 

ここでは XYZ ファイルを地図に描く場合の処理方法を示します： 

1. 水深(Depth [m])と Z 変数(Z 変数を説明するラベルと適切な単位を使用)の二つの変数を持つ新規

コレクションの作成を行います(出力先のディレクトリおよびコレクション名を選びます)。 

2. Import > ODV Spreadsheet から XYZ ファイルを選んで読み込みます(XYZ ファイルの拡張子が.txt

以外の場合は、ファイルタイプに All Files を選んでください)。 

3. Spreadsheet File Properties ダイアログで、(1)カラムの分離文字(ヘッダー行の項目は Column Labels

リスト内の別の行に現れます), (2)XYZ ラベルを含む行番号(ラベルがない場合は 1 になります), (3) 

最初のデータ行の行番号を指定します。 

4. Header Variable Association ダイアログで、X 変数に経度[degrees_east]を、Y 変数に緯度

[degrees_north]を関連付けます。 

5. Import Option ダイアログで、Z 変数(source)と二番目のコレクション変数(target)を関連付けます。そ

れから第一コレクション変数(target)をクリックし、Use Default をクリックして初期設定の水深値を指定

します(確かでないときには 0 を使用)。 

ODV は XYZ ファイルからデータを読み込み、通常の方法でのデータ操作を可能にします。Z 変数の地図を

一ページで作成するには、Configuration > Use Template > SURFACE 1 Win を選んでください。必要ならば、

いつものように表示オプションを修正してください。 

 

14.3 成分分布と他の成分の等値線との重ね合わせ (Overlaying a 

Property Distribution with Contour Lines of another Property) 

ODV で(カラー陰影および／または等値線による)一成分の分布図に、別の成分の等値線を重ね合わせた

断面図または等値面図を作成することができます。このテクニックが役立つのは、例えば、任意の成分断面

上の等密度線や、等値面または等密度面上の等深線です。 
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図 14.2: カラー陰影によるリン酸分布図上に酸素の等値線の重ね合わせ 

 

このようなプロットを作成するには、以下の手順に従ってください： 

• SECTION または SURFACE モードで、キャンバス・ポップアップ・メニューから Windows Layout を選

んで Windows Layout モードに切り替えます。 

• 下になる分布図のウインドウを設定します(ウインドウ a：サイズと位置を定義；そのウインドウの Z 変数

を選択(成分 A))。 

• ウインドウ a 上にマウスを動かして右ボタンをクリックし、Create Overlay Window を選んで、ウインドウ

a の上に重ね合わせるウインドウを作成します。ここで重ね合わせるウインドウ b の Z 変数(成分 B)

を選んでください。Window Layout コンテクスト・メニューから Accept を選んで Window Layout モード

から抜けてください。 

• ODV がデータプロットを再描画した後に、マウスをウインドウ b に動かし、マウスの右ボタンをクリック

して Display Options を選びます。VG Gridding ボタンがチェックされていることを確認して、背景色

に none を選びます(おそらく自動でセットされています)。それから Properties ボタンをクリックしてくだ

さい。Do Color Shading 項目のチェックをはずして等値線の定義に進んでください。成分 A のカラー

分布上でもはっきり見えるような等値線の色(例えば白黒)を使用してください。OK を押すと表示オ

プション設定が確定します。 

• ODV はデータ・ウインドウ a と b を再描画し、成分 B の等値線は A の分布上に現れます。印刷また

は PostScript, PNG, JPEG へ出力する前に、各々の注釈をドラッグして成分 A と B のラベルを分けて

ください(ラベル上にマウスを動かし、マウス左ボタンを押しながら移動させます；この分離は再描画

後に繰り返す必要があります)。または軸ラベルの自動生成を無効にして(Display Options ダイアロ

グで Automatic Axis Labels ボックスのチェックをはずして)、注釈の追加で軸ラベルを作成してくださ

い。 
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• 満足する結果が得られたら、後の利用のために設定を保存してください(Configuration > Save 

Configuration As)。 

別のウインドウが完全に重なる(ウインドウ aのような)ウインドウにアクセスして、そのプロパティを修正する唯一

の方法は、メインメニューから Configuration > Window Properties オプションを選ぶことだけです。 

 

14.4 コレクションの中立密度の事前計算と保存 (Pre-computing and 

Storing Neutral Density Values in Collections) 

ポテンシャル水温、ポテンシャル密度、Brunt-Väisälä Frequency(ブラント─バイサラ周波数)など、簡単に素早

くその場(on-the-fly)で計算できる大部分の導変数に比べて、中立密度の計算はコンピュータの負荷が高く、

多くの時間が費やされます。これが小さいデータコレクションや少数の測点をプロットするだけなら問題はあり

ませんが、大きなコレクションの長い断面に沿った中立密度をその場で計算する場合は、遅くて能率が上が

りません。もし定期的に大きなデータセットで作業して中立密度が必要になるなら、予め中立密度を計算して

ディスクのコレクション・ファイルにその結果を保存しておき、後でディスクから計算済みの値を使うことを検討

すべきでしょう。保存された中立密度の値は、コレクションの中で対応する水深、水温、塩分の値が変更され

る毎に(例えばデータの編集や較正の後に)再計算する必要があります。自己責任において以下に示す中立

密度の事前計算を繰り返してください。 

ここでは、既存のデータコレクションの全てまたは一部の測点について、事前に計算した中立密度を持つ新

しいコレクションの作成方法を示します。 

1. 既存のコレクションを開いて、事前に計算する中立密度を持つ新しいコレクションに含める測点を選

びます。コレクションの全てを処理したい場合は、全球地図にして選択した測点数がコレクション中

の測点数と一致するか確認してください(例えば、ODV テキストウインドウの一行目の初めから二つ

の数は一致しているはずです)。 

2. キャンバス・ポップアップ・メニューの Derived Variables オプションを使って、導変量として Neutral 

Density を定義してください。 

3. Export > ODV Spreadsheet を選んで、ODV スプレッドシート・ファイルに中立密度を含む測点データ

を出力してください。新しいデータセットの名前(以降では xxx.txt と表記)を指定して、Select 

Variables for Output リスト内で Neutral Density の出力が選ばれているか確認してください。欠測値

は空白にしておくことができます。 

4. xxx.txt ファイルを使って新しいコレクションを作成するには、ODV デスクトップ・アイコンにこのファイ

ルを単純にドラッグ・アンド・ドロップするか(Windows といくつかの他のプラットフォーム)、ターミナ

ル・ウインドウから “odvmp xxx.txt” と入力して ODV を起動させます(Unix, Linux, Mac OS X)。新

たに作成されたコレクション xxx は、ディスクファイルに保存される基本変数の一つとして Neutral 
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Density を持ちます。 

14.5 刊行物と Web ページにおける ODV グラフィックスの使用 (Using 

ODV Graphics in Publications and Web Pages) 

ODV の全キャンバスや個々のデータプロットなどの ODV グラフィクス・ファイルは簡単に印刷文書、ポスター、

Web ページに含めることができます。 

全 ODV グラフィックス・キャンバスまたは個々のデータプロットの GIF, PNG, JPG ファイルを作成するには、マ

ウスがキャンバスまたは各々のウインドウにあるとき[Ctrl-s](訳注:[Ctrl]キーを押しながら[s])を押し、出力形式

として GIF, PNG, JPG のいずれかを選択してください。グラフィクス・ファイルを希望の解像度に設定して(初

期設定は画面の解像度)、GIF, PNG, JPG グラフィクス・ファイルを Web ページや文書で使用してください。印

刷用文書には、高解像度の GIF か PNG ファイルを作成するか、代わりに ODV PostScript (.eps)出力を使用

してください。 

様々なタイプセットやページデザインのソフトウェアは、文章や図が混在するページへの Encapsulated 

PostScript ファイル(.eps；訳注：カプセル化されたポストスクリプト・ファイル)の挿入をサポートしています(例え

ば MS Word やその互換ソフト、LaTeX, Adobe PageMaker など)。LaTeX を使う場合、TeX 文書に PostScript

グラフィクスを取り込む方法の実例として Pssample.tex ファイル(通常は c:¥Program Files¥Ocean Data View 

(mp)¥Samples にあります) を参照してください。必要な epsf および epsfig スタイルファイルもサンプル・ディレ

クトリに含まれています。 

Word や PageMaker、その他の出版ソフトウェアを使用する場合は、次のガイドラインにしたがってください：い

つも通りにページを作成して、正しい位置にそれぞれの ODV PostScript ファイルを挿入してください。図のサ

イズは適切に調整されます。ページの作成が終了すると、文書は PostScript プリンターで直接印刷することが

できます。PostScript プリンターが利用できない場合は、PostScript プリンター・ドライバーと

GhostScript/GhostView パッケージ(http://www.cs.wisc.edu/~ghost/aladdin/index.html)をコンピュータにインス

トールする必要があります。その場合は、PostScript プリンター・ドライバーをプリンターとして選んで、ファイル

に出力してください。このファイル GhostView でを開き、システムに接続しているプリンターで印刷してくださ

い。 

 

14.6 航跡図の作成 (Making Cruise Maps) 

ODV の MAP モードを使って、あるデータコレクションの高品質な測点図を作成できます(全測点もしくは一

部の測点)。実際の測点データや測点のメタデータ(例えば測点の位置など)にアクセスすることなく測点図を

作成できます。ここではその作成方法を述べます： 

• ディスクの空のディレクトリに、航跡の地理情報を含むアスキーファイルを作成します。このファイル
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は記述的な名前で(例えば、CruiseTrack_xxx.txt, ここで xxx は航海名を表します)、汎用 ODV ス

プレッドシート・フォーマットの仕様を満たしていなければなりません。 

ファイルの一行目には次のヘッダー行を使ってください(カラムはタブ区切りです)： 

Cruise Station Type mon/day/yr hh:mm Longitude [degrees_east] Latitude 

[degrees_north] Bot. Depth [m] Dummy1 Dummy2 

ヘッダー行の直後に、各測点または航跡の節点を一つのデータ行を追加し、各々の測点または節点に関す

る以下の情報を与えます： 

Cruise 航海名 

Station 測点ラベルまたは番号 

Type “B” 

mon/day/yr 測点または現在の日付 

hh:mm 測点の時刻または “00:00” 

Lon (°E) 十進法での測点の経度 

Lat (°N) 十進法での測点の緯度 

Bot. Depth [m] 測点の水深または “0” 

Dummy1 “0” 

Dummy2 “0” 

• Windows システムでは、用意した航跡ファイルを ODV デスクトップ・アイコンにドラッグ・アンド・ドロ

ップしてください；他の全てのプラットフォームではターミナル・ウインドウを開いて、航跡ファイルの

あるディレクトリに移動し、コマンドラインの引数で航跡ファイル名を指定してターミナル・ウインドウ

から ODV を起動してください(例えば “odvmp CruiseTrack_xxx.txt”)。 

• ODV で MAP モードに切り替えて、興味のある領域を定義するために地図を拡大してください。地

図の Display Options を使って、測点の点のサイズと色を指定し、注釈のスタイルを定義します。特

定の測点を強調し注釈を付けるには、ダブルクリックするか、地図ポップアップ・メニューからExtras 

>  Add Graphics Objects > Symbol Sets を選んでください。 

• 必要に応じて航跡ファイルの最後に新しい測点を追加して、ODV(mp)デスクトップ・アイコンに更

新した航跡ファイルをドラッグ・アンド・ドロップするか(Windows)、あるいはコマンドラインの引数で

航跡ファイル名を指定して ODV を起動してください(他の全てのプラットフォーム)。 

 

14.7 海岸線と等深線ファイルの準備 (Preparing Custom Coastline and 

Bathymetry Files) 

ODV には粗い解像度の全球の海岸線と等深線ファイル(GlobLR)が付属しています。高解像度の海岸線と
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等深線データは、全球(GlobHR)または一部の海域(Baltic, BayOfBiscay, MedHR, MeditHR)がオプションパ

ッケージとして利用できます。ODV が提供していない海域で高解像度な海岸線と等深線が必要で、そのよう

な利用可能な高解像度のデータを持っている場合のために、ODV で使用できるファイルの作成方法を以下

に紹介します。 

新ファイルの準備 (Preparing New Files) 

海岸線と等深線データは別々のファイルでなければなりません。海岸線ファイルの名前として “World.coa” 

を使用します。等深線ファイルの名前は “xxxm.coa” という名付け方に従わなければなりません。ここで xxx

は各等深線の水深を示します(水深値と “m” の間に空白は入りません；例：1000m.coa)。.coa の参考ファイ

ルは ODV をインストールした〔samples〕ディレクトリを参照してください。 

海岸線または等深線の経度／緯度座標は、個々の多角形セグメントに格納されます(下図を参照)。セグメン

トの最初の nS 個の節点は、実際の海岸線か等深線の一部を表わします。セグメントのこの部分は等値線の

輪郭が必要とされるときに一筆書きで描かれます。さらに、各セグメントはオプションとして、描かれないけれ

ども適切にセグメントを閉じる目的にのみ使用される第二の部分を持つことができます。この第二の部分を含

んでいるセグメントを塗り潰したり輪郭線を描いたりできます。任意のセグメント中で節点の総数 nT は 1500 を

超えてはいけません。セグメントが第二の部分を持っていない場合、ストローク・ポイント nS の数は nT と等しく

なければなりません。 

 

図 14.3:ODV 海岸線/等深線の概念図 

経度／緯度座標は十進法で、経度は東経(0～360)、緯度は北緯(-90～90)の度単位です。.coa ファイルの多

角形セグメントのフォーマットは次の通りです： 

nT  nS 
lat1 lon1 
..... 
latnT lonnT 

ここで nT はこのセグメントの頂点の総数を、nS は「真の」海岸線/等深線の頂点数を示します。nT が nS より大き
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い場合、頂点 nS + 1 .... nT はセグメントを閉じるために使用されます(陸側を閉じる)。これらの余分の頂点は

セグメントが描画されるときには表示されません。nT, nS ともに 1500 個未満でなければなりません。セグメント

の最後の頂点に続いて、nT, nS の値を指定してから次のセグメントが始まります。セグメント間に空白行はあり

ません。ファイルの終わりを示すには最後の行には “0 0” と記入します。.coa ファイルは ODV で使用する前

にバイナリフォーマット(.cdt ファイル)に変換しなければなりません。.coa から.cdt への変換プログラム

(coa2cdt.exe)は Windows 版 ODV の配布パッケージに含まれています。coa2ctd 変換プログラムの使用方法

は次の通りです: 

1. .coa ファイルを含むディレクトリに、coa2ctd.inp ファイルを作成して、処理する.coa ファイルの名前を

入力します。 

2. DOS ボックスで、各々のディレクトリを変更して、coa2ctd.exe を実行します。coa2cdt.exe の実行形式

ファイルがパスに含まれているか.coa ディレクトリにあること、.coa ファイルが上述した.coa フォーマット

を満していることを確認してください。 

coa2cdt.exe で作成された.cdt ファイルはプラットフォームに依存せず、全てのサポートされているプラットフォ

ームで使用できます。 

等深線と海岸線を塗り潰すためには、.coa ファイルの全ての多角形が閉じていて、多角形の内側が各々の

等深線または海岸線より浅い領域でなければなりません。等深線や海岸線が閉じた多角形にならなくてもそ

れらを使用することはできますが、線画モードを選んで塗りつぶしを無効にしなければなりません。地図の

Display Options メニューを使用して、適宜表示設定を変更してください(下記の “新ファイルの使用(Using 

New Files)” を参照)。 

新ファイルのインストール (Installing New Files) 

海岸線、等深線、地形、重ね合わせファイルのバイナリ版をインストールするときには、次の手順にしたがっ

てください： 

• ODV の coast ディレクトリ(通常は c:¥Program Files¥Ocean Data View (mp)¥coast)に新しいサブデ

ィレクトリを作成して、それを説明する名前を選んでください(例えばGulfOfMaine)。このディレクトリ

は新しいファイルシリーズの基本ディレクトリとなります。この新しいサブディレクトリに Bathymetry, 

Topography, overlays サブディレクトリを作成してください。 

• 海岸線ファイル(通常“World.cdt”)をシリーズの基本ディレクトリにコピーしてください(例えば

c:¥Program Files¥Ocean Data View (mp)¥coast¥ GulfOfMaine)。 

• 全ての等深線ファイル(例えば 100m.cdt, 500m.cdt など)を Bathymetry サブディレクトリに、全ての

地形ファイルを topography ディレクトリに、全ての多目的な重ね合わせファイル(川、湖沼、境界な

ど)は overlays ディレクトリにコピーしてください。地形ファイルや重ね合わせファイルがなければ各
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ディレクトリは空のままにしておきます。 

 

新ファイルの使用 (Using New Files) 

ODV の地図で新たにインストールしたファイルを使用するには、以下の方法にしたがってください： 

• 地図の Display Options ダイアログ・ボックスを呼び出し(例えば、地図上でマウスの右ボタンをクリッ

クして Display Options を選択します)、Layers タブを選択します。 

• Series コンボボックスで、新たにインストールしたシリーズの名前(例えば GulfOfMaine)を選択しま

す。 

• レイヤーセットを選んで(例えば Ocean Bathymetry)興味のあるレイヤーセットを構成し、Compose を

押してください。Available リストから使用したい等値線ファイルを選択して、希望する描き方や塗りつ

ぶし方法を設定し、最後に<<を押して Selected リストにファイルを追加します(注：<<を押し忘れると

ファイルは追加されません)。Selected リストからファイルを取り除くには>>を押してください。 

描画特性の指定は次の規則にしたがってください： 

(a) 地形の輪郭を線で描く場合は、適切な線の幅、種類、色を選択してください。輪郭が不要ならカラー

に none を選んでください。オペレーティングシステムの制約により、いくつかの Windows のバージョ

ンでは、太い線は常に実線として画面や GIF, PNG, JPG 出力ファイルに描かれます。ODV 

PostScript ファイルであれば、どのような線の幅の選択でも実行されます。 

(b) 地形を塗りつぶす場合は、適切な塗り潰し色を選択し、塗り潰しが不要な場合は none を選んでくだ

さい。 

線と塗り潰し色に automatic を選択すると、ODV は初期設定の色を使用します。一部のレイヤーでは

automatic の初期設定が none になっています。また河川や境界のような一部の地形ファイルは塗りつぶせな

いので、塗り潰し色は明確に none と設定しなければなりません。 

ODV は Display Options ダイアログ・ボックスに表示された順にレイヤーセットを処理します。あるレイヤーセッ

トには Selected リストに表示された順に個々のレイヤーが描かれます(海底地形と陸上地形のレイヤーは、そ

れらが追加されたときに自動的に並び替えられます)。海氷の分布は pre-Coastlines セットに、湖沼、河川、境

界は post-Topography カテゴリーに定義してください。 
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15 付録 (Appendix) 

15.1 ODV ディレクトリ構造 (ODV Directory Structure) 

ODVがインストールされる初期設定のディレクトリは、Windowsでは c:¥Program Files¥Ocean Data View (mp)、

UNIX では/usr/local/odvmp です(以降では<odv_root>と表記；UNIX では “¥” を “/” に置き換えてくださ

い)。インストール・ディレクトリは、特定のタイプのファイルを含むいくつかのサブディレクトリの根本となります。

マクロやパレットファイル、サンプル・データコレクションのように、ユーザーによって修正されるかもしれないイ

ンストール・ファイルは、ユーザーのホームディレクトリ(<home>で表記)の下のサブディレクトリ odv_local にイ

ンストールされます。 

<odv_root>¥bin_w32 Windows の場合 
<odv_root>¥bin_linux-i386 Linux i386 の場合 
<odv_root>¥bin_solaris-sparc SUN Solaris Sparc の場合 
<odv_root>¥bin_irix6.5_mips SGI Irix の場合 
<odv_root>¥bin_aix-powerpc IBM AIX powerpc の場合 
<odv_root>¥bin_macx Mac OS X の場合 

の ODV 実行ファイル、ヘルプファイル、PostScript プリアンブル(preamble)ファイル。 

<odv_root>¥coast¥GlobLR: 

低解像度の全球海岸線・海底地形ファイル 

<odv_root>¥coast¥GlobHR: 

高解像度の全球海岸線・海底地形ファイル(オプションパッケージとして入手可能) 

<odv_root>¥doc: 

ODV html ヘルプファイル(pdf バージョンは ODV web ページから入手可能) 

<odv_root>¥include: 

ODV include ファイルの初期設定ディレクトリ(例えば、オプションパッケージで利用可能な ETOPO2 全

球地形ファイルなど)。あるタイプの他のファイルを含むいくつかのサブディレクトが存在しています。 

<odv_root>¥include¥atmhist: 

様々な大気トレーサーガス濃度の変遷 

<odv_root>¥include¥gazetteers: 

ODV 地名辞典データベースファイル 

<odv_root>¥samples: 

ODV サンプルファイルのディレクトリ。データの読み込みやマクロファイルのテンプレートに使用してくだ

さい。 

<home>¥odv_local¥data: 

ODV データコレクションの初期設定の基本ディレクトリ。データコレクションはディスクや CD-ROM のどこ
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にでも置くことができますが、管理するコレクション毎のサブディレクトリの作成を推奨します。 

<home>¥odv_local¥data¥SAVE: 

南大西洋ベンチレーション実験(South Atlantic Ventilation Experiment)のデータが含まれている ODV
サンプル・データコレクション 

<home>¥odv_local¥include¥macros: 

ODV マクロファイル(.mac) 

<home>¥odv_local¥include¥palettes: 

ODV パレットファイル(.pal) 

User’s default Temp directory: 

一時ファイルのためのディレクトリ。ODV で始まる名前のファイルで三日前より古い場合は定期的にこの

ディレクトリから削除されます。 

 

15.2 品質フラグの変換 (Quality Flag Mapping) 

データの読み込み中に、ODV は読み込みファイルで見つかったデータ品質フラグを、対応する ODV コレク

ション・ファイルに格納される ODV 品質フラグに変換します。次の変換規則が適用されます： 

表 15-1: ARGO品質コードからODV品質コードへの変換 

ARGO 品質コード → ODV 品質フラグ 

0 未処理 → 1 unknown 

1 正常 → 0 good 

2 良好の可能性 → 0 good 

3 不良の疑い → 8 bad 

4 不良 → 8 bade 

5 変更された値 → 1 unknown 

6 予約 → 1 unknown 

7 予約 → 1 unknown 

8 内挿値 → 1 unknown 

9 欠測 → 8 bad 

 

表 15-2: IGOSS品質コードからODV品質コードへの変換 

IGOSS 品質コード → ODV 品質フラグ 

0 未処理 → 1 unknown 

1 正常 → 0 good 

2 良好の可能性 → 0 good 

3 不良の疑い → 8 bad 

4 エラーの発生 → 4 questionable 

5 変更 → 1 unknown 

6 予約 → 1 unknown 
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7 予約 → 1 unknown 

8 予約 → 1 unknown 

9 欠測 → 8 bad 

 

表 15-3: WOCE品質コードからODV品質コードへの変換 

WOCE 品質コード → ODV 品質フラグ 

 採水ボトル 採水データ CTD データ    

1 ボトル情報なし 

この測定のためのサンプル

はボトルから採水されたが分

析値は未受領。どの測定に

関しても水がボトルから採水

された場合、全てのサンプ

ルが説明されていることを保

証するために、このパラメー

ターの品質フラグは初期値

として１がセットされている。

較正なし → 1 unknown 

2 問題なし 容認される測定 容認される観測 → 0 good 

3 水漏れ 疑わしい測定 疑わしい観測 → 4 questionable 

4 正しく作動していない 測定不良 観測不良 → 8 bad 

5 報告なし 報告なし 報告なし → 1 unknown 

6 
ジェラードとニスキンボトル

の測定値間での重大な不

一致 

繰り返し測定の平均(繰り返

した回数は－.DOC ファイル

の中で明示されるべきであ

り、繰り返し測定データの作

表を行うべきである) 

2dbar 以上の間隔におけ

る補間 
→ 1 unknown 

7 原因不明の問題 
手動のクロマトグラフィーの

ピーク測定 
スパイクを含む → 1 unknown 

8 

ペアが正常に動作しなか

った。ニスキンボトルが計

画水深以外で作動しジェ

ラードが正常に作動した。

あるいはその逆。 

不規則なデジタルクロマトグ

ラフィーのピーク統合 
CTD データには割り当て

られていない 
→ 4 questionable 

9 
このボトルから得られたサ

ンプルでない 
この測定のためのこのボトル

からのサンプルでない 
サンプルなし → 1 unknown 

 

表 15-4: WOD01「測点全体の」品質コードからODV品質コードへの変換 

World Ocean Database 2001 品質コード → ODV 品質フラグ 

 測点全体 個々の観測層    

0 測点の容認 値の容認 → 0 good 

1 年別標準偏差チェック不合格 
記録層の重複もしくは逆転 
(前の水深と同じもしくは小さい) 

→ 4 questionable 

2 二回以上の密度逆転(Levitsu 1982 基準) 密度逆転 → 4 questionable 
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3 フラグが付加された航海  → 4 questionable 

4 季節別標準偏差チェック不合格  → 4 questionable 

5 月別標準偏差チェック不合格  → 4 questionable 

6 フラグ１と４  → 4 questionable 

7 
標準層データからの Bullseye あるいは年

別、月別標準偏差チェック不合格 
 → 4 questionable 

8 季節別、月別標準偏差チェック不合格  → 4 questionable 

9 年別、季節別、月別標準偏差チェック失敗  → 4 questionable 

 

表 15-5: WOD01「個々の観測層の」品質コードからODV品質コードへの変換 

World Ocean Database 2001 品質コード → ODV 品質フラグ 

 個々の観測層におけるデータ    

0 値の容認 → 0 good 

1 範囲外値(範囲外のチェック) → 4 questionable 

2 逆転チェック不合格 → 4 questionable 

3 傾度チェック不合格 → 4 questionable 

4 観測層 “bullseye”フラッグと 0 傾度チェック → 4 questionable 

5 傾度チェックと逆転チェック → 4 questionable 

6 レンジと逆転チェック不合格 → 8 bad 

7 レンジと傾度チェック不合格 → 8 bad 

8 レンジと疑わしいデータのチェック不合格 → 8 bad 

9 レンジ、傾度、逆転チェック不合格 → 8 bad 

 

WOD の「測点全体」および「個々の観測層」フラグが有効な場合、ODV は二つの値を個別に ODV 品質フラ

グに割り当て、二つの値のうち大きい値をサンプルの ODV 品質フラグとして使用します。 

 

15.3 汎用 ODV スプレッドシート・フォーマット (Generic ODV Spreadsheet 

Format) 

項目 詳細 

全般 アスキーコード 

ファイル拡張子 .txt 

コメント行 最初の２文字は//で始まります(コメント行は読み込み中にコレクションの.info ファイルに追加さ

れます)。コメント行はファイルの何処にあっても構いません。 

カラム 測点のヘッダー情報(メタデータ)と 50 変数までのデータの値が分離されたカラムに保存されま

す。ヘッダーおよびデータのカラムの並びは任意です。ファイル中のコメント行以外の全ての行

は同じカラム数でなければなりません。 
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カラム区切り文字 タブまたは; (セミコロン) 

ヘッダー行 
(コメント行ではな

い最初の行; 必

須) 

1. カラムのラベルを含みます。 

2. メ タ デー タ の ヘッ ダ ー ラ ベ ル は 厳 密に 次の よう に な って い な け れ ばな りま せ ん : 
“Cruise”, “Station”, “Type”, “mon/day/yr”, “hh:mm”, “Longitude 
[degree_east]”, “Latitude [degree_north]”, “Bot. Depth [m]”. 

3. データ変数のラベルは、カギ括弧[]で囲まれる単位も含めて 60 文字までです。 

4. データ変数の各カラムは、オプションとして変数の直後に品質フラグを持つことができま

す。品質フラグのカラムのラベルは QF または QF:*のいずれかです(ここで*は任意の文字

列)。 

データ行 
(コメント行ではな

い二行目から最

終行まで) 
 

1. 各行には一サンプルのメタデータとデータが含まれています。ある測点の全てのサンプル

は連続していなければなりませんが、並び替えの必要はありません。一つの ODV スプレッ

ドシート・ファイルには多数の航海の多数の測点データを保存できます。 

2. 航海および測点のラベルは最大 20 文字です。測点ラベルに数字を使うと、高度な内部ソ

ートや選択が可能になるので推奨します。 

3. 測点のタイプは一文字です(B は 250 層より少ない測点(例えばボトル採水データ)に、C は

250 層より多い測点(例えば CTD や XBT など)に使用します)。タイプに*を指定すると ODV
が選びます。 

4. “Bot. Depth” (現場水深) がなければこの欄はゼロとしてください。 

5. 測点ヘッダー情報は各測点の最初の行に現れなければなりません。その測点の残りの行

には測点ヘッダー情報を繰り返すか、ファイルサイズを減らすためにヘッダー項目を空欄

にしても構いません。 

品質フラグ・カラ

ム 
 

1. ある変数のデータ品質情報が有効な場合は、その情報はその変数に続けて置きます。 

2. 品質フラグは一桁の整数です：0=good, 1=unknown, 4=questionable, 8=bad. 

欠測値 空欄または –1.e10 

 

15.4 一般 ODV スプレッドシート・フォーマット (General ODV Spreadsheet 

Format) 

項目 詳細 

全般  アスキーコード 

ファイル拡張子 任意 

カラム 測点メタデータ情報と 50 個までの変数のデータ値分離されたカラムに保存されます。一部あ

るいは全てのメタデータカラムがなくても構いません。メタデータとデータのカラムの並びは任

意です。ファイル中のカラムのラベルを含む行(ある場合；下記参照)と全データ行のカラム数

は同じでなければなりません。 

カラム区切り文字 タブまたは;(セミコロン)またはスペースまたは/ 
重要：航海および測点ラベルにカラム区切り文字が含まれてはいけません；例えばカラム区切

り文字として空白または/を使うと、ラベル “CFC [um/kg]”は二つに分割されてしまいます。 
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カラム・ラベル行 1. 無い場合があります；ある場合には、どのデータ行よりも前に置かれなければなりませ

ん。 

2. メタデータとデータのカラムのラベルは任意です。推奨されるヘッダーラベルは次の通り

です: “Cruise”, “Station”, “Type”, “mon/day/yr”, “hh:mm”, “Lon 
gitude [degrees_east]”, “Latitude [degrees_north]”, “Bot. Depth 
[m]”. 

3. データ変数のカラムのラベルはカギ括弧[]で囲まれる単位も含めて 60 文字までです。 

4. データ変数の各カラムはオプションとして変数の直後に品質フラグを持つことができま

す。品質フラグのカラムのラベルは QF または QF:*のいずれかです(ここで*は任意の文

字列)。 

データ行 1. ファイルの任意の行から始めることができます。最初のデータ行に続く全ての行は、同

様にデータ行とみなされます(ファイルの最後にコメントはありません!) 

2. 各行には一サンプルのメタデータとデータが含まれます。ある測点の全てのサンプルは

連続していなければなりませんが、並び替えの必要はありません。一つの ODV スプレッ

ドシート・ファイルには多数の航海の多数の測点データを保存できます。 

3. 測点のタイプは一文字で表わします(B は 250 層より少ない測点(例えばボトル採水デー

タ)に、C は 250 層より多い測点(例えば CTD や XBT など)に使います)。タイプに*を指

定すると ODV が選びます。 

4. “Bot. Depth” (現場水深) がなければこの欄はゼロとしてください。 

5. (ヘッダー・カラムが含まれていれば)測点のヘッダー情報は全ての行に現れなければな

りません。 

品質フラグ・カラム 1. ある変数のデータ品質情報が有効な場合、その情報は変数の直後に置きます。 

2. 品質フラグは一桁の整数です：0=good, 1=unknown, 4=questionable, 8=bad. 

欠測値  空欄または良好なデータの範囲外の任意の数値。 

 

15.5 o4x 交換フォーマット (o4x Exchange Format) 

ODV .o4x 交換ファイルは拡張子が.o4x の一つのアスキーファイルで、データタイプ、変数の数とラベル、実

データ値とデータ品質フラグの情報を含んでいます。典型的な.o4xファイルは三つのセクションを含んでいま

す：(1)(恐らく見当たらない)コメント・セクション；多くて各行 200 文字の自由なフォーマットの行

で任意の数から成る(この部分は見当たりませんかもしれません)、(2)変数セクション；ファイルにデ

ータタイプ、変数の数とラベルを記述；(3)データセクション；実データの値とデータ品質フラグを

含んでいます。データ品質フラグは見当たりませんかもしれません；もしある場合は一桁の数字の

ODV 品質フラグでなければなりません。サンプルの.o4x ファイルは ODV をインストールしたディ

レクトリの下の samples サブディレクトリを参照してください。 

.o4x 変数セクションはキーワード “ODV4.0 Listing” で始まり、下のサンプルのようにフォーマットされていな

ければなりません。ODV4.0 Listing の行より前のどの行もコメント行として扱われ、読み込みのときにコレクシ

ョンの.info ファイルに追加されます。 
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例：o4x 変数セクション 

(注：初めと最後の“….+.”の行は単なる目盛であって、ファイルの一部ではありません。) 

....+....1....+....2....+....3....+....4....+....5....+....6....  
ODV4.0 Listing 
 File Name: import4.o4x 
      Type: HYD 
     Nstat: 12 
 Variables: 8 
 
Depth [m]                                                    6.0 
Temperature [°C]                                             8.2 
Salinity [psu]                                               8.3 
Oxygen [~$m~#mol/kg]                                         6.0 
Phosphate [~$m~#mol/kg]                                      8.2 
Silicate [~$m~#mol/kg]                                       8.1 
Nitrate [~$m~#mol/kg]                                        7.1 
Nitrite [~$m~#mol/kg]                                        6.1 
....+....1....+....2....+....3....+....4....+....5....+....6.... 

最初の測点のヘッダー行とデータファイルの変数セクションは一つの空行で分けられています(例えば ODV

サンプル・ディレクトリにある import4.o4x ファイルを参照してください)。測点のヘッダー行の一桁目#で始まっ

ていなければなりません。これに続く項目は次の通りです：(1)測点の航海ラベル(3～22 桁目；a20)；(2)測点ラ

ベル(24～43 桁目；a20)；(3)測点タイプ(B, C, X のいずれか。それぞれボトル採水, CTD, XBT データ；45 桁

目; a1)；(4)日付 mm/dd/yyyy (47～66 桁目；i2, 1x, i2, 1x, i4)；(5)東経(十進法；58～64 桁目; f7.3)；(6)北緯

(十進法；66～72 桁目；f7.3)；(7)現場水深([m]；74～78 桁目；i5)；(8)最深観測深度([m]；80～84; i5)；(9)観測

層数(85～89 桁目；i5)；(10)ファイル内の変数の数 (91～93 桁目; i3)。このファイルの例では、測点 

“06MT18/558” のタイプはボトル採水で、14 層の観測深度とそれぞれに 8 個の変数が続いています。これら

の変数は、(ファイルの初めにある変数セクションで定義されているように)第二ヘッダー行での変数の順番の

通りに識別されます(例えば、1 なら水深を、6 ならケイ酸塩を意味します)。フォーマットの唯一の制約は、第

二ヘッダー行の変数の番号が少なくとも一つの空白で区切られていなければならないことです。 

各観測水深(この例では 14 層)に対して一行のデータ行があります。これらの行には、第二ヘッダー行で示さ

れている順に各変数のデータ値と品質フラグが含まれていなければなりません。欠測値はデータファイル中

で-1.000E+10 とします。データと品質フラグとは少なくとも一つの空白で分けられていなければなりません。

品質フラグは一桁の整数で、0 = good, 1 = unknown, 4 = questionable, 8 = bad を意味します。測点の最終デ

ータ行の直後には、読み込まれる次の測点の(#で始まる)第一ヘッダー行、あるいはそれが読み込まれる最

後の測点ならば end-of-file (ファイルの終わりを示す文字)が続きます。 

.o4x ファイルを作成した後に ODV を実行して新しいデータのためのコレクションを開くか作成してください。

そして Importメニューから ODV4.x Listing を選択して、上記で作成したアスキーデータファイルを読み込みフ

ァイルとして選んでください。読み込みオプションを指定して OK を押せばデータの読み込みが始まります。

ODV はその後、読み取りファイルにアクセスしてコレクションに測点を追加／結合します。ODV に.o4x ファイ

ルをドラッグ・アンド・ドロップすることもできます。 
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15.6 o3x 交換フォーマット (o3x Exchange Format) 

.o3x 交換フォーマットのデータを読み込むには、二つのアスキーファイルを用意しなければなりません：一つ

は読み込む全測点の実データを含んだもの(初期設定の拡張子は.o3x)、もう一つはデータファイルに含まれ

る変数を記述する(小さい)ファイルです(拡張子は.var でなければなりません)。サンプルの.o3x ファイルにつ

いては ODV をインストールしたディレクトリの samples サブディレクトリを参照してください。 

例：var ファイル 

....+....1....+....2....+....3....+....4....+....5....+....6.... 

ODV4.0 

Collection: SAVE 

      Type: HYD 

     Nstat: 0 

 Variables: 7 

 

Depth [m]                                                    6.0 

Temperature [°C]                                             8.2 

Salinity [psu]                                               8.3 

Oxygen [~$m~#mol/kg]                                         6.0 

Phosphate [~$m~#mol/kg]                                      8.2 

Silicate [~$m~#mol/kg]                                       8.1 

Nitrate [~$m~#mol/kg]                                        7.1 

....+....1....+....2....+....3....+....4....+....5....+....6.... 

上と下の “....+.” 行は単なる目盛であって.var ファイルの一部ではありません。また.var ファイルは ODV4.x

コレクションの定義ファイルと同じフォーマットですが、データの読み込みに必要な情報は変数に関する事項

に限られます。読み込むデータファイルに含まれる変数の数の指定は、ファイルの五行目の十三桁目から始

まっていなければなりません。そして一つの空行の後に、全変数の変数ラベルと数値フォーマットを変数毎

の行で与える必要があります。数値フォーマットは 61 桁目から始まり、ll.d の形式で表示されます (ここで ll

は文字列の全長で、d は小数点以下の桁数を示します)。 

例：o3x ヘッダー行 

....+....1....+....2....+....3....+....4....+....5....+....6....+....7... 

# REID_ET           212 B  6/21/1967 243.167 -28.233  3400  3310   34   7 

    1    2    3    4    5    6    7 

読み込む全測点のデータは単独のアスキーファイルで与えられなければなりません(初期設定の拡張子

は.o3x)。このファイルは以下のフォーマット仕様と一致する必要があります(最上部のメモリはファイルの一部

ではありません)： 
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ファイルは読み込まれる最初の測点のヘッダー行から始まらなければなりません。測点ヘッダー行の一桁目

は#で始まる必要があります。各項目は次の通りです：(1)測点の航海ラベル(3～12桁目；a10)；(2)測点ラベル 

(14～23 桁目；a10)；(3)測点タイプ(B, C, X はそれぞれボトル採水, CTD, XBT データ；25 桁目；a1)；(4)日付

mm/dd/yyyy (27～36 桁目；i2, 1x, i2, 1x, i4)；(5)東経(十進法；38～44 桁目；f7.3)；(6)北緯(十進法；46～52

桁目；f7.3)；(7)現場水深([m]；54～58 桁目；i5)；(8)最深観測層深度([m]；60～64 桁目；i5)；(9)観測層数(66

～69 桁目；i4)；(10)ファイル内の変数の数(71～73 桁目；i3)。上記の例では、測点 “REID_ET/212” で測点

のタイプはボトル採水、34 層の観測深度のそれぞれに七個の変数のデータが続いています。これらの変数

は.var ファイルで定義されているように第二ヘッダー行の変数の順番にしたがって識別されます(例えば、1

なら水深を、6 ならケイ酸塩を意味します)。フォーマットの唯一の制約は、第二ヘッダー行の変数番号が少な

くとも一つの空白で区切られていなければならないことです。 

各観測深度(上述の例では 34 層)に対して一つのデータ行が続かなければなりません。これらの各行は第二

ヘッダー部で示されている順に並んだ数値が含まれなれなければなりません。欠測値はデータファイル中で

-1.000E+10 とします。ある測点の最終データ行の直後には、読み込まれる次の測点の(#で始まる)第一ヘッ

ダー行が、あるいはそれが読み込まれる最後の測点ならば end-of-file (ファイルの終わりを示す文字)が続き

ます。 

.var ファイルと.o3x ファイルを作成してから ODV を実行して新しいデータのためのコレクションを開くか作成し

てください。そして ImportメニューからODV3.x Listingを選択して、上記で作成したアスキーデータファイルを

読み込みファイルとして選び、データソースとして読み込み.var ファイルを選択して読み込む変数を指定しま

す。読み込みオプションを指定して OK を押せばデータの読み込みが始まります。その後 ODV は読み取り

ファイルにアクセスしてコレクションに測点を追加/併合します。ODV3.0 交換フォーマットからデータを読み込

んだときのデータ品質フラグは Unknown にセットされることに注意してください。 

 

15.7 ODV 注釈文の制御文字列と関数 (Control Sequences and 

Functions in ODV Annotations) 

表 15-6: ODV注釈のフォーマット制御文字列 

制御文字列 結果 

~$ 記号フォント(ギリシャ文字)への切り換え 

~# 通常のテキストフォントへの切り換え 

~% パーミル文字(‰)の生成 

~^ 以降の文字を上付きにする 

~_ 以降の文字を下付きにする 

例: “~$S~#CO~_2 [~$m~#mol/kg” は ΣCO2 [μmol/kg] となる。 
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表 15-7: ODV注釈で有効な自動関数 

関数 置換されるテキスト 

=date() 現在の日付 

=time() 現在の時刻 

=user() ユーザー名とホスト名 

=collection() 現在のコレクションの絶対パス名 

=cfg_file() 現在の設定ファイルの絶対パス名 

=sec_file() 現在のセクションファイルの絶対パス名 

 

15.8 ハードウェアの必要条件と制限 (Hardware Requirements and 

Limitations) 

ODV マルチプラットフォーム版は、Windows (9x/Me/NT/2000/XP), Linux, Mac OS X と各種 UNIX のオペレ

ーティングシステムで動作します(訳注: Windows 9x/Me では動作しない、または動作が安定しないという報

告がありますので、2000/XP での使用を強くお勧めします)。一部のシステムでは、ODV をインストールすると

きに管理者の権限が必要になります。 

ODV のハードコピー機能は、白黒とカラーの Apple LaserWriter, キヤノンのレーザープリンター、HP 

DeskJetプリンターでテストされていますが、他のプリンターでも同様に機能するでしょう。PostScriptプリンター

があれば、Print Canvas オプションの代わりに、Save Canvas As か Save Plot As オプションで出力ファイルタイ

プを PostScript (*.eps)として使うことができます。ODV プロットを刊行物や Web ドキュメントで使う場合には高

解像度の gif, png, jpg ファイルの作成を検討してください。 

表 15-8: ODVの制限(データコレクションとグラフィック表示) 

コレクションあたりの測点数 無制限

測点あたりのデータ数 100,000

測点あたりのサンプル数 20,000

コレクションに保存できる変数の数 50

コレクション名の長さ(文字数) 30

変数名の長さ(文字数) 60

航海ラベルの長さ (文字数) 20

測点ラベルの長さ (文字数) 20

データプロット・ウインドウの数 20

ウインドウあたりの等値線の本数 50

 


